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Notices

References in this publication to IBM® products, programs, or services do not imply
IBM intends to make these available in all countries in which IBM operates.  Any
reference to an IBM product, program, or service is not intended to state or imply
only that IBM product, program, or service may be used. Any functionally equivalent
product, program, or service that does not infringe on intellectual property rights of
IBM may be used instead of the IBM product, program, or service. The evaluation
and verification of operation in conjunction with other products, except those
expressly designated by IBM, are the responsibility of the user.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing by IBM of this document does not give you any license to
these patents.  Send license inquiries in writing to the IBM Director of Commercial
Relations, IBM Corporation, Purchase, NY 10577, U.S.A.

Electronic Emission Notices

Federal Communications Commission (FCC) Statement

Note: This equipment is tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. The limits are designed
to provide reasonable protection against harmful interference when the
equipment operates in a commercial environment.  The equipment
generates, uses, and can radiate radio frequency energy, and if not installed
and used in accordance with the instruction manual, may cause harmful
interference to radio communications.  Operation of the equipment in a
residential area is likely to cause harmful interference, in which case the
user is required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used to meet FCC
emission limits. IBM is not responsible for any radio or television interference caused
by using other than recommended cables and connectors, or by unauthorized
changes or modifications to this equipment. Unauthorized changes or modifications
can void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules.  Operation is subject to the
following conditions: (1) the device may not cause harmful interference, and (2) the
device must accept any interference received, including interference that may cause
undesired operation.

Avis de conformité aux normes du ministère des Communications
du Canada

Cet équipement ne dépasse pas les limites de Classe A d’émlsslon des bruits
radioélectriques pour les appareils numériques, telles que prescrites par le
Règlement sur le brouillage radioélectrique établi par le ministère des
Communications du Canada.  L’exploitation faite en milieu résidentiel peut
entraîner le brouillage des réceptions radio et télé, ce qui obligerait le propriétaire
ou l’opérateur á prendre les dispositions nécessaires pour en éliminer les causes.
Voir le Guide d’instructions.
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Canadian Department of Communications Compliance Statement

This equipment does not exceed Class A limits per radio noise emissions for digital
apparatus, set out in the Radio Interference Regulation of the Canadian Department
of Communications.  Operation in a residential area may cause unacceptable
interference to radio and television reception, requiring the owner or operator to take
steps necessary to correct the interference.  Refer to the instruction manual.

Japanese Voluntary Control Council for Interference Statement

United Kingdom Telecommunications Safety Requirements Notice to
Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect
connection to public telecommunications systems in the United Kingdom.

European Community for Information Technology Equipment
(ITE) Statement

This device meets the following regulatory requirements set forth by the European
community for Information Technology Equipment (ITE).

• EN55022, ITE-Generic Emission standard for domestic, commercial, and light
industrial environments (CISPR 22 Class A).

• EN55082-1, ITE-Generic Immunity standard for domestic, commercial, and
light industrial environments (IEC 801-2 through 801-6).  The device meets
European Community Mark Immunity Performance Criteria A, with the
exception being IEC 801-2, Electrostatic Discharge Immunity, which meets
Performance Criteria B. The software automatically restores the device to full
operation if performance degradation occurs, with no operator intervention
required.

Attention!

This is a Class A device.  In a domestic environment the product may cause
radio interference, in which case the user may be required to take adequate
corrective measures.
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European Community Electromagnetic Compatibility
Directive (All Countries)

This product conforms with all protection requirements of European Community
Council Directive 89/336/EEC, on the approximation of the laws of the Member
States relating to electromagnetic compatibility.

IBM cannot accept responsibility for any failure to satisfy the protection requirements
resulting from a non-recommended modification to the product, including the fitting
of non-IBM option cards.

Trademarks and Service Marks

The following terms, indicated by a registered trademark symbol (®) or trademark
symbol (™) on first use in this publication, are trademarks of the IBM Corporation in
the United States or other countries or both:

Registered T rademarks Trademarks

IBM® DCAF™

ESCON® LANAID™

Operating System/2® PS/2™

OS/2® SA OS/390™

S/390® System Automation for OS/390™

Sysplex Timer®

System/390®

Win-OS/2®

Windows®, indicated by a registered trademark symbol on first use in this publication,
is a registered trademark of Microsoft Corporation in the United States or other
countries or both.

Intel®, i486®, and Pentium®, indicated by registered trademark symbols on first use
in this publication, are registered trademarks of Intel Corporation in the United States
or other countries or both.
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About This Publication

This publication provides information about Console installation and administrative
functions for the IBM 9032-003 Enterprise Systems Connection (ESCON®) Director,
9033-004 ESCON Director, 9032-005 Director, and 9037-002 Sysplex Timer®. You
should be familiar with:

• Operation of Directors and/or the Sysplex Timer.

• Director and/or Sysplex Timer status codes, messages, and indicators that
appear at the Console.

• Navigating in the Operating System/2® (OS/2®) environment.

Who Should Use This Publication

Use this publication as an introduction to the operating system interface for the
Director or Sysplex Timer Console or as a guide to performing administrative tasks
at the Director or Sysplex Timer Console.

How to Use This Publication

This publication is used as a tutorial for those are trained but need a refresher before
resuming work with a Director or Sysplex Timer Console or as a reference manual
for operation of the Director or Sysplex Timer Console.

What Is Included in This Publication

This publication includes eight chapters organized as follows:

• Chapte r 1 - General Information. This chapter discusses the ESCON Director
and Sysplex Timer Consoles.  Console platforms and specifications are
described.

• Chapter 2 - Win-OS/2 Basics.  This chapter provides an overview of the
Windows®-Operating System/2 (Win-OS/2®) environment and describes the
OS/2 desktop, standard OS/2 procedures, and working in Win-OS/2.

• Chapter 3 - Hardware Management Console Support.  This chapter
describes use of the Director or Sysplex Timer Console application on a
Hardware Management Console.  Installation, operation, and administrative
procedures are provided.

• Chapter 4 - Remote Access Console Support. This chapter describes how
to configure and use a modem or Local Area Network (LAN) connection
between the Director or Sysplex Timer Console and a remote access Console.

• Chapter 5 - PS/2 Console Procedures .  This chapter describes
administrative, backup, restore, and console customization tasks for a Personal
System/2 (PS/2™) platform configured as a Director or Sysplex Timer Console.
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• Chapter 6 - Model PC-330 Console Procedures .  This chapter describes
administrative, backup, restore, and console customization tasks for a PC-330
platform configured as a Director or Sysplex Timer Console.

• Chapter 7 - Model PC-365 Console Procedures .  This chapter describes
administrative, backup, restore, and console customization tasks for a PC-365
platform configured as a Director or Sysplex Timer Console.

• Chapter 8 - Model PC 300PL Console Procedures . This chapter describes
administrative, backup, restore, and console customization tasks for a PC
300PL platform configured as a Director or Sysplex Timer Console.

A Glossary  and Index are provided at the back of the publication.

Notational Conventions

The following table lists notational conventions used in this publication.

Related Publications

The following publications relate to ESCON Directors:

• Planning for the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Enterprise
Systems Connection Director (SA22-7295).

• Planning for the 9032 Model 5 Director with FICON Converter Feature
(SA22-7415).

• Using the 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director, and
9032 Model 5 Director (SA22-7296).

• User’s Guide Reference Summary for the 9032 Model 3 ESCON Director,
9033 Model 4 ESCON Director, and 9032 Model 5 Director (SA22-7298).

• Operator Panel Reference Summary for the 9032 Model 3 Enterprise Systems
Connection Director (SA26-6103).

Function How Shown Example

Menu options Italics Passwords menu option

Keys and key combinations Bold Enter  or Alt+H  keys

Menu names Italics Help menu

Dialog boxes Italics Select Timer Network dialog box

Buttons on dialog boxes Italics OK button on the Select Timer
Network dialog box

Console input or output Courier Font Type c:\prtdrvs  and click
the OK button
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• Operator Panel Reference Summary for the 9033 Model 4 Enterprise Systems
Connection Director (SA22-7211).

• Operator Panel Reference Summary for the 9032 Model 5 Director
(SA26-7297).

• Maintenance Information for the 9032 Model 3 Enterprise Systems Connection
Director (SY27-3601).

• Maintenance Information for the 9033 Model 4 Enterprise Systems Connection
Director (SY27-2638).

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

• Install and Maintain the ESCON Director Console Application on the Hardware
Management Console (Feature #5901).  Order this feature to obtain the
publication.

The following publications relate to the Sysplex Timer:

• Planning for the 9037 Model 2 Sysplex Timer (SA22-7233).

• Using the 9037 Model 2 Sysplex Timer (SA22-7230).

• User’s Guide Reference Summary for the 9037 Model 2 Sysplex Timer
(SA22-7231).

• Operator Panel Reference Summary for the 9037 Model 2 Sysplex Timer
(SA22-7232).

• Maintenance Information for the 9037 Model 2 Sysplex Timer (SY27-2641).

• Install and Maintain the 9037 Model 2 Sysplex Timer Console Application on
the Hardware Management Console (Feature #4910).  Order this feature to
obtain the publication.

For additional information about the OS/2 Warp 4.0 operating system, refer to Up
and Running OS/2 Warp V4 (S84H-3090).

For additional information about the Hardware Management Console, refer to the
Hardware Management Console Guide (GC38-0453).
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Chapter 1. General Information

This chapter describes the dedicated Console shipped with the Model 9032-003,
9033-004, or 9032-005 Enterprise Systems Connection (ESCON) Director and the
Model 9037-002 Sysplex Timer.  The Console is an IBM personal computer (PC)
running the Director or Sysplex Timer Console application. Both applications run in
a Windows-Operating System/2 (Win-OS/2) environment.

This publication also describes use of a remote access Console and operation of
the Director or Sysplex Timer Console application on a Hardware Management
Console.

The ESCON Director Console
A Console is required to install and configure an ESCON Director, change Director
configurations without the use of System Automation for OS/390™ (SA OS/390™),
and access utility logs. The Console connects to a Director through a 4/16 megabit
per second (Mbps) Token Ring Local Area Network (LAN) using shielded, twisted-
pair cable.  The Console can simultaneously communicate with 16 Console
sessions, consisting of up to 16 Directors and up to two Sysplex Timer networks
(total sessions cannot exceed 16).

The Director may have a session with only one Console.  However, a Console
failure does not cause the operating Director to fail. After the Director is configured
and operational, it can perform all connection tasks without Console intervention.
For maximum availability, a backup or replacement Console should be available to
provide access to critical system or application data.

Director Consoles described in this publication do not support Model 9032-002 or
9033-001 Directors.  Consoles for the Model 9032-003 and 9033-004 Directors
(PS/2 and PC-330) do not support the Model 9032-005 Director.

Console Platforms
It is recommended the Director Console application be installed on a dedicated PC
shipped with the ESCON Director.  The dedicated PC platform changes as PC
technology evolves.  Platform models are periodically changed to take advantage
of faster processor speed, more random-access memory (RAM), and higher-
capacity fixed disks.  The following platforms are supported and described in this
publication:

• Personal System/2 (PS/2)  - uses OS/2 Warp Connect 3.0 and supports
Model 9032-003 and 9033-004 Directors.
1  Copyright IBM Corp. 1999



• Model PC-330 - uses OS/2 Warp Connect 3.0 and supports Model 9032-003
and 9033-004 Directors.

• Model PC-365  - uses OS/2 Warp 4.0 and supports Model 9032-003,
9033-004, and 9032-005 Directors.

• Model PC 300PL  - uses OS/2 Warp 4.0 and supports Model 9032-003,
9033-004, and 9032-005 Directors.

The Director Console application can also be installed on a:

• Customer-supplied PC that meets the minimum Console hardware and
software requirements.  Console administrative, backup, restore, and
customization tasks are not supported.

• Sysplex Timer Console (9032-003 or 9033-004 application on the
Model PC-330, all applications on the PC-365 or PC 300PL).  Console
administrative, backup, restore, and customization tasks are supported
and described in this publication.

• System/390® (S/390®) server’s Hardware Management Console.  Console
administrative, backup, and restore tasks are supported.  For additional
information, refer to Chapter 3, “Hardware Management Console Support” on
page 33.

Remote access for the Director Console is also supported.  A customized version
of Distributed Console Access Facility (DCAF™) software (included with the
Console feature) allows an operator at a remote PC to access the Console and
perform administrative and operator tasks.  For additional information, refer to
Chapter 4, “Remote Access Console Support” on page 59.

PS/2 Director Console
The PS/2 Director Console (Figure 1) is shipped with the OS/2 Warp Connect
3.0 operating system and supports Model 9032-003 and 9033-004 Directors.
The Console also supports the Model 9037-002 Sysplex Timer.  For access to
removable storage media, the platform includes a 3.5-inch diskette drive and a tape
cartridge drive.

Note: The PS/2 platform does not support the Model 9032-005 Director.

PS/2 Console administrative, backup, restore, and customization tasks are
supported and described in this publication.  For additional information, refer to
Chapter 5, “PS/2 Console Procedures” on page 79.  The information applies to
both the Director and Sysplex Timer Consoles.
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Figure 1. PS/2 Director Console

PS/2 Director Console Specifications
The PS/2 Director Console ordered from IBM meets the following specifications:

• PC system unit with:

– Intel® i486® microprocessor with a 25 megahertz (MHz) or greater
clock rate.

– 16 megabytes (MB) RAM.

– 1.44 MB diskette drive (3.5-inch).

– 150 MB or larger fixed disk.

– Tape cartridge drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.

• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).
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Model PC-330 Director Console
The Model PC-330 Director Console (Figure 2) is shipped with the OS/2 Warp
Connect 3.0 operating system and supports Model 9032-003 and 9033-004
Directors.  The Console also supports the Model 9037-002 Sysplex Timer.  For
access to removable storage media, the platform includes a 3.5-inch diskette drive
and a tape cartridge drive.

Note: The Model PC-330 platform does not support the Model 9032-005
Director.

Figure 2. Model PC-330 Director Console

Model PC-330 Console administrative, backup, restore, and customization tasks
are supported and described in this publication.  For additional information, refer
to Chapter 6, “Model PC-330 Console Procedures” on page 149. The information
applies to both the Director and Sysplex Timer Consoles.

PC-330 Director Console Specifications
The Model PC-330 Director Console ordered from IBM meets the following
specifications:

• PC system unit with:

– Intel i486 microprocessor with a 50 MHz or greater clock rate, or Intel
Pentium® microprocessor with a 75 MHz or greater clock rate.

– 16 MB RAM.

– 1.44 MB diskette drive (3.5-inch).
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– 250 MB or larger fixed disk.

– Tape cartridge drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.

• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).

Model PC-365 Director Console
The Model PC-365 Director Console (Figure 3) is shipped with the OS/2 Warp
4.0 operating system and supports Model 9032-003, 9033-004, and 9032-005
Directors.  The Console also supports the Model 9037-002 Sysplex Timer.  For
access to removable storage media, the platform includes a 3.5-inch diskette drive,
compact disc read-only memory (CD-ROM) drive, and rewriteable optical cartridge
(ROC) drive.

Figure 3. Model PC-365 Director Console
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Model PC-365 Console administrative, backup, restore, and customization tasks
are supported and described in this publication. For additional information, refer to
Chapter 7, “Model PC-365 Console Procedures” on page 221.  The information
applies to both the Director and Sysplex Timer Consoles.

PC-365 Director Console Specifications
The Model PC-365 Director Console ordered from IBM meets the following
specifications:

• PC system unit with:

– Intel Pentium Pro microprocessor with a 200 MHz or greater clock rate.

– 32 MB RAM.

– 1.44 MB diskette drive (3.5-inch).

– 1.6 GB or larger fixed disk.

– CD-ROM drive.

– ROC drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.

• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).

Model PC 300PL Director Console
The Model PC 300PL Director Console (Figure 4) is shipped with the OS/2 Warp
4.0 operating system and supports Model 9032-003, 9033-004, and 9032-005
Directors.  The Console also supports the Model 9037-002 Sysplex Timer.  For
access to removable storage media, the platform includes a 3.5-inch diskette drive,
CD-ROM drive, and ROC drive.

Model PC 300PL Console administrative, customization, backup, and restore tasks
are supported and described in this publication. For additional information, refer to
Chapter 8, “Model PC 300PL Console Procedures” on page 285.  The information
applies to both the Director and Sysplex Timer Consoles.
6        Console Installation and User’s Guide



Figure 4. Model PC 300PL Director Console

PC 300PL Director Console Specifications
The Model PC 300PL Director Console ordered from IBM meets the following
specifications:

• PC system unit with:

– Intel Pentium II microprocessor with a 266 MHz or greater clock rate.

– 32 MB RAM or greater.

– 1.44 MB diskette drive (3.5-inch).

– 4.2 GB or larger fixed disk.

– CD-ROM drive.

– ROC drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.

• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).
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Backup or Replacement Director Console
It is recommended an additional Console be configured and maintained to take
over administrative and operator tasks if the Director Console fails.  The Console
can be a backup Console or replacement Console.

Backup Console
The backup Console can be installed on the same LAN as the Director Console,
subject to the following constraints:

• The backup Console must have a different Internet Protocol (IP) address
than the Director Console.

• The Console application cannot be open on the backup Console and
Director Console at the same time.

Refer to Using the 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director,
and 9032 Model 5 Director (SA22-7296) for instructions about configuring,
maintaining, and using a backup Console.

Replacement Console
A replacement Console can be maintained separate from the LAN to which the
Director Console is connected.  The replacement Console has the same IP
address as the Director Console.  If the Director Console fails, it is disconnected
from the LAN and the replacement Console is connected to the LAN in its place.

Refer to Using the 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director,
and 9032 Model 5 Director (SA22-7296) for instructions about configuring,
maintaining, and using a replacement Console.

The Sysplex Timer Console
A Console is required to install a Sysplex Timer network, manage and monitor the
network, define or change External Time Reference (ETR) connection definitions,
manage and monitor the ETR, display, set, and adjust the time and date, and
access utility logs.  The Console connects to a Timer through a 4/16 Mbps Token
Ring LAN using shielded, twisted-pair cable.

The Timer network is comprised of one Timer (Basic or Expanded Basic
configuration) or two Timers (Expanded Availability configuration).  The Console
can simultaneously communicate with two Timer networks.  Only one instance of
the Console application may be open on the PC.

The Timer may have sessions with up to two Consoles.  One of these Consoles is
the active Console, and the other is an optional standby Console.  For maximum
availability, a standby Console should be connected.  A Timer network can be
controlled by only one active Console.  If the active Console fails, the standby
Console can be manually reconfigured as the active Console.
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Console Platforms
It is recommended the Sysplex Timer Console application be installed on a
dedicated PC shipped with the Timer.  The dedicated PC platform changes as
PC technology evolves.  The platform models are periodically changed to take
advantage of faster processor speed, more RAM, and higher-capacity fixed disks.
The following platforms are supported and described in this publication:

• Model PC-330  - uses OS/2 Warp Connect 3.0 and supports the Model
9037-002 Sysplex Timer.

• Model PC-365  - uses OS/2 Warp 4.0 and supports the Model 9037-002
Sysplex Timer.

• Model PC 300PL  - uses OS/2 Warp 4.0 and supports the Model 9037-002
Sysplex Timer.

The Sysplex Timer Console application can also be installed on a:

• Customer-supplied PC that meets the minimum Console hardware and
software requirements.  Console administrative, backup, restore, and
customization tasks are not supported.

• ESCON Director Console (Model PS/2, PC-330, PC-365, or PC 300PL).
Console administrative, customization, backup, and restore tasks are
supported and described in this publication.

• S/390 server’s Hardware Management Console.  Console administrative,
backup, and restore, tasks are supported. For additional information, refer to
Chapter 3, “Hardware Management Console Support” on page 33.

Remote access for the Sysplex Timer Console is also supported.  A customized
version of DCAF software (included with the Console feature) allows an operator at
a remote PC to access the Console and perform administrative and operator tasks.
For additional information, refer to Chapter 4, “Remote Access Console Support”
on page 59.

Model PC-330 Sysplex Timer Console
The Model PC-330 Timer Console (Figure 5) is shipped with the OS/2 Warp
Connect 3.0 operating system and supports the Model 9037-002 Sysplex Timer.
The Console also supports Model 9032-003 and 9033-004 ESCON Directors.
For access to removable storage media, the platform includes a 3.5-inch diskette
drive and a tape cartridge drive.

Note: The Model PC-330 platform does not support the Model 9037-001
Sysplex Timer.
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Figure 5. Model PC-330 Sysplex Timer Console

Model PC-330 Console administrative, backup, restore, and customization tasks
are supported and described in this publication.  For additional information, refer
to Chapter 6, “Model PC-330 Console Procedures” on page 149. The information
applies to both the Director and Sysplex Timer Consoles.

PC-330 Timer Console Specifications
The Model PC-330 Timer Console ordered from IBM meets the following specifica-
tions:

• PC system unit with:

– Intel i486 microprocessor with a 50 MHz or greater clock rate, or Intel
Pentium microprocessor with a 75 MHz or greater clock rate.

– 16 MB RAM.

– 1.44 MB diskette drive (3.5-inch).

– 250 MB or larger fixed disk.

– Tape cartridge drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.
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• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).

Model PC-365 Sysplex Timer Console
The Model PC-365 Timer Console (Figure 6) is shipped with the OS/2 Warp 4.0
operating system and supports the Model 9037-002 Sysplex Timer.  The Console
also supports Model 9032-003, 9033-004, and 9032-005 Directors.  For access to
removable storage media, the platform includes a 3.5-inch diskette drive, CD-ROM
drive, and ROC drive.

Note: The Model PC-365 platform does not support the Model 9037-001
Sysplex Timer.

Figure 6. Model PC-365 Sysplex Timer Console

Model PC-365 Console administrative, backup, restore, and customization tasks
are supported and described in this publication. For additional information, refer to
Chapter 7, “Model PC-365 Console Procedures” on page 221.  The information
applies to both the Director and Sysplex Timer Consoles.

PC-365 Timer Console Specifications
The Model PC-365 Timer Console ordered from IBM meets the following
specifications:

• PC system unit with:

– Intel Pentium Pro microprocessor with a 200 MHz or greater clock rate.

– 32 MB RAM.

652
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– 1.44 MB diskette drive (3.5-inch).

– 1.6 GB or larger fixed disk.

– CD-ROM drive.

– ROC drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.

• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).

Model PC 300PL Sysplex Timer Console
The Model PC 300PL Timer Console (Figure 7) is shipped with the OS/2 Warp 4.0
operating system and supports the Model 9037-002 Sysplex Timer.  The Console
also supports Model 9032-003, 9033-004, and 9032-005 Directors.  For access to
removable storage media, the platform includes a 3.5-inch diskette drive, CD-ROM
drive, and ROC drive.

Note: The Model PC 300PL platform does not support the Model 9037-001
Sysplex Timer.

Figure 7. Model PC 300PL Sysplex Timer Console
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Model PC 300PL Console administrative, customization, backup, and restore tasks
are supported and described in this publication. For additional information, refer to
Chapter 8, “Model PC 300PL Console Procedures” on page 285.  The information
applies to both the Director and Sysplex Timer Consoles.

PC 300PL Sysplex Timer Console Specifications
The Model PC 300PL Timer Console ordered from IBM meets the following
specifications:

• PC system unit with:

– Intel Pentium II microprocessor with a 266 MHz or greater clock rate.

– 32 MB RAM or greater.

– 1.44 MB diskette drive (3.5-inch).

– 4.2 GB or larger fixed disk.

– CD-ROM drive.

– ROC drive.

– 4/16 Mbps Token Ring Controller Adapter card.

• 15-inch color display monitor.

• Keyboard.

• Pointing device (mouse) and pad.

• 6.1-meter (20-foot) Token Ring adapter cable.

• Ac power cables (for the system unit and color monitor) configured for
length and plug type according to site requirements.  Minimum length is
1.8 meters (6 feet).

Standby Timer Console
It is recommended that a standby Console be installed and configured to take over
administrative, operator, and maintenance tasks if the active Timer Console fails.
The Console application can be open on both Consoles at the same time.

Refer to Maintenance Information for the 9037 Model 2 Sysplex Timer (SY27-2641)
for instructions about installing, configuring, and using a standby Console.
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Shared Console
It is recommended the ESCON Director Console application or Sysplex Timer
Console application be installed on a dedicated PC.  However, both applications
can be installed on the same PC platform for use as a shared Console.  Use of a
shared Console is subject to the following constraints:

• The 9032-003 or 9033-004 Director Console application can be installed on a
Model PC-330 Sysplex Timer Console.

• All Director Console applications can be installed on a Model PC-365 or PC
300 PL Sysplex Timer Console.

• The Sysplex Timer Console application can be installed on a Model PS/2,
PC-330, PC-365, or PC 300 PL Director Console.

• The Director Console and Sysplex Timer Console applications can be
installed on an S/390 server’s Hardware Management Console.
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Chapter 2. Win-OS/2 Basics

This chapter provides an introduction to working with the Enterprise Systems
Connection (ESCON) Director or Sysplex Timer Console application in a Windows-
Operating System/2 (Win-OS/2) environment.

The chapter describes:

• The OS/2 desktop.

• Standard OS/2 procedures.

• Working in Win-OS/2.

The OS/2 Desktop
This section describes the OS/2 desktop and its components (including the launch
pad and desktop objects), and OS/2 windows. The OS/2 desktop (Figure 8) shows
the Director Console and Sysplex Timer Console applications installed (application
icons appear on the desktop as objects), and is customized for working with either
or both applications.

Note: The OS/2 desktop may look different, depending on the OS/2 version
(Warp Connect 3.0 or Warp 4.0) installed on the Console.

Figure 8. OS/2 Desktop

Launch Pad

Desktop Objects
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Launch Pad
The launch pad (Figure 9) contains a set of object drawers that are accessed and
used to perform OS/2 administrative tasks related to the Director and Sysplex
Timer Console applications.  Click the drawer arrow (to the right of each drawer)
to open a drawer and access a series of buttons to perform the desired Director or
Sysplex Timer Console administrative task.

The functions of buttons accessed through launch pad drawers are not described
in detail in this chapter.  Launch pad functions are described in procedural steps
elsewhere in this publication when applicable to a specific Director or Sysplex
Timer administrative task.

Figure 9. Launch Pad

The following drawers appear on the launch pad:

• OS/2 Window  - This drawer accesses the OS/2 window, disk operating
system (DOS) window, set date and time, and program manager functions.

• Drive A  - This drawer accesses the Console’s A:  drive, C: drive, and a build
diagnostic diskette function.

• DCAF Target  - This drawer accesses Distributed Console Access Facility
(DCAF) target, DCAF controller, remote setup, Communication Manager/2
(CM/2) setup, start CM/2, and stop CM/2 functions.

• TCP/IP Cnfg. - This drawer accesses Transmission Control Protocol/Internet
Protocol (TCP/IP) configuration, LAN Adapter and Protocol Support (LAPS)
for OS/2 Warp Connect 3.0 applications, Multi-Protocol Transport Services
(MPTS), Address Resolution Protocol (ARP), and LANAID™ functions.

Shut down Button

Backup Drawer (Warp 4.0)
DualStor Button (Warp Connect 3.0)

OS/2 Window Drawer

Drive A Drawer

DCAF Target Drawer

TCP/IP Cnfg. Drawer
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• Backup  - This drawer accesses backup, restore, set default backup time,
and modify backup schedule functions for OS/2 Warp 4.0 applications.  The
drawer does not appear on the Warp Connect 3.0 launch pad.

• DualStor  - This button accesses IBM-licensed software to perform backup
and restore functions for OS/2 Warp Connect 3.0 applications.  The button
does not appear on the Warp 4.0 launch pad.

The launch pad also contains a Shutdown button.  Click this button to shut down
the OS/2 operating system and the Director or Sysplex Timer Console.

Desktop Objects
The top portion of the OS/2 desktop contains a set of objects (icons) used to start
the Director Console application, start the Sysplex Timer Console application, or
open tool folders and windows to perform OS/2 administrative tasks.

The functions of all the desktop objects are not described in detail in this chapter.
Object functions are described in procedural steps elsewhere in this publication
when applicable to a specific Director or Sysplex Timer administrative task.  The
following objects (icons) appear on the OS/2 desktop:

• OS/2 System (Warp Connect 3.0)  -Double-click the OS/2 System icon to
open the OS/2 System - Icon View.  Icons in this window access disk drives,
system setup utilities, and the Startup, Command Prompts, and Productivity
folders.  Refer to your Win- OS/2 documentation for additional information.

• OS/2 Applications (Warp Connect 3.0) - Double-click the OS/2 Applications
icon to open the OS/2 Applications - Icon View.  Icons in this window access
a variety of OS/2 applications.  Icons also access DCAF, DualStor, and
TCP/IP functions.  Refer to your Win-OS/2 documentation for additional
information.
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• OS/2 System (Warp 4.0)  - Double-click the OS/2 System icon to open the
OS/2 System - Icon View.  Icons in this window access disk drives, system
setup utilities, the toolbar, and the Command Prompts, Startup, and Utilities
folders.  Refer to your Win-OS/2 documentation for additional information.

• Programs (Warp 4.0)  - Double-click the Programs icon to open the OS/2
Programs - Icon View.  Icons in this window access the assistance center,
peripheral connections, minimized window viewer, shredder, and the Console
Applications, Templates, Win- OS/2 Groups, and Windows Programs folders.
Refer to your Win- OS/2 documentation for additional information.

• Director Console  - Double-click the Director Console icon to open the
Director Console application.

• ESCON Director Tools  - Double-click the ESCON Director Tools folder to
open the ESCON Director Tools - Icon View.  Icons in this window migrate
Director definitions to another Console and collect Director maintenance
data.

• Sysplex Timer Console  - Double-click the Sysplex Timer Console icon to
open the Sysplex Timer Console application.
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• Sysplex Timer Tools  - Double-click the Sysplex Timer Tools folder to open
the Sysplex Timer Tools - Icon View. The icon in this window collects Sysplex
Timer maintenance data.

OS/2 Windows
An OS/2 window is a bounded area of the screen that contains application icons,
utility icons, or other information.  A window can be smaller than or the same size
as the screen.  Warp Connect 3.0 windows appear slightly different than Warp 4.0
windows.

An OS/2 Warp Connect 3.0 window (Figure 10) contains the following components:

• At the top of the window is a title bar that displays the title of the window.

• On the title bar are three buttons; the Control Box Menu button on the left,
and the Minimize and Maximize buttons on the right.

– Click the Control Box Menu button to display a pull-down menu of window
utility functions.  Double-click the Control Box Menu button to close the
window.

– Click the Minimize button to minimize the window to an icon.

– If the window is partial-screen size, click the Maximize button to change
the window to full-screen size. If the window is full- screen size, click the
Maximize button to change the window to partial-screen size.

• The space inside the window contains icons or other information.

 Figure 10. OS/2 Warp Connect 3.0 Window Components
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An OS/2 Warp 4.0 window (Figure 11) contains the following components:

• At the top of the window is a title bar that displays the title of the window.

• On the title bar are four buttons: the Control Box Menu button on the left, and
the Close, Minimize, and Maximize buttons on the right.

– Click the Control Box Menu button to display a pull-down menu of window
utility functions.  Double-click the Control Box Menu button to close the
window.

– Click the Close button to close the window to an icon.

– Click the Minimize button to minimize the window to an icon.

– If the window is partial-screen size, click the Maximize button to change
the window to full-screen size. If the window is full- screen size, click the
Maximize button to change the window to partial-screen size.

• Below the title bar is a menu bar that contains menu pull-down options
pertaining to the window.

• The space inside the window contains icons or other information.

 Figure 11. OS/2 Warp 4.0 Window Components

Standard OS/2 Procedures
This section describes standard OS/2 procedures that are referenced in other
chapters in this publication.  The procedures include:

• Transferring between a Console application and the OS/2 desktop.

• Shutting down and restarting a Console application.

• Shutting down and restarting the OS/2 operating system and Console.

Control Box Menu Button
Title Bar

Close Button
Minimize Button

Maximize

Menu

Button
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Transfer Between a Console Application and the OS/2 Desktop
Use the following procedures to transfer from a Console application to the OS/2
desktop or to transfer from the desktop to a Console application.

To transfer from the Director Console application to the OS/2 desktop, refer to
"From the Director Console Application" below.  To transfer from the Sysplex
Timer Console application to the OS/2 desktop, refer to "From the Sysplex Timer
Console Application" below.  To transfer from the OS/2 desktop to a Console
application, refer to "From the OS/2 Desktop" on page 22.

From the Director Console Application
To transfer from the Director Console application to the OS/2 desktop:

1. At the Startup or any active matrix window, simultaneously press the Ctrl and
Esc  keys.  The Window List appears.

2. Double-click the Desktop-Icon View selection.  The OS/2 desktop appears.

Note: The OS/2 desktop may look different, depending on the OS/2 version
(Warp Connect 3.0 or Warp 4.0) installed on the Director Console.

3. If you were directed to this task from another procedure, return to that
procedure.

From the Sysplex Timer Console Application
To transfer from the Sysplex Timer Console application to the OS/2 desktop:

1. At the Startup or Sysplex Timer Network Console window, simultaneously
press the Ctrl  and Esc  keys.  The Window List appears.
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2. Double-click the Desktop-Icon View selection.  The OS/2 desktop appears.

Note: The OS/2 desktop may look different, depending on the OS/2 version
(Warp Connect 3.0 or Warp 4.0) installed on the Director Console.

3. If you were directed to this task from another procedure, return to that
procedure.

From the OS/2 Desktop
To transfer from the OS/2 desktop to the ESCON Director or Sysplex Timer
Console application:

1. Perform one of the following:

– To transfer to the Director Console application, simultaneously press the
Ctrl  and Esc  keys at the OS/2 desktop.  The Window List appears.

Double-click the Director Console - Director Console selection.
The Startup or an active matrix window appears when the Console
application is open and running.  It may take up to 30 seconds for the
Director Console application to open.
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– To transfer to the Sysplex Timer Console application, simultaneously
press the Ctrl  and Esc  keys at the OS/2 desktop.  The Window List
appears.

Double-click the Sysplex Timer Console - Sysplex Timer Console
selection. The Startup or Sysplex Timer Network Console window
appears when the Console application is open and running.  It may take
up to 30 seconds for the Sysplex Timer Console application to open.

2. If you were directed to this task from another procedure, return to that
procedure.

Shut Down and Restart a Console Application
To shut down and restart the ESCON Director Console application from the OS/2
desktop, continue to "Director Console Application" on page 24. To shut down and
restart the Sysplex Timer Console application from the OS/2 desktop, refer to
"Sysplex Timer Console Application" on page 25.  Both procedures initiate
changes to software options.
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Director Console Application
To shut down and restart the ESCON Director Console application:

1. From the Startup window or any active matrix window, select the Exit option
from the File menu.  The following dialog box appears.

2. Click the OK button to close the dialog box. The OS/2 desktop appears. The
Director continues to operate normally after exiting the Console application.

3. At the OS/2 desktop, double-click the Director Console icon to start the
Console application. The Startup window appears when the Console
application is open and running.  It may take up to 30 seconds for the
Director Console application to open.

4. If you were directed to this task from another procedure, return to that
procedure.
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Sysplex Timer Console Application
To shut down and restart the Sysplex Timer Console application:

1. From the Startup or Sysplex Timer Network Console window, select the Exit
option from the File menu.  The following dialog box appears.

2. Click the Exit button to close the dialog box.  The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the Console
application.

3. At the OS/2 desktop, double-click the Sysplex Timer Console icon to start
the Console application. The Startup window appears when the Console
application is open and running. It may take up to 30 seconds for the Sysplex
Timer Console application to open.

4. If you were directed to this task from another procedure, return to that
procedure.
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Shut Down and Restart the OS/2 Operating System and Console
Use this procedure to shut down and restart the OS/2 operating system and
Console and to initiate changes to software options.  This procedure also shuts
down the Director and Sysplex Timer Console applications (if the applications
are running).  To shut down and restart the Console:

1. At the OS/2 desktop, click the Shutdown button at the bottom of the launch
pad.  Dialog boxes appear for each active application (and the operating
system), asking if you want to close the application without saving data.

2. Click the OK or Yes button (as applicable) as each dialog box appears.
Eventually a Shutdown Has Completed message box appears, explaining
it is now safe to turn off the computer or restart.

3. Switch off power on the PC Console, wait 10 seconds, then switch power
back on.  The Console performs POSTs and loads the operating system.
Upon completion, the OS/2 desktop appears.

4. Perform one of the following:

– Double-click the Director Console icon to start the Console application.
The Startup window appears when the Console application is open
and running.  It may take up to 30 seconds for the Director Console
application to open.

– Double-click the Sysplex Timer Console icon to start the Console
application. The Startup window appears when the Console application
is open and running. It may take up to 30 seconds for the Sysplex Timer
Console application to open.
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5. If you were directed to this task from another procedure, return to that
procedure.

Working in Win-OS/2
This section describes how to work in a typical Win-OS/2 application, and
discusses general terms, windows components, dialog boxes, edit fields, and
other features.  Refer to your Win-OS/2 documentation for additional information.

Definitions of Terms
In the Win-OS/2 environment, tasks are performed in rectangular areas of the
screen called windows.  These windows appear on a background called the
desktop.  There are two types of windows; application and document.

• An application window contains a running program.

• A document window is contained inside an application window and can
usually be edited.

Applications (executable programs) are represented by graphic symbols called
icons.  Information is entered or actions are acknowledged using dialog boxes.

The Mouse
Most actions performed in the Win-OS/2 environment involve the mouse. A mouse
is used to point at and select objects, and to execute commands (instead of typing
the commands). To select an item (such as an icon), place the mouse cursor over
the item and click the left mouse button.  To start an application, place the mouse
cursor over the application icon and double-click the left mouse button.
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The mouse cursor assumes several different shapes:

• On the desktop or along the top of the screen in an application, it assumes
the shape of a pointer arrow.

• Along the side or corner of a window, it assumes the shape of a double
arrow, allowing the window to be resized in the directions of the arrow.

• In an edit field in a dialog box, it assumes the shape of a capital I ,
sometimes called an I-beam.

• After initiating an action, the it assumes the shape of an hourglass during
the processing time for the action.

Window Components
Win-OS/2 windows (Figure 12) contain the following components:

• At the top of the window is a title bar that displays the title of the document
or application.

• On the title bar are three buttons; the Control Box Menu button on the left,
and the Minimize and Maximize buttons on the right.

• Below the title bar is a menu bar that contains menu pull-down options
pertaining to the application.

• At the right and bottom sides of the window are horizontal and vertical
scroll bars, scrolling indicators, and scroll arrows.

• The space inside the window is the workspace.

 Figure 12. Win-OS/2 Window Components
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Minimize, Restore, and Maximize Windows
The Minimize and Maximize buttons are at the right corner of the title bar.  Use
these buttons to change the size of a window from a full screen to a partial screen
or an icon.  This process is useful to compare the contents of one window to
another, or to shrink a window to an icon.

The button with the down arrow is the Minimize button. Click the button to shrink a
window to an icon.  To restore a minimized icon, double-click the icon or click and
hold until the Control Box menu appears, and then select the Restore option.

The button with the up arrow is the Maximize button.  Click the button to enlarge a
window to full screen.  In full-screen mode, the Maximize button has an up and
down arrow to switch between windowed and full-screen modes.

Moving and Resizing Windows
To move a window:

1. Place the mouse cursor on the window’s title bar.

2. Click anywhere on the title bar, hold the left mouse button, and move (drag)
the window to the desired position.

3. Release the mouse button.

To resize a window:

1. Click anywhere in a window with the left mouse button to make the window
active.

2. Place the mouse cursor on a top, bottom, or side edge (to resize horizontally
or vertically), or on a corner (to resize diagonally).  The mouse pointer
changes to a double arrow, indicating the direction of change.

3. Drag the edge or corner to the desired size.

4. Release the mouse button.

Closing a Window
To close a window:

• Double-click the Control Box Menu button,

or

• Single-click the Control Box Menu button and select either the Exit or Close
option.

Exiting Windows also closes any open windows and applications.
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Using Scroll Bars
Scroll bars allow you to view the contents of a window when the contents exceed
the displayed area.  Along the right side is the vertical scroll bar, and along the
bottom is the horizontal scroll bar.  To use the scroll bar:

• Place the cursor over a scroll bar arrow and click the left mouse button once
to scroll one unit in the direction of the arrow.

• Place the cursor over the box in a scroll bar, click and hold the left mouse
button, and drag the box through the scroll bar.

• To make large jumps, place the cursor anywhere in a scroll bar above or
below the box and click the left mouse button.

Menu Bars
To perform a menu command in Windows, click the command on the menu bar with
the left mouse button to display a pull-down menu.  Menus can also be opened by
pressing the Alt  key and the underlined letter representing the menu option.

When a pull-down menu is open, click the left mouse button to perform the menu
command selected. To cancel a selection, move the cursor off the menu selection
and press the left mouse button, or press the Esc or Alt  key.

Organizing Windows
When several windows are open, it may be hard to find information or icons.  To
rearrange the windows or open hidden icons, click the Windows option on the
menu bar.  From this menu:

• Cascade  - This option stacks open windows one on top of the other with the
title bars showing.

• Tile  - This option places open windows into side-by-side tiles showing a
portion of each window.

• Arrange Icons  - This option arranges program icons in the selected window
or minimized icons on the desktop.

• Numbered groups show all program groups and allow you to select them.

Dialog Boxes
Dialog boxes (Figure 13) are used to enter information or to acknowledge an
action performed by an application.  Information is typed in an edit field, selected
by clicking items in a list box, or selected with an operation button, radio button, or
check box.
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Figure 13. Dialog Box Components

Edit Field
Information such as passwords and network addresses is entered in an edit field.
When an edit field is selected, the cursor appears at the beginning of the field.
After entering information, press the Tab key to move the cursor out of the edit
field.

Operation Button
Click an operation button to select or acknowledge an action.  Most dialog boxes
contain at least one operation button to exit or close the dialog box. If an operation
button is light gray, the operation is inactive and cannot be selected.

List Box
A list box contains a list of selectable options.  The list may be open (all options
appear) or hidden.  A hidden list box is identified by a down arrow adjacent to the
list.  A selection is made by clicking the down arrow and selecting the desired list
option.

List BoxCheck Box Operation Button

Radio Button Edit Field
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Radio Button
Click a radio button to enable or disable a selection.  Radio buttons are used for
selectable items (usually two or three) with clearly defined and mutually exclusive
alternatives.

Minimizing and Restoring Application Windows
To minimize a window to a desktop icon, click the Minimize button.  To restore a
minimized application:

• Double-click the application icon.

• Simultaneously press the Ctrl  and Esc  keys to display the Window List,
then double-click the application name.

• Simultaneously press the Alt  and Esc  keys to toggle through the minimized
icons.

• Simultaneously press the Alt  and Tab keys to display a box with the
minimized application name.  Release the Alt key to restore the application
window.
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Chapter 3. Hardware Management Console Support

The Hardware Management Console is a dedicated PC platform running the
Hardware Management Console application (HWMCA).  The Console is designed
as an operations and management platform for System/390 (S/390) servers.

This chapter provides instructions to:

• Install the Enterprise Systems Connection (ESCON) Director Console or
Sysplex Timer Console application on the Hardware Management Console.

• Start or close the Director or Sysplex Timer Console application.

• Back up critical Hardware Management Console data.

• Perform data collection, backup, restore, and other procedures accessed
from the ESCON Director or Sysplex Timer Tools folders.

• Delete the Director or Sysplex Timer Console application from the Hardware
Management Console.

Information that Does Not Apply
Information in the following sections of this publication does not apply to the
Hardware Management Console:

• The "Back Up the Console Fixed Disk to Tape" procedures in Chapters 5
and 6.

• The "Back Up the System Library to Tape" procedures in Chapters 5 and 6.

• The "Back Up the System Library to ROC" procedure in Chapters 7 and 8.

• The "Set or Change Default Printer" procedures in Chapters 5, 6, 7 and 8.

Install the Director or Sysplex Timer Console Application
To install the Director Console or Sysplex Timer Console application (or both)
on the Hardware Management Console, contact your IBM service representative
and order the appropriate feature (Feature Number 5901 for the Director Console
application or Feature Number 4910 for the Sysplex Timer Console application).

Before adding a feature to the base Hardware Management Console, read
“Use of Other Applications and Features” in the Hardware Management Console
Guide (GC38-0453).
33  Copyright IBM Corp. 1999



Install the Director Console Application
To install the Director Console application on the Hardware Management Console,
order Install and Maintain the ESCON Director Console Application on the
Hardware Management Console (Feature #5901).  This miscellaneous equipment
specification (MES) instruction includes:

• Procedures to verify prerequisites are met.

• Bill of materials for installation.

• Installation details.

• Test procedures.

• Post-installation maintenance information.

Install the Timer Console Application
To install the Timer Console application on the Hardware Management Console,
order Install and Maintain the 9037 Model 2 Sysplex Timer Console Application on
the Hardware Management Console (Feature #4910).  This MES instruction
includes:

• Procedures to verify prerequisites are met.

• Bill of materials for installation.

• Installation details.

• Test procedures.

• Post-installation maintenance information.

Start and Shut Down the Director or Sysplex Timer Console Application
Before closing the HWMCA or powering off the Hardware Management Console,
you must shut down the ESCON Director Console application or Sysplex Timer
Console application (or both).  Conversely, if you closed the HWMCA, you must
restart the HWMCA before you restart either the ESCON Director or Sysplex Timer
Console applications.

The following paragraphs describe how to start and shut down the Director
Console application and the Sysplex Timer Console application.

Attention!

You cannot install the Director or Timer Console application on a Hardware
Management Console that is already controlling the maximum number of
Console sessions (16).  The 16 Console sessions may include up to 16
Director sessions and up to two Timer network sessions.
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Start the Director Console Application
To start the Director Console application:

1. At the Hardware Management Console’s Operating System/2 (OS/2)
desktop, double-click the Extra Applications folder.  The Extra Applications -
Icon View appears.

2. In the Extra Applications - Icon View, double-click the Director Console icon.
The Director Console Startup window appears. It may take up to 30 seconds
for the Console application to open.

Shut Down the Director Console Application
To close the Director Console application:

1. Select the Exit option from the File menu.  The dialog box on the following
page appears.
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2. Click the OK button to close the dialog box.  The Extra Applications - Icon
View appears.

3. Double-click the upper left corner of the Extra Applications - Icon View to
close the view and return to the OS/2 desktop.

Note: The OS/2 desktop may look different, depending on the OS/2 version
installed on the Hardware Management Console.

Start the Timer Console Application
To start the Sysplex Timer Console application:

1. At the Hardware Management Console’s OS/2 desktop, double-click the
Extra Applications folder.  The Extra Applications - Icon View appears.
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2. In the Extra Applications - Icon View, double-click the Sysplex Timer Console
icon.  The Timer Console Startup window displays.

Shut Down the Timer Console Application
To close the Sysplex Timer Console application:

1. Select the Exit option from the File menu.  The following dialog box appears.

2. Click the Exit button to close the dialog box.  The Extra Applications - Icon
View appears.
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3. Double-click the upper left corner of the Extra Applications - Icon View to
close the view and return to the OS/2 desktop.

Note: The OS/2 desktop may look different, depending on the OS/2 version
installed on the Hardware Management Console.

4. If possible, leave the Timer Console application active and operational for the
following reasons:

– Certain Timer events and associated reason codes are transmitted only
to the Event log maintained at the Timer Console.  The events are not
transmitted through attached processors to the System Control Program
(SCP) Console. If the Console application is closed and a Timer network
failure occurs, reason codes and other information required for fault
isolation may not be recorded.

– Closing the Console application causes an ETR Service is Requested
message to be reported to the SCP Console with reason code 40
(communication lost with active Console) or reason code 41
(communication lost with standby Console).  This may result in an
unnecessary service call.
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– Starting the Console application causes an ETR Service is Requested
message to be reported to the SCP Console, with reason code 8
(communication established with active Console) or reason code 9
(communication established with standby Console).  This may result in
an unnecessary service call.

Back Up Critical Data
If required by the customer, follow procedures for backing up critical data in the
“Backup Critical Data (Hardware Management Console and Support Element)”
section of Chapter 4 of S/390 9672 Parallel Enterprise Server S/390 9674 Coupling
Facility; Installation Manual For R2 and R3 Based Models (SY24-6152).

This procedure backs up critical data for the Hardware Management Console and
associated mainframe support elements. The procedure does not back up system
libraries for the Director Console or Sysplex Timer Console applications.  To back
up data for the Director or Timer Console applications, refer to procedures in
Chapters 5, 6, 7, and 8 of this guide.

ESCON Director Tools Folder
The ESCON Director Tools folder (accessed from the Extra Applications - Icon
View) contains program-executable icons that allow a user to:

• Perform the data collection procedure after a system problem occurs or when
a field-replaceable unit (FRU) is removed and replaced.

• Migrate Director Console definitions to the Hardware Management Console.

• Back up the Director Console library to a rewriteable optical cartridge (ROC).

• Restore the Director Console library from a ROC.

The following sections provide instructions to perform the administrative
procedures listed above.

Data Collection Procedure (Director)
The data collection procedure transfers maintenance information to the Hardware
Management Console’s fixed disk, then to a 3.5-inch diskette.  The diskette is
mailed to the original equipment manufacturer (OEM) for problem analysis and
resolution.  Perform the data collection procedure after a Director problem occurs
or when a FRU is removed and replaced.

1. With the Director’s active matrix window open, select the Collect
Maintenance Information option from the Maintenance menu.  The Collect
Maintenance Information dialog box appears showing files being transferred
and the transfer status.  When all files are transferred to the fixed disk, the
following dialog box appears.
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2. Click the OK button to close the dialog box.  The Director’s active matrix
window reappears.

3. Record the Director name.  The name (up to eight characters in length)
appears on the title bar at the top of the active matrix window.

4. Simultaneously press the Ctrl  and Esc  keys to transfer to the Hardware
Management Console’s OS/2 desktop.  The Window List appears.

5. Double-click the Desktop-Icon View selection.  The Hardware Management
Console’s OS/2 desktop appears.

6. If the Extra Applications - Icon View is not open, double-click the Extra
Applications folder to open it.

7. Insert a data collection diskette into drive A:  of the Hardware Management
Console in accordance with one of the following steps:

– If you are removing and replacing a FRU in the 9032 Model 3 ESCON
Director, use the data collection diskette shipped with the replacement
FRU.  The diskette is labeled Data Collection Diskette.

– If you are removing and replacing a FRU in the 9032 Model 5 ESCON
Director or collecting data for another purpose (such as fault isolating
problems), use a data collection diskette shipped with the Director.  The
diskette is labeled Data Collection Utility Version XX.YY.ZZ, where
XX.YY.ZZ is the Licensed Internal Code (LIC) version number.

– If a labeled data collection diskette is not available, a blank, DOS-
formatted diskette may be used.
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8. At the Extra Applications - Icon View, double-click the ESCON Director Tools
folder.  The ESCON Director Tools - Icon View appears.

9. Double-click the ESCON Director Data Collection icon.  The first ESCON
Director Data Collection window appears.

10. Type Y and press the Enter  key.  The second ESCON Director Data
Collection window appears.

11. Type the Director name recorded in step 3 and press the Enter  key.
Messages appear in the window showing files transferring from the fixed
disk to diskette.  The process is complete when the Enter prompt appears.
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12. Press the Enter  key.  The ESCON Director Data Collection window closes.

13. Double-click the upper left corner of the ESCON Director Tools - Icon View
to close the view and return to the OS/2 desktop.

14. Remove the data collection diskette from drive A:  of the Hardware
Management Console.  Record the following information on the diskette
label.

– Director serial number.

– Quality Service Activity Reporting (QSAR) number.

– Problem Management - Hardware (PMH) number.

– Current date.

15. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

Migrate Director Definitions
If the Director Console application is discontinued at a Console (Director or
Hardware Management) and installed on a new Console (Director or Hardware
Management), Director definitions must be recorded on a 3.5-inch diskette and
migrated to the new Console.  Director definitions include Internet Protocol (IP)
addresses, Director names, model numbers, and matrix configuration files.

If the Console application is discontinued at the Hardware Management Console
and installed on a Director Console, a definitions diskette must be created at the
Hardware Management Console.  Refer to "Create Director Definitions Diskette"
below for instructions.

If the Console application is discontinued at the Director Console and installed
on a Hardware Management Console, Director definitions must be migrated.  For
instructions, refer to "Migrate Definitions to the Hardware Management Console"
on page 44.

Create Director Definitions Diskette
Perform this procedure to create a Director definitions diskette at the Hardware
Management Console.

1. If the Director Console application is closed and the Hardware Management
Console’s OS/2 desktop appears, go to step 4.

2. If the Director Console application is open, simultaneously press the Ctrl and
Esc keys to transfer to the Hardware Management Console’s OS/2 desktop.
The Window List appears.
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3. Double-click the Desktop-Icon View selection.  The Hardware Management
Console’s OS/2 desktop appears.

4. Insert the Console application diskette (labeled Console Version XX.YY.ZZ)
into drive A:  of the Hardware Management Console.

5. Double-click the OS/2 System icon.  The OS/2 System - Icon View appears.

6. Double-click the Drives icon.  The Drives - Icon View appears.

7. Double-click the Drive A icon.  The Drive A - Icon View appears.

8. Double-click the DCGETDEF.CMD icon.  The DCGETDEF.CMD window
appears.
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9. Remove the Console application diskette from drive A:  of the Hardware
Management Console and insert a blank, DOS-formatted diskette (provided
with the Director).

10. Press the Enter  key.  Director definitions are copied to the diskette, and the
copy progress appears in the DCGETDEF.CMD window.  When the process
is complete, the DCGETDEF.CMD window closes.

11. Double-click the upper left corner of the Drive A - Icon View, Drives - Icon
View, and OS/2 System - Icon View to close the views and return to the
OS/2 desktop.

12. Remove the Director definitions diskette from drive A:  of the Hardware
Management Console.

13. Label and store the Director definitions diskette as appropriate. The diskette
can now be used to transport definitions to a new Console.

Migrate Definitions to the Hardware Management Console
Perform this procedure to migrate Director definitions from a Director Console to
the Hardware Management Console.

Note: This procedure does not work if the Director Console application is open
or if the Director Console library already contains definitions.

1. If required, close the Director Console application.  Refer to "Shut Down the
Director Console Application" on page 35 for instructions.

2. Double-click the Extra Applications folder to open the Extra Applications -
Icon View.

3. At the Extra Applications - Icon View, double-click the ESCON Director Tools
folder.  The ESCON Director Tools - Icon View appears.

4. Double-click the Put Director Definitions Director Console Migration icon.
The Put Director Definitions Director Console Migration window appears.
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Note: If a warning appears indicating migration was terminated because
Director definitions exist in the Console library, press the Enter  key
to close the Put Director Definitions Director Console Migration
window and exit the utility.

If a warning appears indicating migration was terminated because
the Console library was not initialized, press the Enter  key to close
the Put Director Definitions Director Console Migration window
and exit the migration utility.  Open and close the Director Console
application, then perform this procedure again.

5. Insert the Director definitions diskette (created at the Console from which the
definitions are migrated) into drive A: of the Hardware Management Console.

6. Press the Enter  key.  Director definitions are copied to the Hardware
Management Console’s fixed disk to be used to initialize the Director Console
library.  When the process is complete, the Put Director Definitions Director
Console Migration window closes.

7. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

8. Remove the Director definitions diskette from drive A:  of the Hardware
Management Console.  Store the Director definitions diskette as appropriate.

9. At the Extra Applications - Icon View, double-click the Director Console icon
to restart the Console application.

Back Up the Director System Library
Before updating the Hardware Management Console code, configuration files
associated with the Director must be saved on a backup ROC.  Perform the
following procedure to back up the Director configuration files.

1. If required, close the Director Console application.  For instructions, refer to
"Shut Down the Director Console Application" on page 35.
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2. Double-click the Extra Applications folder to open the Extra Applications -
Icon View.

3. At the Extra Applications - Icon View, double-click the ESCON Director Tools
folder.  The ESCON Director Tools - Icon View appears.

4. Double-click the Backup Library Director Console Archive icon.  The Backup
Library Director Console Archive window appears.

5. Insert a backup ROC into the optical drive and press the Enter  key.  When
the backup operation completes, the Backup Library Director Console
Archive window closes.

6. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

7. Remove the backup ROC from the optical drive. Label and store the backup
ROC as appropriate.

Restore the Director System Library
After updating the Hardware Management Console code, configuration files
associated with the Director must be restored from the backup ROC.  Perform the
following procedure to restore the Director configuration files.

1. If required, close the Director Console application.  For instructions, refer to
"Shut Down the Director Console Application" on page 35.

2. Double-click the Extra Applications folder to open the Extra Applications -
Icon View.
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3. At the Extra Applications - Icon View, double-click the ESCON Director Tools
folder.  The ESCON Director Tools - Icon View appears.

4. Double-click the Restore Library Director Console Archive icon. The Restore
Library Director Console Archive window appears.

5. Insert the ROC that was used to back up the Director files into the optical
drive and press the Enter  key.  When the restore operation completes, the
Restore Library Director Console Archive window closes.

6. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

7. Remove the backup ROC from the optical drive. Replace the backup ROC in
its original storage location.

Sysplex Timer Tools Folder
The Sysplex Timer Tools folder (accessed from the Extra Applications - Icon View)
contains program-executable icons that allow a user to:

• Perform the data collection procedure after a system problem occurs or when
a FRU is removed and replaced.

• Back up the Sysplex Timer Console library to a ROC.

• Restore the Sysplex Timer Console library from a ROC.
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The following sections provide instructions to perform the administrative
procedures listed on the preceding page.

Data Collection Procedure (Sysplex Timer)
The data collection procedure transfers maintenance information to a 3.5-inch
diskette.  The diskette is mailed to the OEM for problem analysis and resolution.
Perform the data collection procedure after a Sysplex Timer problem occurs or
when a FRU is removed and replaced.

1. At the Sysplex Timer Network Console window, simultaneously press the
Ctrl  and Esc  keys to transfer to the Hardware Management Console’s OS/2
desktop.  The Window List appears.

2. Double-click the Desktop-Icon View selection.  The Hardware Management
Console’s OS/2 desktop appears.

3. If the Extra Applications - Icon View is not open, double-click the Extra
Applications folder to open it.

4. At the Extra Applications - Icon View, double-click the Sysplex Timer Tools
folder.  The Sysplex Timer Tools - Icon View appears.

5. Double-click the Sysplex Timer Data Collection icon.  The Sysplex Timer
Data Collection window appears.
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6. Insert a data collection diskette into drive A:  of the Hardware Management
Console.  The diskette is labeled Data Collection Diskette.

Note: If a labeled data collection diskette is not available, a blank, DOS-
formatted diskette may be used.

7. Press the Enter  key.  Messages appear in the window showing files
transferring from fixed disk to diskette.  The data collection process is
complete when the Enter prompt appears.

8. Press the Enter  key.  The Sysplex Timer Data Collection window closes.

9. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

10. Remove the data collection diskette from drive A:  of the Hardware
Management Console.  Record the following information on the diskette
label.

– Timer serial number.

– QSAR number.

– PMH number.

– Current date.

11. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

Back Up the Sysplex Timer System Library
Before updating the Hardware Management Console code, configuration files
associated with the Sysplex Timer must be saved on a backup ROC.  Perform the
following procedure to back up the Sysplex Timer configuration files.

1. If required, close the Timer Console application.  For instructions, refer to
"Shut Down the Director Console Application" on page 35.
Chapter 3.  Hardware Management Console Support       49



2. Double-click the Extra Applications folder to open the Extra Applications -
Icon View.

3. At the Extra Applications - Icon View, double-click the Sysplex Timer Tools
folder.  The Sysplex Timer Tools - Icon View appears.

4. Double-click the Backup Library Sysplex Timer Console Archive icon.  The
Backup Library Sysplex Timer Console Archive window appears.

5. Insert a backup ROC into the optical drive and press the Enter  key.  When
the backup operation completes, the Backup Library Sysplex Timer Console
Archive window closes.

6. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

7. Remove the backup ROC from the optical drive. Label and store the backup
ROC as appropriate.

Restore the Sysplex Timer System Library
After updating the Hardware Management Console code, configuration files
associated with the Sysplex Timer must be restored from the backup ROC.
Perform the following procedure to restore the Timer configuration files.

1. If required, close the Timer Console application.  Refer to "Shut Down the
Timer Console Application" on page 37 for instructions.

2. Double-click the Extra Applications folder to open the Extra Applications -
Icon View.

3. At the Extra Applications - Icon View, double-click the Sysplex Timer Tools
folder.  The Sysplex Timer Tools - Icon View appears.
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4. Double-click the Restore Library Sysplex Timer Console Archive icon.  The
Restore Library Sysplex Timer Console Archive window appears.

5. Insert the ROC that was used to back up the Timer configuration files into the
optical drive and press the Enter key. When the restore operation completes,
the Restore Library Sysplex Timer Console Archive window closes.

6. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

7. Remove the backup ROC from the optical drive. Replace the backup ROC in
its original storage location.

Uninstall the Director or Sysplex Timer Console Application
To discontinue operations and delete the Director Console or Sysplex Timer
Console application (or both) from the Hardware Management Console, perform
the procedures described in the following paragraphs.

Uninstall the Director Console Application
If the Director Console application is to be uninstalled from the Hardware
Management Console, perform the following procedures:

• Delete the Console application from the Hardware Management Console’s
fixed disk

• Delete the Director Console icon and ESCON Director Tools folder from the
Extra Applications folder

• If there are no other application icons (such as the Sysplex Timer Console
application) in the Extra Applications folder, delete the folder.
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Delete Console Application
Perform the following procedure to delete the Director Console application from
the Hardware Management Console’s fixed disk.

1. If required, close the Director Console application.  For instructions, refer to
"Shut Down the Director Console Application" on page 35.

2. At the Hardware Management Console’s OS/2 desktop, double-click the
OS/2 System icon.  The OS/2 System - Icon View appears.

3. Double-click the Drives icon.  The Drives - Icon View appears.

4. Double-click the Drive D icon.  The Drive D - Tree View appears.

5. Double-click the EXTRA folder.  The EXTRA - Icon View appears.

6. Single-click (highlight) the ESCD folder, then select the Delete option from
the Edit menu.  The Delete Object(s) dialog box appears with ESCD
displayed in the Object list box.

7. Click (uncheck) the Confirm on folder delete and Confirm on object delete
check boxes, then click the Delete button.  The Confirm on Data File delete
dialog box appears.
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8. Click the Yes to all button.  The Director Console application is deleted from
the Hardware Management Console’s fixed disk.

9. Double-click the upper left corner of the EXTRA - Icon View, Drive D - Tree
View, Drives - Icon View, and OS/2 System - Icon View to close all views and
return to the OS/2 desktop.

Delete Director Console Icons
Perform the following procedure to delete the Director Console icon and ESCON
Director Tools folder from the Extra Applications folder.

1. At the Hardware Management Console’s OS/2 desktop, double-click the
Extra Applications folder to open the Extra Applications - Icon View.

2. At the Extra Applications - Icon View, select the Director Console icon and
the ESCON Director Tools folder (click and hold the left mouse button, and
drag the cursor over both icons).

3. Select the Delete option from the Edit menu. The Delete Object(s) dialog box
appears with Director Console and ESCON Director Tools displayed in the
Object list box.

4. Click (uncheck) the Confirm on folder delete and Confirm on object delete
check boxes, then click the Delete button.  The Director Console icons are
deleted from the Extra Applications folder.

5. Double-click the upper left corner of the Extra Applications - Icon View to
close the view and return to the OS/2 desktop.
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Delete Extra Applications Folder (Optional)
Perform the following procedure to delete the Extra Applications folder.

1. At the Hardware Management Console’s OS/2 desktop, double-click the
Extra Applications folder to open the Extra Applications - Icon View.

2. Select the Delete option from the Folder menu.  The Delete Object(s) dialog
box appears with Extra Applications displayed in the Object list box.

3. Click (uncheck) the Confirm on folder delete and Confirm on object delete
check boxes, then click the Delete button.  The Extra Applications folder is
deleted from the OS/2 desktop.

Uninstall the Timer Console Application
If the Timer Console application is to be uninstalled from the Hardware
Management Console, perform the following procedures:

• Delete the Console application from the Hardware Management Console’s
fixed disk.

• Delete the Sysplex Timer Console icon and Sysplex Timer Tools folder from
the Extra Applications folder.

• If there are no other application icons (such as the Director Console
application) in the Extra Applications folder, delete the folder.

Delete Console Application
Perform the following procedure to delete the Sysplex Timer Console application
from the Hardware Management Console’s fixed disk.

1. If required, close the Timer Console application.  For instructions, refer to
"Shut Down the Timer Console Application" on page 37.
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2. At the Hardware Management Console’s OS/2 desktop, double-click the
OS/2 System icon.  The OS/2 System - Icon View appears.

3. Double-click the Drives icon.  The Drives - Icon View appears.

4. Double-click the Drive D icon.  The Drive D - Tree View appears.

5. Double-click the EXTRA folder.  The EXTRA - Icon View appears.

6. Single-click (highlight) the TIMER folder, then select the Delete option
from the Edit menu.  The Delete Object(s) dialog box appears with TIMER
displayed in the Object list box.

7. Click (uncheck) the Confirm on folder delete and Confirm on object delete
check boxes, then click the Delete button.  The Confirm on Data File delete
dialog box appears.

8. Click the Yes to all button. The Timer Console application is deleted from the
Hardware Management Console’s fixed disk.

9. Double-click the upper left corner of the EXTRA - Icon View, Drive D - Tree
View, Drives - Icon View, and OS/2 System - Icon View to close the views and
return to the OS/2 desktop.
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Delete Timer Console Icons
Perform the following procedure to delete the Sysplex Timer Console icon and
Sysplex Timer Tools folder from the Extra Applications folder.

1. At the Hardware Management Console’s OS/2 desktop, double-click the
Extra Applications folder to open the Extra Applications - Icon View.

2. At the Extra Applications - Icon View, select the Sysplex Timer Console icon
and the Sysplex Timer Tools folder (click and hold the left mouse button, and
drag the cursor over both icons).

3. Select the Delete option from the Edit menu. The Delete Object(s) dialog box
appears with Sysplex Timer Console and Sysplex Timer Tools displayed in
the Object list box.

4. Click (uncheck) the Confirm on folder delete and Confirm on object delete
check boxes, then click the Delete button.  The Timer Console icons are
deleted from the Extra Applications folder.

5. Double-click the upper left corner of the Extra Applications - Icon View to
close the view and return to the OS/2 desktop.

Delete Extra Applications Folder (Optional)
Perform the following procedure to delete the Extra Applications folder.

1. At the Hardware Management Console’s OS/2 desktop, double-click the
Extra Applications folder to open the Extra Applications - Icon View.

2. Select the Delete option from the Folder menu.  The Delete Object(s) dialog
box appears with Extra Applications displayed in the Object list box.
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3. Click (uncheck) the Confirm on folder delete and Confirm on object delete
check boxes, then click the Delete button.  The Extra Applications folder is
deleted from the OS/2 desktop.
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Chapter 4. Remote Access Console Support

This chapter describes the procedures to enable and use a remote access
Console. With a remote Console, an operator assumes functional control of a local
Console running the Enterprise Systems Connection (ESCON) Director Console
application or Sysplex Timer Console application.

The remote access Console refers to the PC platform installed physically distant
from the Director or Sysplex Timer Console.  The remote access Console is also
called the controller Console.  The remote Console can be a 9032-003, 9033-004,
or 9032-005 ESCON Director Console, a 9037-002 Sysplex Timer Console, or a
Hardware Management Console.

The local Console refers to the PC platform locally running the Director or Sysplex
Timer Console application.  The local Console is also called the target Console.
The local Console can be:

• A Director Console (including either a backup or replacement Console). The
Sysplex Timer application can also be installed on this Console.

• A Sysplex Timer Console (active or standby).  The Director application can
also be installed on this Console.

• A System/390 (S/390) Hardware Management Console running the Director
or Timer Console application (or both).

The remote Console communicates with the local console over a bridged or routed
local area network (LAN), using a customized version of Distributed Console
Access Facility (DCAF) software and Transmission Control Protocol/Internet
Protocol (TCP/IP) software.

To enable and use a remote access Console, an operator activates the DCAF
software at both the remote and local Consoles, and starts the Director or Sysplex
Timer Console application on the local Console.

Note: The customized version of DCAF is supported only for the Director
Console or Sysplex Timer Console applications.

LAN Configurations
This section illustrates Director and Sysplex Timer configurations that connect a
remote Console (controller) to a local Console (target) through a Token Ring LAN
connection and TCP/IP software.  A customized version of DCAF communication
software is installed and resident on the fixed disk of the 9032-003, 9033-004,
9032-005, 9037-002, and Hardware Management Consoles.

Note: The remote Console can be installed on a separate LAN connected to the
local LAN (containing Directors or Timers) through a bridge or router.
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The following figures show the local Console as a:

• Dedicated Director Console.

• Dedicated Sysplex Timer Console.

• Hardware Management Console running the Director and Timer Console
applications.

Figure 14 shows a remote Console attached to a dedicated Director Console
through a remote LAN and TCP/IP connection.  The Console controls Directors
(Models 9032-003, 9033-004, and 9032-005) through a DCAF session with the
Director Console application.  The session can control up to 16 Directors.

Figure 14. Remote Console LAN Connection to ESCON Director Console

Figure 15 shows a remote Console attached to a dedicated Timer Console through
a remote LAN and TCP/IP connection. The Console controls both Sysplex Timers
in an Expanded Availability (EA) network through a DCAF session with the Timer
Console application.  The session can control up to two Sysplex Timer networks.

Figure 15. Remote Console LAN Connection to Sysplex Timer Console
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Figure 16 shows a remote access Console attached to a Hardware Management
Console through a remote LAN and TCP/IP connection.  The remote Console
controls Directors (Models 9032-003, 9033-004, and 9032-005) and an EA Sysplex
Timer network through a DCAF session with the Director and Timer Console
applications.  Both Console applications reside on the Hardware Management
Console fixed disk.  The session can control up to 16 Directors and two Sysplex
Timer networks.

Figure 16. Remote Console LAN Connection to Hardware Management Console

Configure and Use a Console for Remote Access by TCP/IP
This section describes the steps to configure and use a remote Console that
communicates with a local Console through a Token Ring LAN (bridged or routed)
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Local Console Configuration
Perform the following steps to configure the local (target) Console for remote
access through a LAN and TCP/IP connection.

1. Perform the “Set Win-OS/2 Window Session Parameters (Director)” proce-
dure on page 69 and return to this step.

2. Perform one of the following steps to transfer to the Operating System/2
(OS/2) desktop.

Note: The OS/2 desktop may look different, depending on the OS/2
version installed on the Console.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

3. Open the DCAF Target drawer by clicking the drawer arrow on the launch
pad.
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4. Click the Remote Setup button.  The Remote Setup window appears.

5. Type the Internet Protocol (IP) address of the remote Console and press the
Enter  key.  The OS/2 desktop reappears.

Note: Ensure the IP address of the remote Console is different from the IP
address of the local Console.

6. Click the DCAF Target button. The DCAF Target window appears.

7. Double-click the TCP/IP entry.  The IP address of the local (target) Console
appears and Started appears in the right column.
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8. Double-click the minimize button at the upper right corner of the DCAF Target
window to minimize it.

Remote Console Configuration and Session Start
Perform the following steps to configure the remote (controller) Console and start a
DCAF session with the local (target) through a LAN and TCP/IP connection.

1. At the OS/2 desktop of the remote Console, open the DCAF Target drawer
by clicking the drawer arrow on the launch pad.
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Note: When using a Hardware Management Console at application level
1.4.4 as the controller, refer to the Hardware Management Console
Guide (GC38-0453) to define the Director or Timer Console.

Note: The OS/2 desktop may look different, depending on the OS/2
version installed on the Console.

2. Click the DCAF Controller button. A screen with the IBM logo appears briefly,
then the Distributed Console Access Facility window appears.

3. Select the Open Workstation Directory option from the Session menu.  The
DCAF - Directory window appears, displaying an icon for the Console.

Note: If the Distributed Console Access Facility message box appears,
click the OK button to clear the message.

4. Select the Open option from the Workstation menu. The Open a workstation
notebook appears, displaying the General page.
Chapter 4.  Remote Access Console Support       65



5. Click the Protocol tab to open the TCP/IP page.

6. Click in the Remote host name field and type the IP address of the local
(target) Console.
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7. Click the Save button.  A dialog box appears asking if you want to save
changes.  Click the Yes button.

8. Double-click the upper left corner to close the notebook.  The DCAF -
Directory window reappears.

9. Double-click the Console icon.  The desktop of the local (target) Console
appears in the Distributed Console Access Facility window.

10. Perform one (or both, if required) of the following steps to access the Director
Console or Timer Console application:

– At the Distributed Console Access Facility window, access the Timer
Console application by selecting the Ctrl - Esc option from the Keystrokes
menu.  The Window List appears.

Double-click the WIN-OS/2 window: session-Director Console entry. The
Director Console’s Startup window appears in the Distributed Console
Access Facility window.

Note: If a WIN-OS/2 window: session-Director Console entry does not
display in the Window List, click the Console icon at the top of the
target Console’s OS/2 desktop in the Distributed Console Access
Facility window.  The Director Console’s Startup window
appears.

– At the Distributed Console Access Facility window, access the Timer
Console application by selecting the Ctrl - Esc option from the Keystrokes
menu.  The Window List appears.
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Double-click the WIN-OS/2 window: session-Sysplex Timer Network
Console entry.  The Timer Console’s Startup window appears in the
Distributed Console Access Facility window.

Note: If a WIN-OS/2 window: session-Sysplex Timer Network Console
entry does not display in the Window List, click the Console icon
at the top of the target Console’s OS/2 desktop in the Distributed
Console Access Facility window.  The Timer Console’s Startup
window appears.

Terminate a Session with the Local Console
Perform the following steps to terminate a DCAF session (LAN and TCP/IP
connection) with the local Console.

1. At the Distributed Console Access Facility window of the remote Console,
select the Terminate a Session option from the Session pull-down menu.

2. At the local Console, return to the full-screen Win-OS/2 configuration for
using the Director Console or Timer Console application.  For instructions,
refer to “Set Win-OS/2 Full Screen Session Parameters (Director)” on
page 71.

Console Application Session Parameters for Remote Access Console
Perform the following procedures to:

• Set Win-OS/2 window session parameters for the local (target) Console to
allow it to operate as the target of a Console application DCAF session.
Perform this procedure when configuring the local Console for a DCAF
session.

• Reset Win-OS/2 full screen session parameters for the local (target) Console.
Perform this procedure after terminating Console application DCAF session.
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Set Win-OS/2 Window Session Parameters (Director)
The Director Console application is normally configured as a full-screen
application, but must be configured as a windowed application to run as a DCAF
target.  Perform the following procedure to configure the Console to operate in a
Win-OS/2 window and allow the local (target) Console to operate during a DCAF
session.

1. At the local Console, shut down the Console application.  For instructions,
refer to “Director Console Application” on page 24.

2. At the OS/2 desktop, click the Director Console icon once with the left
mouse button and once with the right mouse button to display the Console
Application menu.

Note: Clicking both mouse buttons ensures the correct application menu
is displayed.

Note: The OS/2 desktop may look different, depending on the OS/2
version installed on the Console.
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3. Click the Properties option.  The Director Console - Properties dialog box
appears with the Program page open.

Note: For older versions of OS/2, click the Settings option from the
Console Application menu.  The Settings and Properties options
are equivalent in function.

4. Click the Session tab to display the Session page.

5. Click the WIN-OS/2 window radio button.
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6. Double-click the upper left corner of the Director Console - Properties dialog
box to close it.

7. Double-click the Director Console icon on the OS/2 desktop to start the
Console application.  The Startup window appears when the Console
application is running.

Set Win-OS/2 Full Screen Session Parameters (Director)
The default configuration for the Director Console application is Win-OS/2 full
screen mode.  When the remote access Console feature is disabled on the local
(target) Console, reconfigure the Director Console application for Win-OS/2 full
screen mode.

1. At the local Console, shut down the Console application.  For instructions,
refer to “Director Console Application” on page 24.

2. At the OS/2 desktop, click the Director Console icon once with the left
mouse button and once with the right mouse button to display the Console
Application menu.

Note: Clicking both mouse buttons ensures the correct application menu
is displayed.

Note: The OS/2 desktop may look different, depending on the OS/2
version installed on the Console.
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3. Click the Properties option.  The Director Console - Properties dialog box
appears with the Program page open.

Note: For older versions of OS/2, click the Settings option from the
Console Application menu.  The Settings and Properties options
are equivalent in function.

4. Click the Session tab to display the Session page.

5. Click the WIN-OS/2 full screen radio button.
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6. Double-click the upper left corner of the Director Console - Properties dialog
box to close it.

7. Double-click the Director Console icon on the OS/2 desktop to start the
Console application.  The Startup window appears when the Console
application is running.

Set Win-OS/2 Window Session Parameters (Sysplex Timer)
The Timer Console application is normally configured as a full screen application,
but must be configured as a windowed application to run as a DCAF target.
Perform the following procedure to configure the Console to operate in a Win-OS/2
window and allow the local (target) Console to operate during a DCAF session.

1. At the local Console, shut down the Console application.  For instructions,
refer to “Sysplex Timer Console Application” on page 25.

2. At the OS/2 desktop, click the Sysplex Timer Console icon once with the left
mouse button and once with the right mouse button to display the Console
Application menu.

Note: Clicking both mouse buttons ensures the correct application menu
is displayed.

Note: The OS/2 desktop may look different, depending on the OS/2
version installed on the Console.
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3. Click the Properties option.  The Sysplex Timer Console - Properties dialog
box appears with the Program page open.

Note: For older versions of OS/2, click the Settings option from the
Console Application menu.  The Settings and Properties options
are equivalent in function.

4. Click the Session tab to display the Session page.

5. Click the WIN-OS/2 window radio button.
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6. Double-click the upper left corner of the Sysplex Timer Console - Properties
dialog box to close it.

7. Double-click the Sysplex Timer Console icon on the OS/2 desktop to start
the Console application.  The Startup window appears when the Console
application is running.

Set Win-OS/2 Full Screen Session Parameters (Sysplex Timer)
The default configuration for the Timer Console application is Win-OS/2 full screen
mode.  When the remote access Console feature is disabled on the local (target)
Console, reconfigure the Timer Console application for Win-OS/2 full screen mode.

1. At the local Console, shut down the Console application.  For instructions,
refer to “Sysplex Timer Console Application” on page 25.

2. At the OS/2 desktop, click the Sysplex Timer Console icon once with the left
mouse button and once with the right mouse button to display the Console
Application menu.

Note: Clicking both mouse buttons ensures the correct application menu
is displayed.

Note: The OS/2 desktop may look different, depending on the OS/2
version installed on the Console.
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3. Click the Properties option.  The Sysplex Timer Console - Properties dialog
box appears with the Program page open.

Note: For older versions of OS/2, click the Settings option from the
Console Application menu.  The Settings and Properties options
are equivalent in function.

4. Click the Session tab to display the Session page.

5. Click the WIN-OS/2 full screen radio button.
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6. Double-click the upper left corner of the Sysplex Timer Console - Properties
dialog box to close it.

7. Double-click the Sysplex Timer Console icon on the OS/2 desktop to start
the Console application.  The Startup window appears when the Console
application is running.
Chapter 4.  Remote Access Console Support       77



78        Console Installation and User’s Guide



Chapter 5. PS/2 Console Procedures

This chapter describes Operating System/2 (OS/2) Warp Connect 3.0 procedures
for an IBM Personal System/2 (PS/2) computer used as an Enterprise Systems
Connection (ESCON) Director Console or as a Director Console with the Sysplex
Timer Console application installed.  The procedures are Director and Timer-
specific and include:

• Performing general administrative tasks.

• Performing backup and restore functions.

• Customizing the Console operating environment.

General Administrative Tasks
This section describes general administrative tasks for the ESCON Director
Console or Sysplex Timer Console.  The section provides instructions to:

• Perform the data collection procedure for the Director or Sysplex Timer.

• Clear the address resolution protocol (ARP) table for the local area
network (LAN) on which a Director or Timer is installed.

• Migrate a Director database to another Console (excluding a Hardware
Management Console).

• Change the Token Ring adapter data rate for the Console PC.

• Create Console diagnostic diskettes.

Perform Data Collection Procedure
Perform the data collection procedure for the Director or Sysplex Timer after a
system problem occurs or when a field-replaceable unit (FRU) is removed and
replaced.

Director Data Collection
The data collection procedure transfers maintenance information to the Director
Console’s fixed disk, then to a 3.5-inch diskette.  The diskette is mailed to the
original equipment manufacturer (OEM) for problem analysis and resolution.

1. With the Director’s Active Matrix window open, select the Collect
Maintenance Information option from the Maintenance menu.  The Collect
Maintenance Information dialog box appears showing files being transferred
and the transfer status.  When all files are transferred to the fixed disk, the
following dialog box appears.
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2. Click the OK button to close the dialog box.  The Director’s Active Matrix
window reappears.

3. Record the Director name.  The name (up to eight characters in length)
appears on the title bar at the top of the active matrix window.

4. Simultaneously press the Ctrl  and Esc  keys to transfer to the Director
Console’s OS/2 desktop.  The Window List appears.

5. Double-click the Desktop-Icon View selection.  The Director Console’s OS/2
desktop appears.

6. Insert a data collection diskette into drive A:  of the Director Console in
accordance with one of the following steps:

– If you are removing and replacing a FRU in the 9032-003 or 9033-004
ESCON Director, use the data collection diskette shipped with the
replacement FRU.  The diskette is labeled Data Collection Diskette.

– If a labeled data collection diskette is not available, a blank, DOS-
formatted diskette may be used.

7. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.
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8. Double-click the ESCON Director Data Collection icon.  The first ESCON
Director Data Collection window appears.

9. Type Y and press the Enter  key.  The second ESCON Director Data
Collection window appears.

10. Type the Director name (recorded in step 3 of this procedure) and press the
Enter  key.  Messages appear in the window showing files transferring from
the fixed disk to diskette.  The data collection process is complete when the
Enter prompt appears.

11. Press the Enter  key.  The ESCON Director Data Collection window closes.

12. Double-click the upper left corner of the ESCON Director Tools - Icon View
to close the view and return to the OS/2 desktop.

13. Remove the data collection diskette from drive A:  of the Director Console.
Record the following information on the diskette label.
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– Director serial number.

– Quality Service Activity Reporting (QSAR) number.

– Problem Management - Hardware (PMH) number.

– Current date.

14. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

15. At the OS/2 desktop, open the Director Console application by double-
clicking the Director Console icon.  The Console application opens to the
window closed in step 4 of this procedure.

Sysplex Timer Data Collection
The data collection procedure transfers maintenance information from the Timer to
a 3.5-inch diskette.  The diskette is mailed to the OEM for problem analysis and
resolution.

1. At the Sysplex Timer Network Console window, simultaneously press the Ctrl
and Esc  keys to transfer to the Timer Console’s OS/2 desktop.  The Window
List appears.

2. Double-click the Desktop-Icon View selection.  The Timer Console’s OS/2
desktop appears.

3. At the OS/2 desktop, double-click the Sysplex Timer Tools folder.  The
Sysplex Timer Tools - Icon View appears.

4. Double-click the Sysplex Timer Data Collection icon.  The Sysplex Timer
Data Collection window appears.
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5. Insert a data collection diskette into drive A:  of the Timer Console.  The
diskette is labeled Data Collection Diskette.  If a labeled data collection
diskette is not available, a blank, DOS-formatted diskette may be used.

6. Press the Enter  key.  Messages appear in the window showing files
transferring from fixed disk to diskette.  The data collection process is
complete when the Enter prompt appears.

7. Press the Enter  key.  The Sysplex Timer Data Collection window closes.

8. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

9. Remove the data collection diskette from drive A:  of the Timer Console.
Record the following information on the diskette label.

– Timer serial number.

– QSAR number.

– PMH number.

– Current date.

10. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

11. At the OS/2 desktop, open the Sysplex Timer Console application by double-
clicking the Sysplex Timer Console icon.  The Console application opens to
the window closed in step 1 of this procedure.

Clear the Address Resolution Protocol Table
This procedure clears the ARP table for a LAN with a Director or Timer installed.
The procedure clears old Internet Protocol (IP) or Media Access Control (MAC)
addresses so the ARP table can rebuild with new addresses.  The procedure
prevents new Console, Director, or Timer addresses from conflicting with old,
unused addresses.  Clear the ARP table if:
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• The IP or MAC address of a Director, Director Console, Timer, or Timer
Console was changed after operating previously on the LAN.

• The Director, Director Console, Timer, or Timer Console are installed on a
public (nondedicated) LAN.

To clear the ARP table:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the TCP/IP Cnfg. drawer to open the drawer.
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3. Click the ARP button to clear the table. The ARP window appears briefly and
closes, indicating all the IP and MAC addresses cleared by the procedure.

4. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

5. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

Migrate Director Definitions
If the Director Console application is uninstalled at a Console (Director, Sysplex
Timer, Hardware Management, or other nondedicated Console) and installed on a
new Console, Director definitions must be recorded on a 3.5-inch diskette and
migrated to the new Console.  Definitions include IP addresses, Director names,
model numbers, and matrix configuration files.
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If the Console application is discontinued and installed on a another Director
Console, a Director definitions diskette must be created. Refer to "Create Director
Definitions Diskette" below for instructions.  If the Console application is installed
on a new Director Console, Director definitions must be migrated. For instructions,
refer to "Migrate Definitions to a Director Console" on page 87.

Create Director Definitions Diskette
Perform this procedure to create a Director definitions diskette.

1. Ensure the Director Console application is closed, not just reduced to an
icon.  If the Console application is open (Startup or Matrix window appears),
continue to step a.  If the OS/2 desktop appears, go to step b.

Note: OS/2 screens may look slightly different depending on the level of
operating system installed on the Director Console.

a. At the Startup or Matrix window, select the Close Window option from
the File menu.  The Director Console application closes and the OS/2
desktop appears.  Go to step 2.

b. At the OS/2 desktop, simultaneously press the Ctrl  and Esc  keys.  The
Window List  appears.

• If the Director Console - Director Console selection does not appear,
the Console application is closed. Double-click the Desktop - Icon
View selection to return to the OS/2 desktop, and go to step 2.

• If the Director Console - Director Console selection appears , the
Console application is open and minimized. Double-click the
selection to maximize the application.  At the Startup or Matrix
window, select the Close Window option from the File menu.  The
Console application closes and the OS/2 desktop appears.

2. Insert the Console application diskette (labeled Console Version XX.YY.ZZ)
into drive A:  of the Director Console.

3. Double-click the OS/2 System icon.  The OS/2 System - Icon View appears.

4. Double-click the Drives icon.  The Drives - Icon View appears.

5. Double-click the Drive A icon.  The Drive A - Icon View appears.
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6. Double-click the DCGETDEF.CMD icon.  The DCGETDEF.CMD window
appears.

7. Remove the Console application diskette from drive A:  of the Director
Console and insert a blank, DOS-formatted diskette (provided with the
Director).

8. Press the Enter  key.  Director definitions are copied to the diskette, and the
copy progress is displayed in the DCGETDEF.CMD window.  When the
process is complete, the DCGETDEF.CMD window closes.

9. Double-click the upper left corner of the Drive A - Icon View, Drives - Icon
View, and OS/2 System - Icon View to close the views and return to the OS/2
desktop.

10. Remove the Director definitions diskette from drive A:  of the Director
Console.

11. Label and store the Director definitions diskette as appropriate. The diskette
can now be used to transport definitions to a new Console.

Migrate Definitions to a Director Console
Perform this procedure to migrate Director definitions to a Director Console.

Note: This procedure does not work if the Director Console application is open or
if the Director Console library already contains definitions.
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1. If the Director Console application is open, select the Exit option from the File
menu.  The following dialog box appears.

2. Click the OK button to close the dialog box.  The OS/2 desktop appears.

3. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.

4. Double-click the Put Director Definitions Director Console Migration icon.
The Put Director Definitions Director Console Migration window appears.

Note: If a warning appears indicating migration was terminated because
Director definitions exist in the Console library, press the Enter key to
close the Put Director Definitions Director Console Migration window
and exit the utility.
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If a warning appears indicating migration was terminated because
the Console library was not initialized, press the Enter  key to close
the Put Director Definitions Director Console Migration window and
exit the migration utility.  Open and close the Director Console
application, then perform this procedure again.

5. Insert the Director definitions diskette (created at the Console from which the
definitions are migrated) into drive A:  of the Console.

6. Press the Enter key. Director definitions are copied to the Console fixed disk
for initializing the Director Console library. When the process is complete, the
Put Director Definitions Director Console Migration window closes.

7. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

8. Remove the Director definitions diskette from drive A:  of the Console.  Store
the Director definitions diskette as appropriate.

9. At the OS/2 desktop, start the Director Console application by double-clicking
the Director Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

Change Token Ring Adapter Card Data Rate
Perform this procedure to change the data rate of the Micro-Channel Token Ring
adapter card for the Director or Sysplex Timer Console.  The procedure changes
the default rate of 16 megabits per second (Mbps) to 4 Mbps.

Note: The data rate is set at the factory.  Do not change the data rate unless
required because of LAN or other system requirements.

To change the Token Ring adapter card data rate:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.
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Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. Shut down and restart the operating system and Console.  For instructions,
refer to  “Shut Down and Restart the OS/2 Operating System and Console”
on page 26.

3. The Console performs power-on self tests (POSTs).  If the PS/2 is not
connected to an isolated multistation access unit (MAU), the following
message appears.  A message may also appear to call the next level of
support.  These messages are normal.

LT20029: A lobe wire fault has been detected. The adapter
will be closed.

Press Enter to continue.

4. Press the Enter  key to continue.

5. Inspect the flashing cursor at the upper left corner of the screen.  When the
memory check KB counter stops and the cursor moves to the upper right
corner of the screen, simultaneously press the Ctrl, Alt, and Ins  keys.  The
IBM logo screen appears, followed by the configuration program Main Menu.
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6. Use the up or down arrow keys (↑ or ↓) to highlight and select the Set
Configuration option, then press the Enter key. The Set Configuration menu
appears.

7. Use the up or down arrow keys (↑ or ↓) to highlight and select the Change
Configuration option, then press the Enter  key.  The first Change
Configuration menu appears.

Main Menu

Select one:

1 Start operating system
2 Backup/Restore system programs
3 Update system programs
4 Set configuration
5 Set features
6 Copy an option diskette
7 Test the computer
8 More utilities

Enter F1=Help F3=Exit

Set Configuration

Select one:

1 View Configuration
2 Change Configuration
3 Backup configuration
4 Restore configuration
5 Run automatic configuration
6 Set and view SCSI device configuration
7 Display memory map

Enter F1=Help F3=Exit

 Change Configuration

Total System Memory
Installed Memory.......................16384KB (16.0MB)
Usable Memory..........................15936KB (15.6MB)

Built In Features
Installed memory.......................16384KB (16.0MB)
Diskette Drive 0 Type..................[2.88MB 3.5”]
Diskette Drive 1 Type..................[Not Installed]
Diskette Drive 2 Type..................[Not Installed]
Math Coprocessor.......................[Not Installed]
First Serial Port......................[SERIAL 1, IRQ4]
Second Serial Port.....................[SERIAL 1, IRQ4]
Parallel Port..........................[Parallel 1]
Parallel Port DMA Arbitration Level....[Disabled]
Video I/O Address......................[Instance 6:2160h-216-Fh]

1 MB VRAM Aperture Base Address........[Disabled]

F1=Help    F3=Exit     F5=Previous     F6=Next      F8=Fwd

F10=Save
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8. If the configuration entry for Slot 1 - IBM Token-Ring Network 16/4 Adapter/A
does not appear, press the F8 key to advance to the second Change
Configuration menu.

9. Use the up or down arrow keys (↑ or ↓) to highlight and select the Adapter
Data Rate option for the Token Ring Adapter card.

10. Press the F6 key to toggle the rate from 16 Mbps to 4 Mbps.

11. Press the F10 and Enter  keys to save the new configuration data.

12. Press the F3 key to exit to the Set Configuration menu.

13. Press the F3 key again to exit to the Main Menu.  A message box appears
indicating you must restart the Console to initiate changes.

14. Press Enter  to restart the Console and initiate changes.  The Console
performs POSTs.  If the PS/2 is not connected to an isolated MAU, the
following message appears.  A message may also appear to call the next
level of support.  These messages are normal.

LT20029: A lobe wire fault has been detected. The adapter
will be closed.

Press Enter to continue.

15. Press the Enter  key to continue.

16. The Console finishes POSTs and loads the OS/2 operating system. The IBM
logo screen appears, followed by the OS/2 desktop.

17. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

 Change Configuration

Video ROM Address............................[DE000-DFFFF]]
1 MB VRAM Aperture Base Address..............[Disabled]
Video Arbitration Level......................[Level 13]
Video Fairness...............................[On]
SCSI Address (ID)............................[7]
SCSI DMA Arbitration Level...................[Level 8]

Slot 1 - IBM Token-Ring Network 16/4 Adapter/A
Primary or Alternate adapter.................[Primary]
Adapter Data Rate............................[16 Mbps]
ROM Address Range............................[DA000-DBFFF]
RAM Size and Address Range...................[16 KB/C000-C3FFF]
Internet Level...............................[Interrupt 2]

F1=Help    F3=Exit     F5=Previous     F6=Next      F8=Fwd

F10=Save
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– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

Create a Console Diagnostic Diskette
Perform this procedure to create a diagnostic diskette for the Console PC.  Keep
the diskette with the Console, and use it under direction from the next level of sup-
port to fault isolate problems with the PC.  To create the diagnostic diskette:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Insert a blank, formatted diskette (labeled For Use By Service Personnel
Only  and shipped with the Console) into the diskette drive.

3. Click the arrow on the Drive A drawer to open the drawer.
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4. Click the Build Diag. Disk button.  The Build Diag. Disk window appears.

5. Press the Y key to continue. A message appears at the bottom of the window
showing the percentage of files written to the diskette.

6. When the percentage reaches 100, the diagnostic diskette is created and the
OS/2 desktop reappears.  Remove the diskette from the drive.  Label the
diskette Reference Diskette.

7. Close the Drive A drawer by clicking the drawer arrow.

8. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.
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– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

9. Keep the diskette with the Console and use it under direction from the next
level of support to fault isolate PC problems.

Backup and Restore Functions
The PS/2 Console contains a tape cartridge drive to perform backup and restore
functions.  Backups of the Console fixed disk and the Director or Sysplex Timer
system libraries are routinely performed.  Library data is restored using a tape
cartridge containing the most recent backup version of the Director or Timer
system library.  The entire Console fixed disk is restored using:

• Three 3.5-inch Console stand-alone restore (SR) diskettes.

• A tape cartridge with the most recent backup version of the Console fixed
disk (includes both the Director or Timer Console application and the Director
or Timer system library).

This section describes:

• Backup options.

• Backing up the Director or Sysplex Timer system library to tape.

• Restoring the Director or Sysplex Timer system library from tape.

• Backing up the Console fixed disk to tape.

• Restoring the Console fixed disk from diskettes and tape.

Backup Options
When performing procedures to set automatic backup parameters or back up data
on demand, two backup options are available from the AutoTape Event Schedule
or Load Job File dialog boxes:

• CONSOLE.TPF - This is the default option.  This option backs up the entire
Console fixed disk to tape.

• CLIBBKUP.TPF  - This option backs up the system library.  The file contains
all information about Timers on the Console, including LIC files, logs, and
Timer configuration data.
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Back Up the System Library to Tape
Routine backups of the Director or Sysplex Timer system library to a tape cartridge
ensure critical data can be restored if required.  The data is also required when
migrating the Director Console application to a backup or replacement Console.

Critical data for the Director Console includes Console settings, LIC files, logs, IP
addresses, Director configuration files, and Director matrices.  Critical data for the
Sysplex Timer Console includes Console settings, IP addresses, configuration
files, logs, and identification information for the Timer network.

This section describes procedures to enable automatic back up of the system
library to tape, or to back up the system library on demand.

Enable Automatic Backup
If enabled, DualStor software installed on the Console automatically backs up
the system library to a tape cartridge at a specified or default time.  Perform this
procedure to enable automatic backup of the system library to tape at the default
backup time (daily at 12:00 midnight) and announcement time (five minutes), or to
specify a new backup time and announcement time.  Because changing default
parameters (Table 1 on page 114) disables automatic backup and requires shutting
down the OS/2 operating system, it is recommended that this procedure be
performed during Console installation and setup.

This procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  If either or both
applications are running on a Hardware Management Console, refer to Chapter 3
for system library backup procedures.   To enable automatic backup of the
system library:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.

2. To toggle between enabled and disabled for automatic backup (default is
disabled), click the Suspend button.

3. To change the backup time, day, and pre-dispatch announcement, click the
Edit button.  The AutoTape Event Schedule dialog box appears.
Chapter 5.  PS/2 Console Procedures       97



Change backup settings as follows:

a. To change the backup time from the default value of 00:00:00
(midnight), click the Time field in the Dispatch area. Type a new time.
Use the left and right (← and →) arrow keys and the Backspace key
to change or delete characters.

b. To change from daily backups (default), click the Weekly, Weekdays,
or 1st day of Month buttons as desired.

c. To change the pre-dispatch announcement from five minutes
(default), click the appropriate button (1 Min to 30 Min) in the
Pre-dispatch announcement area.

4. Click the scrolling arrow on the right of the Command field, then select the
CLIBBKUP.TPF  option.  This option backs up the Director or Sysplex Timer
system library as desired.

5. Click the OK button after completing the changes.  The AutoTape dialog box
reappears.

6. Double-click the upper left corner of the AutoTape dialog box to close the
dialog box and return to the OS/2 desktop.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.
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8. Ensure a blank, QD2120 1/4-inch backup tape (QIC 80 format) is installed in
the Console tape drive when the automatic backup feature is enabled.  The
backup tape is provided with the Console. Ensure the sliding tab on the tape
is set to record mode.

Backup on Demand
Perform this procedure to back up the Director or Sysplex Timer system library on
demand.  This procedure applies to a dedicated Console PC running the Director
Console application or Sysplex Timer Console application (or both).  If either
or both applications are running on a Hardware Management Console, refer to
Chapter 3 for system library backup procedures.  To back up the system library
on demand:

1. Install a blank, QD2120 1/4-inch backup tape (QIC 80 format) in the Console
tape drive as shown in Figure 17.  The tape is provided with the Console.
Ensure the sliding tab on the tape is set to record mode.

Figure 17. Install Tape Cartridge in PS/2 Console

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Do not use the Console restore tape to back up the fixed disk.
This is the master tape for restoring the Console fixed disk to the
factory default settings.

CAUTION
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.
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3. Click the DualStor button on the launch pad.  The DualStor for OS/2 window
appears.

Note: If the IBM logo appears and remains on the Console screen, press
Enter  to display the DualStor for OS/2 window.

4. If a new tape is used for the backup, retension the tape before performing the
backup.  A tape currently being used in the Console or a newly-formatted
tape does not need to be retensioned.  For these cases, continue to step 5.
To retension the tape:

a. Wait until a Tape Ready  message appears on the bottom line of the
DualStor for OS/2 window.  Select the current tape in the Tapes
section of the window.

b. Select the Operations option to open the Operations menu.

c. At the Operations menu, select the Retension Tape option.  The
Retension Confirmation dialog box appears.

d. Click the Yes button to begin tape retensioning.  This operation may
take up to five minutes.  When the tape is retensioned, the DualStor
for OS/2 window reappears.

5. Select the Load Job File option from the Jobs menu.  The Load Job File
dialog box appears.
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6. At the File list box, click (select) the CLIBBKUP.TPF option. Wait for the QIC
Tape Ready  message to display on the bottom line of the DualStor for OS/2
window, then click the OK button in the Load Job File dialog box.

7. Click the Yes button when the confirmation dialog box appears. The Backing
Up Files dialog box appears.  All selected files are scanned (Scan Checked
Files dialog box), and a message box appears.  The message box indicates
the system will erase the contents of the installed tape.  Click the OK button
to continue.  The Backing Up Files dialog box reappears and displays the
backup statistics as the backup occurs.  The system library copies to tape in
approximately five to ten minutes.
102        Console Installation and User’s Guide



Note: When a new QIC formatted tape is used, a message box appears
indicating the tape is in QIC 40/80 format and asking if you want to
continue the backup.  Click the Continue button to proceed with the
backup.

8. When the backup completes, click the OK button to exit the Backing Up Files
dialog box.

Note: When a backup is performed using DualStor, a log file is created.
This log file contains error, verification, and status messages created
during the backup.  The log file may contain a sharing violation error
message.  This is a normal condition.  The file <filename>.DIR
contains the header information currently in use for the backup
session and is skipped by DualStor.

9. Double-click the upper left corner of the Load Job File dialog box and
DualStor for OS/2 window to return to the OS/2 desktop.

10. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 2 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 2 of this procedure.

Restore the System Library from Tape
Perform this procedure to restore the Director or Sysplex Timer system library from
a backup tape cartridge to the Console fixed disk.  To restore the system library:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.
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Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. Insert the backup tape containing the system library in the tape drive.

3. Click the DualStor drawer on the launchpad.  The DualStor for OS/2 window
appears.

Note: If the IBM logo appears and remains on the screen, press the Enter
key to display the DualStor for OS/2 window.
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4. When DualStor finishes reading the tape header and directory information,
click the box by the Tape icon in the Tapes area under Tape#/Name at the top
right portion of the window.  An X appears in the box.  The Restore button
and other buttons activate at the top of the window.

5. Click the Restore button.  The Restore Parameters for Tape\Library Backup
dialog box appears.

6. If not selected in the dialog box, select the following by clicking the
appropriate radio button or check box.

– Prompt if newer file exists.

– Skip matching file.

– Restore with directory structure.

7. Click the OK button to initiate a restore to the fixed disk (C:). A message box
appears displaying the progress of the restore process.  When the Elapsed
Time xx:xx:xx  message appears, the restore is complete.

8. Close all windows by double-clicking the upper left corner of each window.

9. Perform a full backup of the Console fixed disk.  For instructions, refer to
“Back Up the Console Fixed Disk to Tape” on page 106.

10. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.
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– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.  The Console application should remain
active and operational for the following reasons:

a. Certain Timer events and associated reason codes are transmitted
only to the Event log maintained at the Timer Console.  The events
are not transmitted through attached processors to the System
Control Program (SCP) Console. If the Console application is closed
and a Timer network failure occurs, reason codes and other
information required for fault isolation may not be recorded.

b. Closing the Console application causes an ETR Service is
Requested message to be reported to the SCP Console with reason
code 40 (communication lost with active Console) or reason code 41
(communication lost with standby Console).  This may result in an
unnecessary service call.

c. Starting the Console application causes an ETR Service is
Requested  message to be reported to the SCP Console, with
reason code 8 (communication established with active Console) or
reason code 9 (communication established with standby Console).
This may result in an unnecessary service call.

Back Up the Console Fixed Disk to Tape
Routine backups of the entire Console fixed disk to a tape cartridge ensure critical
data can be restored if the fixed disk fails or requires replacement.  This section
describes the procedures to enable automatic back up the fixed disk or back up the
fixed disk on demand.

Note: The procedure requires approximately one hour to back up the Console
controlling a fully-configured cluster of Directors or a Sysplex Timer
network.

Enable Automatic Backup
If enabled, DualStor software installed on the Console automatically backs up the
fixed disk to a tape cartridge at a specified or default time. Perform this procedure
to enable automatic backup of the fixed disk to tape at the default backup time
(daily at 12:00 midnight) and announcement time (five minutes), or to specify a new
backup and announcement time.

Attention!

Under normal operating conditions, automatic backup of the entire
fixed disk is enabled for the Director or Sysplex Timer Console.
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Because changing default parameters (Table 1 on page 114) disables automatic
backup and requires shutting down the OS/2 operating system, it is recommended
that this procedure be performed during Console installation and setup.

This procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  To enable automatic
backup of the fixed disk:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.
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2. To toggle between enabled and disabled for automatic backup (default is
disabled), click the Suspend button.

3. To change the backup time, day, and pre-dispatch announcement, click the
Edit button.  The AutoTape Event Schedule dialog box appears.

Change backup settings as follows:

a. To change the backup time from the default value of 00:00:00
(midnight), click the Time field in the Dispatch area. Type a new time.
Use the left and right (← and →) arrow keys and the Backspace key
to change or delete characters.

b. To change from daily backups (default), click the Weekly, Weekdays,
or 1st day of Month buttons as desired.

c. To change the pre-dispatch announcement from five minutes
(default), click the appropriate button (1 Min to 30 Min) in the
Pre-dispatch announcement area.
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4. Click the scrolling arrow on the right of the Command field, then select the
CONSOLE.TPF option.  This option backs up the Director or Sysplex Timer
Console fixed disk as desired.

5. Click the OK button after completing the changes.  The AutoTape dialog box
reappears.

6. Double-click the upper left corner of the AutoTape dialog box to close the
dialog box and return to the OS/2 desktop.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

8. Ensure a blank, QD2120 1/4-inch backup tape (QIC 80 format) is installed in
the Console tape drive when the automatic backup feature is enabled.  The
backup tape is provided with the Console. Ensure the sliding tab on the tape
is set to record mode.

Backup on Demand
Perform this procedure to back up the Console fixed disk on demand.  This
procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  To back up the fixed
disk on demand:

1. Install a blank, QD2120 1/4-inch backup tape (QIC 80 format) in the Console
tape drive as shown in Figure 18.  The tape is provided with the Console.
Ensure the sliding tab on the tape is set to record mode.

Do not use the Console restore tape to back up the fixed disk.
This is the master tape for restoring the Console fixed disk to the
factory default settings.

CAUTION
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Figure 18. Install Tape Cartridge in PS/2 Console

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.
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3. Click the DualStor button on the launch pad.  The DualStor for OS/2 window
appears.

Note: If the IBM logo appears and remains on the Console screen, press
Enter  to display the DualStor for OS/2 window.
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4. If a new tape is used for the backup, retension the tape before performing the
backup.  A tape currently being used in the Console or a newly-formatted
tape does not need to be retensioned.  For these cases, continue to step 5.
To retension the tape:

a. Wait until a Tape Ready  message appears on the bottom line of the
DualStor for OS/2 window.  Select the current tape in the Tapes
section of the window.

b. Select the Operations option to open the Operations menu.

c. At the Operations menu, select the Retension Tape option.  The
Retension Confirmation dialog box appears.

d. Click the Yes button to begin tape retensioning.  This operation may
take up to five minutes.  When the tape is retensioned, the DualStor
for OS/2 window reappears.

5. Select the Load Job File option from the Jobs menu.  The Load Job File
dialog box appears.

6. At the File list box, click (select) the CONSOLE.TPF option. Wait for the QIC
Tape Ready  message to display on the bottom line of the DualStor for OS/2
window, then click the OK button in the Load Job File dialog box.

7. Click the Yes button when the confirmation dialog box appears. The Backing
Up Files dialog box appears.  All selected files are scanned (Scan Checked
Files dialog box), and a message box appears.  The message box indicates
the system will erase the contents of the installed tape.  Click the OK button
to continue.  The Backing Up Files dialog box reappears and displays the
backup statistics as the backup occurs. The entire Console fixed disk copies
to tape in approximately 45 minutes to one hour.
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Note: When a new QIC formatted tape is used, a message box appears
indicating the tape is in QIC 40/80 format and asking if you want to
continue the backup.  Click the Continue button to proceed with the
backup.

8. When the backup completes, click the OK button to exit the Backing Up Files
dialog box.

Note: When a backup is performed using DualStor, a log file is created.
This log file contains error, verification, and status messages created
during the backup.  The log file may contain a sharing violation error
message.  This is a normal condition.  The file <filename>.DIR
contains the header information currently in use for the backup
session and is skipped by DualStor.

9. Double-click the upper left corner of the Load Job File dialog box and
DualStor for OS/2 window to return to the OS/2 desktop.

10. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 2 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 2 of this procedure.
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Restore the Console Fixed Disk from Diskettes and Tape
Perform this procedure to format and restore the Console fixed disk from stand-
alone restore (SR) diskettes and a backup tape cartridge.  Use the instructions
after installing a new unformatted fixed disk. This procedure applies to a dedicated
Console PC running the Director Console application or Sysplex Timer Console
application (or both).  Default parameters when the fixed disk is restored are listed
in Table 1.

Table 1. Default Parameters for Console Support Software (Tape Restore)

To reformat and restore the Console fixed disk from diskettes and a backup tape:

1. Obtain the following (XX.YY.ZZ indicates the software version, release, and
patch numbers):

– The 3.5-inch Console restore diskette labeled Console Restore/SR1 of
SR3, Version XX.YY.ZZ (shipped with the Director or Sysplex Timer)

– The 3.5-inch Console restore diskette labeled Console Restore/SR2 of
SR3, Version XX.YY.ZZ (shipped with the Director or Sysplex Timer)

– The 3.5-inch Console restore diskette labeled Console Restore/SR3 of
SR3, Version XX.YY.ZZ (shipped with the Director or Sysplex Timer)

– The tape cartridge containing the most recent backup version of the
Console fixed disk (includes both the Director or Sysplex Timer Console
application and associated system library).

Feature Default Parameters

Set Time and Date Time and date for manufacturing location

Change Time and Date Format Time:  12-hour clock
Date:  Month-Day-Year

Console Screen Lock Disabled

Keyboard Layout United States

IP Address 1.1.1.1

MAC Address Set on adapter card

Subnet Mask 255.0.0.0

Automatic Backup Disabled

Default Printer Generic/Text Only on LPT1
Generic/Text to File
114        Console Installation and User’s Guide



2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

3. At the OS/2 desktop, click the Shutdown button at the bottom of the launch
pad. A dialog box appears, asking if you want to close the application without
saving data.

4. Click the OK button.  A Shutdown Has Completed message box appears,
explaining it is now safe to turn off the computer or restart.

5. Power off the Console PC.
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6. Insert the Console Restore/SR1 of SR3 diskette in the diskette drive and
power on the Console PC. Verify the memory test completes and the system
powers on.

7. When prompted for OS/2 Diskette 2, insert the Console Restore/SR2 of SR3
diskette and press the Enter  key.  Install and load messages appear.

8. When the following message appears, insert the Console Restore/SR3 of
SR3 diskette.

9. To format the fixed disk, type FDISK at the [A:\ ] prompt and press the Enter
key.

10. When the FDISK screen appears, press the Enter key to display the Options
menu.

11. Select the Create Partition option.  The maximum disk size appears.

Note: If the Create Partition option is not available, a partition may exist.
The FDISK screen displays the Console hardware configuration
status as Startable , access as C:primary , FS Type as Fat, and MB
between 150 and 500 (depending on the PC model and fixed disk
size).  If this appears, go to step 14.  If these specifications do not
appear, select Delete Partition from the Options menu, then select
Create Partition and continue to step 12.

12. Press the Enter  key.  The Partition dialog box appears.

13. Select the Primary Partition option and press the Enter  key.

14. Press the F3 key twice to exit the FDISK utility.

15. Insert the Console Restore/SR1 of SR3 diskette, and simultaneously press
the Ctrl , Alt , and Del keys twice to reboot the Console PC.

16. When prompted, insert the Console Restore/SR2 of SR3 diskette and press
the Enter  key.

17. When prompted, insert the Console Restore/SR3 of SR3 diskette
(this diskette must be in the diskette drive for step 18 through step 20).

18. At the [A:\ ] prompt, type Format C:/FS:FAT  and press the Enter  key.

Place SR Disk #3 in Boot Drive
for following operations:

FDISK.COM Partitioning Disk
FORMAT.COM High Level Format
SR.EXE Restore Your DualStor Backup
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19. When a message appears warning that all data on hard disk C will be lost,
type Y (Yes) and press the Enter  key to proceed with the format utility.
Percentages of formatting completed appear.

20. When prompted for a volume label for drive C, type Console  and press the
Enter  key.

21. Insert the Console Restore/SR1 of SR3 diskette.

22. Power off the Console PC, wait at least 10 seconds, then power the Console
PC back on.

23. Insert the tape cartridge that contains the most recent backup version of the
Console fixed disk in the tape drive. The indicator to the left of the tape drive
illuminates as the PC reads the tape header.

24. Insert the Console Restore/SR2 of SR3 diskette when prompted.

25. Insert the Console Restore/SR3 of SR3 diskette when prompted.

26. When the indicator to the left of the tape drive extinguishes, type SR at the
[A:\ ] prompt and press the Enter  key.  The indicator illuminates.

27. When the indicator extinguishes, press the Enter  key.  Ensure the light
extinguishes before pressing the Enter  key.  The following prompt appears
when installation is complete:

Do you want to restore backup set ’Console Backup’?

28. Type Y (Yes) and press the Enter  key.  The following prompt appears:

Enter logical disk letter to be the restore target of
backup set ’Console Backup’ (default=C:).

29. Press the Enter  key.  The following prompt appears:

Begin restore operation?

30. Type O (OK) and press the Enter  key.  This starts installation from the tape
to the fixed disk.  Complete installation takes approximately one hour.  The
restore process completes as messages appear indicating bytes restored.

31. When the [A:\ ] prompt appears, remove the tape cartridge and Console
Restore/SR3 of SR3 diskette, and simultaneously press the Ctrl , Alt , and Del
keys twice to reboot the Console PC.

Customize the Console Operating Environment
This section describes procedures to change ESCON Director or Sysplex Timer
Console operating parameters from default values listed in Table 2.   If you restore
the PS/2 Console’s fixed disk, all the parameters (including the IP address of the
Console) are reset to default values.
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Note: Do not enable the screen saver or automatic lockup function (password
protection) through the OS/2 desktop Settings option.  Enable the screen
saver using instructions in this section.

Table 2. Procedures and Default Parameters for Console Operating Environment

Set Date and Time
This procedure sets the date and time for the Console PC’s operating environment.
Although the date and time are set, the parameters may require change for an
installation location. Use this procedure to display or change the Console date and
time or synchronize the Console date and time with a Sysplex Timer network.

In the Director Console application, Console Audit Log and Console Error Log
events are time stamped with the PC date and time. All other date and time entries
in the application are time stamped with parameters derived from the Director.

In the Sysplex Timer Console application, Console Audit Log events are time
stamped with the PC date and time.  All other date and time entries in the
application are time stamped with Coordinated Universal Time (UTC) derived
from the Timer.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Procedure Default Parameter Page

Set Date and Time Set to date and time for
manufacturing location

118

Change Date and Time Format Time:  12-hour clock
Date:  Month-Day-Year

121

Enable Screen Saver Disabled 124

Change Keyboard Layout and
Country Code Page

United States 127

Change IP Address 1.1.1.1 135

Change Subnet Mask 255.0.0.0 135

Change MAC Address Set on adapter card 142

Change Default Printer Generic/Text Only on LPT1
Generic/Text to File

145
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Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.
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3. Click the Set Date and Time button.  The System Clock - Settings notebook
appears with the Date/Time page open.

4. To adjust the Console time, click the up or down arrows by the Hours,
Minutes, and Seconds fields as required. Click the AM or PM radio button as
required.
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5. To adjust the Console date, click the up or down arrows by the Month, Day,
and Year fields as required.

6. Close the System Clock - Settings notebook by double-clicking the icon in the
upper left corner of the notebook.

7. Close the OS/2 Window drawer by clicking the drawer arrow.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Date and Time Format
This procedure changes the time format between a 12-hour and 24-hour clock, and
the date format between a month-day-year, day-month-year, or year-month-day
format.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Double-click the System Setup icon. The System Setup - Icon View appears.

4. Double-click the Country icon. The Country - Settings notebook appears with
the Country page open.

5. Perform one or both of the following to adjust the format:

– Click the Date tab to display the Date page.  Click the desired radio
button to select between Month-Day-Year, Day-Month- Year, or Year-
Month-Day display formats.
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– Click the Time tab to display the Time page.  Click the desired radio
button to select between 12 hours or 24 hours display formats.  If the 12
hours format is used, select between AM or PM display by scrolling
through the list box to the right of the radio button.

6. Double-click the upper left corner of the Country - Settings notebook box to
close the notebook.
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7. Double-click the upper left corner of the System Setup - Icon View to close
the view.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Enable Screen Saver
Perform this procedure to enable the Win-OS/2 screen saver or modify screen
saver operation.  Do not enable the screen saver or automatic lockup (password
protection) function available through the OS/2 desktop Properties option.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.
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4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.

5. Double-click the Desktop icon.  The Desktop dialog box appears.
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6. Modify the screen saver function as required.  Enable the screen saver by
scrolling to a desired screen (other than None) in the Name field in the
Screen Saver section.  Set the time delay for the screen saver to enable by
scrolling to the desired time in the Delay field. The password function for the
Console is not required.  To enable the password function, select a screen
saver and the Setup button.  Click the Password check box, enter a
password, and click OK.

7. When finished, click the OK button on the Desktop dialog box.

8. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

9. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

10. Close the OS/2 Window drawer by clicking the drawer arrow.

11. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

12. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Keyboard Layout and Country Code Page (International Users Only)
Perform this procedure to change the keyboard layout and country information.
This allows keyboards to be customized for international users (outside of the
United States). You must also change options for Win-OS/2 windows and the OS/2
operating system.
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1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Double-click the System Setup icon.  The System Setup - Icon View
appears.
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4. Double-click the Selective Install icon.  A message box appears indicating
the installation program is initializing.  After a few seconds, the System
Configuration dialog box appears.

5. At the Locale area of the System Configuration dialog box, click the Country
icon.  The Country Information dialog box appears.
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6. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.

7. At the Locale area of the System Configuration dialog box, click the Keyboard
icon.  The Keyboard dialog box appears.

8. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.
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9. Click the OK button.  The OS/2 Setup and Installation dialog box appears.

10. Click the Install button to continue. The Source Directory dialog box appears.

11. Click the Install button.  A message box appears explaining that the OS/2
setup is completing the configuration change.  After a few seconds, a
message box appears telling you to shut down and restart the system.

12. Click the OK button.  The System Setup - Icon View appears again.

13. Double-click the upper left corner of the System Setup - Icon View and OS/2
System - Icon View to close the views and return to the OS/2 desktop.
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14. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

15. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Win-OS/2 Keyboard Settings
Perform this procedure to change the keyboard layout for Win-OS/2 windows
and the OS/2 operating system.  This allows keyboards to be customized for
international users (outside of the United States).

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.
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– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.
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4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.

5. Double-click the International icon.  The International dialog box appears.

6. Click the arrow button for the Country field and select the desired country
from the drop-down list.
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7. Click the arrow button for the Language field and select the desired language
from the drop-down list.

8. Click the arrow button for the Default Keyboard field and select the desired
keyboard layout from the drop-down list.

9. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

10. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

11. Close the OS/2 Window drawer by clicking the drawer arrow.

12. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

13. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Token Ring Adapter IP Address and Subnet Mask
The default IP address for the Console Token Ring adapter card is 1.1.1.1, and the
default subnet mask is 255.0.0.0. If you wish to change either or both these values,
obtain a unique Console IP address or subnet mask from the LAN administrator.

The IP address must be in the form nnn.nnn.nnn.nnn, where nnn is a decimal byte
in the range 0 through 255.  The IP address may not be all zeros or all 255s.
Change default IP address and subnet mask values if:

• The Console is not on an isolated Token Ring LAN.

• There is more than one Console on the Token Ring LAN.
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• The subnet mask does not conform to the network to which the Console is
connected.

• The IP address conflicts with the address of another device on the ring or
does not conform to the LAN addressing scheme.

• The IP address does not conform to the LAN addressing scheme.

Perform the following procedure to display and change the Director or Sysplex
Timer Console’s IP address and subnet mask.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.

3. Click the TCP/IP Cnfg. button.  The TCP/IP Configuration notebook appears
with the Network page open.
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4. To change the IP address, click in the IP Address field.  Type the new IP
address as necessary. Move within the field by using the left and right arrow
keys (← and →).  Use the Backspace  key to delete characters.

5. To change the subnet mask, click in the Subnet Mask field.  Type the new
subnet mask as necessary.  Move within the field by using the left and right
arrow keys (← and →).  Use the Backspace  key to delete characters.

6. Close the TCP/IP Configuration notebook by double-clicking the upper left
corner of the notebook.  The Closing TCP/IP Configuration dialog box
appears.

7. Click the Save button.  The OS/2 desktop appears.

8. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

9. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

10. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Token Ring Adapter MAC Address
Change the Console Token Ring adapter’s Media Access Control (MAC) address if
the address does not conform to the locally-administered LAN addressing scheme.
Perform the following procedure to display and change the Director or Sysplex
Timer Console’s MAC address.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.

3. To display the MAC address, continue to "Display MAC Address" below.  To
change the MAC address, refer to “Change MAC Address” on page 142.

Display MAC Address
To display the MAC address:

1. At the OS/2 desktop, close the TCP/IP Cnfg. drawer by clicking the drawer
arrow.

2. Click the OS/2 Window drawer arrow on the launch pad to open the drawer.

3. Click the OS/2 Window button on the OS/2 Window drawer.  The OS/2
Window appears.
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4. Type qsystem -d | more  (as shown above) and press the Enter  key.  A
second OS/2 Window appears showing system data.

5. Press the Enter  key to display a continuation of the OS/2 Window data.
Record the MAC address.  The address appears under Primary Token:
Address:.  The MAC address is 0004AC9540C7 in the following example.
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6. Close the OS/2 window by double-clicking the top left corner.  When the
OS/2 Window dialog box appears, click the Yes button to close without saving
data.  The OS/2 desktop appears.

7. Close the OS/2 Window drawer by clicking the drawer arrow.

Change MAC Address
To change the MAC address:

1. Click the LAPS button on the TCP/IP Cnfg. drawer.  The IBM LAN Adapter
and Protocol Support window appears.
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2. Click the Configure button.  The Configuration dialog box appears.

3. Ensure the Configure LAN transports radio button is selected, then click the
Continue button.  The Configure Workstation dialog box appears.

4. Use the scrolling arrows to scroll through the Current Configuration list box
and click (select) the IBM Token-Ring Network Adapters entry.

5. Click the Edit button.  The Parameters for IBM Token-Ring Network Adapter
dialog box appears.
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6. Click the Network adapter address field.  Enter the new hexadecimal MAC
address (12-digit) as required.

7. Click the OK button.  The Configure Workstation dialog box reappears.

8. Click the OK button. The IBM LAN Adapter and Protocol Support dialog box
reappears.

9. Click the Exit button.  The CONFIG.SYS Updates dialog box appears.  The
letter C should appear in the Drives to update field.  If it does not, use the
scrolling arrows to select C.

10. Click the Continue button.  A CONFIG.SYS Updated dialog box
appears explaining the CONFIG.SYS file was successfully updated.

11. Click the OK button.  The Exiting LAPs dialog box appears.

12. Click the Exit button to return to the OS/2 desktop.

13. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

14. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.
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– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

15. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Set or Change Default Printer
Perform the following procedure to set or change the default printer for the Director
or Sysplex Timer Console.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.

4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.
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5. Double-click the Printers icon.  The Printers dialog box appears.

6. Click (select) a driver displayed in the Installed Printers field and click the Set
as Default Printer button.

7. To add a driver not listed in the Installed Printers field, perform the following:

a. Click the Add button. The Printers dialog box reappears with a list of
available printers.
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b. Scroll through the list of printers and select the desired printer.

c. Click the Install button to display the Install Driver dialog box.

d. Type C:\prtdrvs  and click the OK button.  The driver loads and
appears under the list of installed printers in the Printers dialog box.

8. Close all open windows by double-clicking the upper left corner of each
window.  When the Exit Win-OS/2 dialog box appears, click the OK button
to exit Win-OS/2, close the dialog box, and return to the OS/2 desktop.

9. Close the OS/2 Window drawer by clicking the drawer arrow.

10. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 2 on
page 118), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

11. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Chapter 6. Model PC-330 Console Procedures

This chapter describes Operating System/2 (OS/2) Warp Connect 3.0 procedures
for an IBM Model PC-330 computer used as an Enterprise Systems Connection
(ESCON) Director Console or Sysplex Timer Console.  The procedures are
Director and Timer-specific and include:

• Performing general administrative tasks.

• Performing backup and restore functions.

• Customizing the Console operating environment.

General Administrative Tasks
This section describes general administrative tasks for the ESCON Director
Console or Sysplex Timer Console.  The section provides instructions to:

• Perform the data collection procedure for the Director or Sysplex Timer.

• Clear the address resolution protocol (ARP) table for the local area
network (LAN) on which a Director or Timer is installed.

• Migrate a Director database to another Console (excluding a Hardware
Management Console).

• Change the Token Ring adapter data rate for the Console PC.

• Create Console diagnostic diskettes.

Perform Data Collection Procedure
Perform the data collection procedure for the Director or Sysplex Timer after a
system problem occurs or when a field-replaceable unit (FRU) is removed and
replaced.

Director Data Collection
The data collection procedure transfers maintenance information to the Director
Console’s fixed disk, then to a 3.5-inch diskette.  The diskette is mailed to the
original equipment manufacturer (OEM) for problem analysis and resolution.

1. With the Director’s Active Matrix window open, select the Collect
Maintenance Information option from the Maintenance menu.  The Collect
Maintenance Information dialog box appears showing files being transferred
and the transfer status.  When all files are transferred to the fixed disk, the
following dialog box appears.
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2. Click the OK button to close the dialog box.  The Director’s Active Matrix
window reappears.

3. Record the Director name.  The name (up to eight characters in length)
appears on the title bar at the top of the active matrix window.

4. Simultaneously press the Ctrl  and Esc  keys to transfer to the Director
Console’s OS/2 desktop.  The Window List appears.

5. Double-click the Desktop-Icon View selection.  The Director Console’s OS/2
desktop appears.

6. Insert a data collection diskette into drive A:  of the Director Console in
accordance with one of the following steps:

– If you are removing and replacing a FRU in the 9032-003 or 9033-004
ESCON Director, use the data collection diskette shipped with the
replacement FRU.  The diskette is labeled Data Collection Diskette.

– If a labeled data collection diskette is not available, a blank, DOS-
formatted diskette may be used.

7. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.
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8. Double-click the ESCON Director Data Collection icon.  The first ESCON
Director Data Collection window appears.

9. Type Y and press the Enter  key.  The second ESCON Director Data
Collection window appears.

10. Type the Director name (recorded in step 3 of this procedure) and press the
Enter  key.  Messages appear in the window showing files transferring from
the fixed disk to diskette.  The data collection process is complete when the
Enter prompt appears.

11. Press the Enter  key.  The ESCON Director Data Collection window closes.

12. Double-click the upper left corner of the ESCON Director Tools - Icon View
to close the view and return to the OS/2 desktop.

13. Remove the data collection diskette from drive A:  of the Director Console.
Record the following information on the diskette label.
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– Director serial number.

– Quality Service Activity Reporting (QSAR) number.

– Problem Management - Hardware (PMH) number.

– Current date.

14. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

15. At the OS/2 desktop, open the Director Console application by double-
clicking the Director Console icon.  The Console application opens to the
window closed in step 4 of this procedure.

Sysplex Timer Data Collection
The data collection procedure transfers maintenance information from the Timer to
a 3.5-inch diskette.  The diskette is mailed to the OEM for problem analysis and
resolution.

1. At the Sysplex Timer Network Console window, simultaneously press the Ctrl
and Esc  keys to transfer to the Timer Console’s OS/2 desktop.  The Window
List appears.

2. Double-click the Desktop-Icon View selection.  The Timer Console’s OS/2
desktop appears.

3. At the OS/2 desktop, double-click the Sysplex Timer Tools folder.  The
Sysplex Timer Tools - Icon View appears.

4. Double-click the Sysplex Timer Data Collection icon.  The Sysplex Timer
Data Collection window appears.
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5. Insert a data collection diskette into drive A:  of the Timer Console.  The
diskette is labeled Data Collection Diskette.  If a labeled data collection
diskette is not available, a blank, DOS-formatted diskette may be used.

6. Press the Enter  key.  Messages appear in the window showing files
transferring from fixed disk to diskette.  The data collection process is
complete when the Enter prompt appears.

7. Press the Enter  key.  The Sysplex Timer Data Collection window closes.

8. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

9. Remove the data collection diskette from drive A:  of the Timer Console.
Record the following information on the diskette label.

– Timer serial number.

– QSAR number.

– PMH number.

– Current date.

10. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

11. At the OS/2 desktop, open the Sysplex Timer Console application by double-
clicking the Sysplex Timer Console icon.  The Console application opens to
the window closed in step 1 of this procedure.

Clear the Address Resolution Protocol Table
This procedure clears the ARP table for a LAN with a Director or Timer installed.
The procedure clears old Internet Protocol (IP) or Media Access Control (MAC)
addresses so the ARP table can rebuild with new addresses.  The procedure
prevents new Console, Director, or Timer addresses from conflicting with old,
unused addresses.  Clear the ARP table if:
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• The IP or MAC address of a Director, Director Console, Timer, or Timer
Console was changed after operating previously on the LAN.

• The Director, Director Console, Timer, or Timer Console are installed on a
public (nondedicated) LAN.

To clear the ARP table:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the TCP/IP Cnfg. drawer to open the drawer.
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3. Click the ARP button to clear the table. The ARP window appears briefly and
closes, indicating all the IP and MAC addresses cleared by the procedure.

4. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

5. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

Migrate Director Definitions
If the Director Console application is uninstalled at a Console (Director, Sysplex
Timer, Hardware Management, or other nondedicated Console) and installed on a
new Console, Director definitions must be recorded on a 3.5-inch diskette and
migrated to the new Console.  Definitions include IP addresses, Director names,
model numbers, and matrix configuration files.
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If the Console application is discontinued and installed on a another Director
Console, a Director definitions diskette must be created. Refer to "Create Director
Definitions Diskette" below for instructions.  If the Console application is installed
on a new Director Console, Director definitions must be migrated. For instructions,
refer to "Migrate Definitions to a Director Console" on page 157.

Create Director Definitions Diskette
Perform this procedure to create a Director definitions diskette.

1. Ensure the Director Console application is closed, not just reduced to an
icon.  If the Console application is open (Startup or Matrix window appears),
continue to step a.  If the OS/2 desktop appears, go to step b.

Note: OS/2 screens may look slightly different depending on the level of
operating system installed on the Director Console.

a. At the Startup or Matrix window, select the Close Window option from
the File menu.  The Director Console application closes and the OS/2
desktop appears.  Go to step 2.

b. At the OS/2 desktop, simultaneously press the Ctrl  and Esc  keys.  The
Window List  appears.

• If the Director Console - Director Console selection does not appear,
the Console application is closed. Double-click the Desktop - Icon
View selection to return to the OS/2 desktop, and go to step 2.

• If the Director Console - Director Console selection appears , the
Console application is open and minimized. Double-click the
selection to maximize the application.  At the Startup or Matrix
window, select the Close Window option from the File menu.  The
Console application closes and the OS/2 desktop appears.

2. Insert the Console application diskette (labeled Console Version XX.YY.ZZ)
into drive A:  of the Director Console.

3. Double-click the OS/2 System icon.  The OS/2 System - Icon View appears.

4. Double-click the Drives icon.  The Drives - Icon View appears.

5. Double-click the Drive A icon.  The Drive A - Icon View appears.
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6. Double-click the DCGETDEF.CMD icon.  The DCGETDEF.CMD window
appears.

7. Remove the Console application diskette from drive A:  of the Director
Console and insert a blank, DOS-formatted diskette (provided with the
Director).

8. Press the Enter  key.  Director definitions are copied to the diskette, and the
copy progress is displayed in the DCGETDEF.CMD window.  When the
process is complete, the DCGETDEF.CMD window closes.

9. Double-click the upper left corner of the Drive A - Icon View, Drives - Icon
View, and OS/2 System - Icon View to close the views and return to the OS/2
desktop.

10. Remove the Director definitions diskette from drive A:  of the Director
Console.

11. Label and store the Director definitions diskette as appropriate. The diskette
can now be used to transport definitions to a new Console.

Migrate Definitions to a Director Console
Perform this procedure to migrate Director definitions to a Director Console.

Note: This procedure does not work if the Director Console application is open or
if the Director Console library already contains definitions.
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1. If the Director Console application is open, select the Exit option from the File
menu.  The following dialog box appears.

2. Click the OK button to close the dialog box.  The OS/2 desktop appears.

3. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.

4. Double-click the Put Director Definitions Director Console Migration icon.
The Put Director Definitions Director Console Migration window appears.

Note: If a warning appears indicating migration was terminated because
Director definitions exist in the Console library, press the Enter key to
close the Put Director Definitions Director Console Migration window
and exit the utility.
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If a warning appears indicating migration was terminated because
the Console library was not initialized, press the Enter  key to close
the Put Director Definitions Director Console Migration window and
exit the migration utility.  Open and close the Director Console
application, then perform this procedure again.

5. Insert the Director definitions diskette (created at the Console from which the
definitions are migrated) into drive A:  of the Console.

6. Press the Enter key. Director definitions are copied to the Console fixed disk
for initializing the Director Console library. When the process is complete, the
Put Director Definitions Director Console Migration window closes.

7. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

8. Remove the Director definitions diskette from drive A:  of the Console.  Store
the Director definitions diskette as appropriate.

9. At the OS/2 desktop, start the Director Console application by double-clicking
the Director Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

Change Token Ring Adapter Card Data Rate
Perform this procedure to change the data rate of the Token Ring adapter card for
the Director or Sysplex Timer Console. The procedure changes the default rate of
16 megabits per second (Mbps) to 4 Mbps.

Note: The data rate is set at the factory.  Do not change the data rate unless
required because of LAN or other system requirements.

To change the Token Ring adapter card data rate:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.
Chapter 6.  Model PC-330 Console Procedures       159



Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the arrow on the TCP/IP Cnfg. drawer to open the
drawer.
160        Console Installation and User’s Guide



3. Click the Lanaid button.  The IBM LANAID message box appears briefly
while the system configuration is queried.

The IBM LANAID message box closes, and the LANAID v2.21 for IBM
Auto/Turbo ISA Adapters window appears.

4. Click the Adapter Configuration button.  The View Adapter Configuration
dialog box appears with the Configurable page open.
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5. Click the Change button at the bottom of the dialog box.  The Change
Configuration Parameters dialog box appears with the Adapter Modes page
open.

6. Click the Other Parameters tab at the top of the dialog box.  The Other
Parameters page appears.

7. To change the data rate from 16 Mbps (default), click the 4 Mbps radio button
in the Data Rate box.

8. Click the OK button.  The Configuration Warning message box appears.
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9. Click the Yes button.  The Configuration Warning message box closes and
the View Adapter Configuration dialog box reappears.

10. Click the Store button at the bottom of the dialog box to save the parameters.
The Storing Configuration message box appears for approximately 30
seconds.

When the configuration change is stored, the Storing Configuration message
box closes and the Configuration settings applied message box appears.
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11. Click the OK button. The Configuration settings applied message box closes.

12. Click the Done button.  The View Adapter Configuration dialog box
closes and the LANAID v2.21 for IBM Auto/Turbo ISA Adapters dialog box
reappears.

13. Click the Exit button.  The LANAID dialog box appears.

14. Click the OK button.  The OS/2 desktop appears.

15. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

16. Shut down and restart the operating system and Console to initiate changes.
For instructions, refer to “Shut Down and Restart the OS/2 Operating System
and Console” on page 26.

Create a Console Diagnostic Diskette
Perform this procedure to create a diagnostic diskette for the Console PC.  Keep
the diskette with the Console, and use it under direction from the next level of
support to fault isolate problems with the PC.  To create the diagnostic diskette:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.
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– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Insert a blank, formatted diskette (labeled For Use By Service Personnel
Only  and shipped with the Console) into the diskette drive.

3. Click the arrow on the Drive A drawer to open the drawer.

4. Click the Build Diag. Disk button.  The Build Diag. Disk window appears.
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5. Press the Y key to continue. A message appears at the bottom of the window
showing the percentage of files written to the diskette.

6. When the percentage reaches 100, the diagnostic diskette is created and the
OS/2 desktop reappears.  Remove the diskette from the drive.  Label the
diskette Reference Diskette.

7. Close the Drive A drawer by clicking the drawer arrow.

8. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

9. Keep the diskette with the Console and use it under direction from the next
level of support to fault isolate PC problems.

Backup and Restore Functions
The Model PC-330 Console contains a tape cartridge drive to perform backup and
restore functions.  Backups of the Console fixed disk and the Director or Sysplex
Timer system libraries are routinely performed.  Library data is restored using a
tape cartridge containing the most recent backup version of the Director or Timer
system library.  The entire Console fixed disk is restored using:

• Three 3.5-inch Console stand-alone restore (SR) diskettes.

• A tape cartridge with the most recent backup version of the Console fixed
disk (includes both the Director or Timer Console application and the Director
or Timer system library).
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This section describes:

• Backup options.

• Backing up the Director or Sysplex Timer system library to tape.

• Restoring the Director or Sysplex Timer system library from tape.

• Backing up the Console fixed disk to tape.

• Restoring the Console fixed disk from diskettes and tape.

Backup Options
When performing procedures to set automatic backup parameters or back up data
on demand, two backup options are available from the AutoTape Event Schedule
or Load Job File dialog boxes:

• CONSOLE.TPF - This is the default option.  This option backs up the entire
Console fixed disk to tape.

• CLIBBKUP.TPF  - This option backs up the system library.  The file contains
all information about Timers on the Console, including LIC files, logs, and
Timer configuration data.

Back Up the System Library to Tape
Routine backups of the Director or Sysplex Timer system library to a tape cartridge
ensure critical data can be restored if required.  The data is also required when
migrating the Director Console application to a backup or replacement Console.

Critical data for the Director Console includes Console settings, LIC files, logs, IP
addresses, Director configuration files, and Director matrices.  Critical data for the
Sysplex Timer Console includes Console settings, IP addresses, configuration
files, logs, and identification information for the Timer network.

This section describes procedures to enable automatic back up of the system
library to tape, or to back up the system library on demand.

Enable Automatic Backup
If enabled, DualStor software installed on the Console automatically backs up
the system library to a tape cartridge at a specified or default time.  Perform this
procedure to enable automatic backup of the system library to tape at the default
backup time (daily at 12:00 midnight) and announcement time (five minutes), or to
specify a new backup time and announcement time.  Because changing default
parameters (Table 3 on page 186) disables automatic backup and requires shutting
down the OS/2 operating system, it is recommended that this procedure be
performed during Console installation and setup.
Chapter 6.  Model PC-330 Console Procedures       167



This procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  If either or both
applications are running on a Hardware Management Console, refer to Chapter 3
for system library backup procedures.   To enable automatic backup of the
system library:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.
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2. To toggle between enabled and disabled for automatic backup (default is
disabled), click the Suspend button.

3. To change the backup time, day, and pre-dispatch announcement, click the
Edit button.  The AutoTape Event Schedule dialog box appears.

Change backup settings as follows:

a. To change the backup time from the default value of 00:00:00
(midnight), click the Time field in the Dispatch area. Type a new time.
Use the left and right (← and →) arrow keys and the Backspace key
to change or delete characters.

b. To change from daily backups (default), click the Weekly, Weekdays,
or 1st day of Month buttons as desired.

c. To change the pre-dispatch announcement from five minutes
(default), click the appropriate button (1 Min to 30 Min) in the
Pre-dispatch announcement area.
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4. Click the scrolling arrow on the right of the Command field, then select the
CLIBBKUP.TPF  option.  This option backs up the Director or Sysplex Timer
system library as desired.

5. Click the OK button after completing the changes.  The AutoTape dialog box
reappears.

6. Double-click the upper left corner of the AutoTape dialog box to close the
dialog box and return to the OS/2 desktop.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

8. Ensure a blank, QD2120 1/4-inch backup tape (QIC 80 format) is installed in
the Console tape drive when the automatic backup feature is enabled.  The
backup tape is provided with the Console. Ensure the sliding tab on the tape
is set to record mode.

Backup on Demand
Perform this procedure to back up the Director or Sysplex Timer system library on
demand.  This procedure applies to a dedicated Console PC running the Director
Console application or Sysplex Timer Console application (or both).  If either
or both applications are running on a Hardware Management Console, refer to
Chapter 3 for system library backup procedures.  To back up the system library
on demand:

1. Install a blank, QD2120 1/4-inch backup tape (QIC 80 format) in the Console
tape drive as shown in Figure 19.  The tape is provided with the Console.
Ensure the sliding tab on the tape is set to record mode.

Do not use the Console restore tape to back up the fixed disk.
This is the master tape for restoring the Console fixed disk to the
factory default settings.

CAUTION
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Figure 19. Install Tape Cartridge in Model PC-330 Console

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.
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3. Click the DualStor button on the launch pad.  The DualStor for OS/2 window
appears.

Note: If the IBM logo appears and remains on the Console screen, press
Enter  to display the DualStor for OS/2 window.
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4. If a new tape is used for the backup, retension the tape before performing the
backup.  A tape currently being used in the Console or a newly-formatted
tape does not need to be retensioned.  For these cases, continue to step 5.
To retension the tape:

a. Wait until a Tape Ready  message appears on the bottom line of the
DualStor for OS/2 window.  Select the current tape in the Tapes
section of the window.

b. Select the Operations option to open the Operations menu.

c. At the Operations menu, select the Retension Tape option.  The
Retension Confirmation dialog box appears.

d. Click the Yes button to begin tape retensioning.  This operation may
take up to five minutes.  When the tape is retensioned, the DualStor
for OS/2 window reappears.

5. Select the Load Job File option from the Jobs menu.  The Load Job File
dialog box appears.

6. At the File list box, click (select) the CLIBBKUP.TPF option. Wait for the QIC
Tape Ready  message to display on the bottom line of the DualStor for OS/2
window, then click the OK button in the Load Job File dialog box.

7. Click the Yes button when the confirmation dialog box appears. The Backing
Up Files dialog box appears.  All selected files are scanned (Scan Checked
Files dialog box), and a message box appears.  The message box indicates
the system will erase the contents of the installed tape.  Click the OK button
to continue.  The Backing Up Files dialog box reappears and displays the
backup statistics as the backup occurs.  The system library copies to tape in
approximately five to ten minutes.
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Note: When a new QIC formatted tape is used, a message box appears
indicating the tape is in QIC 40/80 format and asking if you want to
continue the backup.  Click the Continue button to proceed with the
backup.

8. When the backup completes, click the OK button to exit the Backing Up Files
dialog box.

Note: When a backup is performed using DualStor, a log file is created.
This log file contains error, verification, and status messages created
during the backup.  The log file may contain a sharing violation error
message.  This is a normal condition.  The file <filename>.DIR
contains the header information currently in use for the backup
session and is skipped by DualStor.

9. Double-click the upper left corner of the Load Job File dialog box and
DualStor for OS/2 window to return to the OS/2 desktop.

10. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 2 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 2 of this procedure.
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Restore the System Library from Tape
Perform this procedure to restore the Director or Sysplex Timer system library from
a backup tape cartridge to the Console fixed disk.  To restore the system library:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. Insert the backup tape containing the system library in the tape drive.

3. Click the DualStor drawer on the launchpad.  The DualStor for OS/2 window
appears.
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Note: If the IBM logo appears and remains on the screen, press the Enter
key to display the DualStor for OS/2 window.

4. When DualStor finishes reading the tape header and directory information,
click the box by the Tape icon in the Tapes area under Tape#/Name at the top
right portion of the window.  An X appears in the box.  The Restore button
and other buttons activate at the top of the window.

5. Click the Restore button.  The Restore Parameters for Tape\Library Backup
dialog box appears.
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6. If not selected in the dialog box, select the following by clicking the
appropriate radio button or check box.

– Prompt if newer file exists.

– Skip matching file.

– Restore with directory structure.

7. Click the OK button to initiate a restore to the fixed disk (C:). A message box
appears displaying the progress of the restore process.  When the Elapsed
Time xx:xx:xx  message appears, the restore is complete.

8. Close all windows by double-clicking the upper left corner of each window.

9. Perform a full backup of the Console fixed disk.  For instructions, refer to
“Back Up the Console Fixed Disk to Tape” on page 178.

10. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.  The Console application should remain
active and operational for the following reasons:

a. Certain Timer events and associated reason codes are transmitted
only to the Event log maintained at the Timer Console.  The events
are not transmitted through attached processors to the System
Control Program (SCP) Console. If the Console application is closed
and a Timer network failure occurs, reason codes and other
information required for fault isolation may not be recorded.

b. Closing the Console application causes an ETR Service is
Requested message to be reported to the SCP Console with reason
code 40 (communication lost with active Console) or reason code 41
(communication lost with standby Console).  This may result in an
unnecessary service call.

c. Starting the Console application causes an ETR Service is
Requested  message to be reported to the SCP Console, with
reason code 8 (communication established with active Console) or
reason code 9 (communication established with standby Console).
This may result in an unnecessary service call.
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Back Up the Console Fixed Disk to Tape
Routine backups of the entire Console fixed disk to a tape cartridge ensure critical
data can be restored if the fixed disk fails or requires replacement.  This section
describes the procedures to enable automatic back up the fixed disk or back up the
fixed disk on demand.

Note: The procedure requires approximately one hour to back up the Console
controlling a fully-configured cluster of Directors or a Sysplex Timer
network.

Enable Automatic Backup
If enabled, DualStor software installed on the Console automatically backs up the
fixed disk to a tape cartridge at a specified or default time. Perform this procedure
to enable automatic backup of the fixed disk to tape at the default backup time
(daily at 12:00 midnight) and announcement time (five minutes), or to specify a new
backup and announcement time.  Because changing default parameters (Table 3
on page 186) disables automatic backup and requires shutting down the OS/2
operating system, it is recommended that this procedure be performed during
Console installation and setup.

This procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  To enable automatic
backup of the fixed disk:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.

Attention!

Under normal operating conditions, automatic backup of the entire
fixed disk is enabled for the Director or Sysplex Timer Console.
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– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the AutoTape-AutoTape selection. The AutoTape dialog box
appears.

2. To toggle between enabled and disabled for automatic backup (default is
disabled), click the Suspend button.

3. To change the backup time, day, and pre-dispatch announcement, click the
Edit button.  The AutoTape Event Schedule dialog box appears.
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Change backup settings as follows:

a. To change the backup time from the default value of 00:00:00
(midnight), click the Time field in the Dispatch area. Type a new time.
Use the left and right (← and →) arrow keys and the Backspace key
to change or delete characters.

b. To change from daily backups (default), click the Weekly, Weekdays,
or 1st day of Month buttons as desired.

c. To change the pre-dispatch announcement from five minutes
(default), click the appropriate button (1 Min to 30 Min) in the
Pre-dispatch announcement area.

4. Click the scrolling arrow on the right of the Command field, then select the
CONSOLE.TPF option.  This option backs up the Director or Sysplex Timer
Console fixed disk as desired.

5. Click the OK button after completing the changes.  The AutoTape dialog box
reappears.

6. Double-click the upper left corner of the AutoTape dialog box to close the
dialog box and return to the OS/2 desktop.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

8. Ensure a blank, QD2120 1/4-inch backup tape (QIC 80 format) is installed in
the Console tape drive when the automatic backup feature is enabled.  The
backup tape is provided with the Console. Ensure the sliding tab on the tape
is set to record mode.

Backup on Demand
Perform this procedure to back up the Console fixed disk on demand.  This
procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  To back up the fixed
disk on demand:

1. Install a blank, QD2120 1/4-inch backup tape (QIC 80 format) in the Console
tape drive as shown in Figure 20.  The tape is provided with the Console.
Ensure the sliding tab on the tape is set to record mode.
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Figure 20. Install Tape Cartridge in Model PC-330 Console

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Do not use the Console restore tape to back up the fixed disk.
This is the master tape for restoring the Console fixed disk to the
factory default settings.

CAUTION
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

3. Click the DualStor button on the launch pad.  The DualStor for OS/2 window
appears.

Note: If the IBM logo appears and remains on the Console screen, press
Enter  to display the DualStor for OS/2 window.
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4. If a new tape is used for the backup, retension the tape before performing the
backup.  A tape currently being used in the Console or a newly-formatted
tape does not need to be retensioned.  For these cases, continue to step 5.
To retension the tape:

a. Wait until a Tape Ready  message appears on the bottom line of the
DualStor for OS/2 window.  Select the current tape in the Tapes
section of the window.

b. Select the Operations option to open the Operations menu.

c. At the Operations menu, select the Retension Tape option.  The
Retension Confirmation dialog box appears.

d. Click the Yes button to begin tape retensioning.  This operation may
take up to five minutes.  When the tape is retensioned, the DualStor
for OS/2 window reappears.

5. Select the Load Job File option from the Jobs menu.  The Load Job File
dialog box appears.
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6. At the File list box, click (select) the CONSOLE.TPF option. Wait for the QIC
Tape Ready  message to display on the bottom line of the DualStor for OS/2
window, then click the OK button in the Load Job File dialog box.

7. Click the Yes button when the confirmation dialog box appears. The Backing
Up Files dialog box appears.  All selected files are scanned (Scan Checked
Files dialog box), and a message box appears.  The message box indicates
the system will erase the contents of the installed tape.  Click the OK button
to continue.  The Backing Up Files dialog box reappears and displays the
backup statistics as the backup occurs. The entire Console fixed disk copies
to tape in approximately 45 minutes to one hour.
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Note: When a new QIC formatted tape is used, a message box appears
indicating the tape is in QIC 40/80 format and asking if you want to
continue the backup.  Click the Continue button to proceed with the
backup.

8. When the backup completes, click the OK button to exit the Backing Up Files
dialog box.

Note: When a backup is performed using DualStor, a log file is created.
This log file contains error, verification, and status messages created
during the backup.  The log file may contain a sharing violation error
message.  This is a normal condition.  The file <filename>.DIR
contains the header information currently in use for the backup
session and is skipped by DualStor.

9. Double-click the upper left corner of the Load Job File dialog box and
DualStor for OS/2 window to return to the OS/2 desktop.

10. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 2 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 2 of this procedure.

Restore the Console Fixed Disk from Diskettes and Tape
Perform this procedure to format and restore the Console fixed disk from stand-
alone restore (SR) diskettes and a backup tape cartridge.  Use the instructions
after installing a new unformatted fixed disk. This procedure applies to a dedicated
Console PC running the Director Console application or Sysplex Timer Console
application (or both).  Default parameters when the fixed disk is restored are listed
in Table 3.
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Table 3. Default Parameters for Console Support Software (Tape Restore)

To reformat and restore the Console fixed disk from diskettes and a backup tape:

1. Obtain the following (XX.YY.ZZ indicates the software version, release, and
patch numbers):

– The 3.5-inch Console restore diskette labeled Console Restore/SR1 of
SR3, Version XX.YY.ZZ (shipped with the Director or Sysplex Timer)

– The 3.5-inch Console restore diskette labeled Console Restore/SR2 of
SR3, Version XX.YY.ZZ (shipped with the Director or Sysplex Timer)

– The 3.5-inch Console restore diskette labeled Console Restore/SR3 of
SR3, Version XX.YY.ZZ (shipped with the Director or Sysplex Timer)

– The tape cartridge containing the most recent backup version of the
Console fixed disk (includes both the Director or Sysplex Timer Console
application and associated system library).

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Feature Default Parameters

Set Time and Date Time and date for manufacturing location

Change Time and Date Format Time:  12-hour clock
Date:  Month-Day-Year

Console Screen Lock Disabled

Keyboard Layout United States

IP Address 1.1.1.1

MAC Address Set on adapter card

Subnet Mask 255.0.0.0

Automatic Backup Disabled

Default Printer Generic/Text Only on LPT1
Generic/Text to File
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Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

3. At the OS/2 desktop, click the Shutdown button at the bottom of the launch
pad. A dialog box appears, asking if you want to close the application without
saving data.

4. Click the OK button.  A Shutdown Has Completed message box appears,
explaining it is now safe to turn off the computer or restart.

5. Power off the Console PC.

6. Insert the Console Restore/SR1 of SR3 diskette in the diskette drive and
power on the Console PC. Verify the memory test completes and the system
powers on.

7. When prompted for OS/2 Diskette 2, insert the Console Restore/SR2 of SR3
diskette and press the Enter  key.  Install and load messages appear.
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8. When the following message appears, insert the Console Restore/SR3 of
SR3 diskette.

9. To format the fixed disk, type FDISK at the [A:\ ] prompt and press the Enter
key.

10. When the FDISK screen appears, press the Enter key to display the Options
menu.

11. Select the Create Partition option.  The maximum disk size appears.

Note: If the Create Partition option is not available, a partition may exist.
The FDISK screen displays the Console hardware configuration
status as Startable , access as C:primary , FS Type as Fat, and MB
between 150 and 500 (depending on the PC model and fixed disk
size).  If this appears, go to step 14.  If these specifications do not
appear, select Delete Partition from the Options menu, then select
Create Partition and continue to step 12.

12. Press the Enter  key.  The Partition dialog box appears.

13. Select the Primary Partition option and press the Enter  key.

14. Press the F3 key twice to exit the FDISK utility.

15. Insert the Console Restore/SR1 of SR3 diskette, and simultaneously press
the Ctrl , Alt , and Del keys twice to reboot the Console PC.

16. When prompted, insert the Console Restore/SR2 of SR3 diskette and press
the Enter  key.

17. When prompted, insert the Console Restore/SR3 of SR3 diskette
(this diskette must be in the diskette drive for step 18 through step 20).

18. At the [A:\ ] prompt, type Format C:/FS:FAT  and press the Enter  key.

19. When a message appears warning that all data on hard disk C will be lost,
type Y (Yes) and press the Enter  key to proceed with the format utility.
Percentages of formatting completed appear.

20. When prompted for a volume label for drive C, type Console  and press the
Enter  key.

21. Insert the Console Restore/SR1 of SR3 diskette.

Place SR Disk #3 in Boot Drive
for following operations:

FDISK.COM Partitioning Disk
FORMAT.COM High Level Format
SR.EXE Restore Your DualStor Backup
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22. Power off the Console PC, wait at least 10 seconds, then power the Console
PC back on.

23. Insert the tape cartridge that contains the most recent backup version of the
Console fixed disk in the tape drive. The indicator to the left of the tape drive
illuminates as the PC reads the tape header.

24. Insert the Console Restore/SR2 of SR3 diskette when prompted.

25. Insert the Console Restore/SR3 of SR3 diskette when prompted.

26. When the indicator to the left of the tape drive extinguishes, type SR at the
[A:\ ] prompt and press the Enter  key.  The indicator illuminates.

27. When the indicator extinguishes, press the Enter  key.  Ensure the light
extinguishes before pressing the Enter  key.  The following prompt appears
when installation is complete:

Do you want to restore backup set ’Console Backup’?

28. Type Y (Yes) and press the Enter  key.  The following prompt appears:

Enter logical disk letter to be the restore target of
backup set ’Console Backup’ (default=C:).

29. Press the Enter  key.  The following prompt appears:

Begin restore operation?

30. Type O (OK) and press the Enter  key.  This starts installation from the tape
to the fixed disk.  Complete installation takes approximately one hour.  The
restore process completes as messages appear indicating bytes restored.

31. When the [A:\ ] prompt appears, remove the tape cartridge and Console
Restore/SR3 of SR3 diskette, and simultaneously press the Ctrl , Alt , and Del
keys twice to reboot the Console PC.

Customize the Console Operating Environment
This section describes procedures to change ESCON Director or Sysplex Timer
Console operating parameters from default values listed in Table 4.   If you restore
the Model PC-330 Console’s fixed disk, all the parameters (including the IP
address of the Console) are reset to default values.

Note: Do not enable the screen saver or automatic lockup function (password
protection) through the OS/2 desktop Settings option.  Enable the screen
saver using instructions in this section.
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Table 4. Procedures and Default Parameters for Console Operating Environment

Set Date and Time
This procedure sets the date and time for the Console PC’s operating environment.
Although the date and time are set, the parameters may require change for an
installation location. Use this procedure to display or change the Console date and
time or synchronize the Console date and time with a Sysplex Timer network.

In the Director Console application, Console Audit Log and Console Error Log
events are time stamped with the PC date and time. All other date and time entries
in the application are time stamped with parameters derived from the Director.

In the Sysplex Timer Console application, Console Audit Log events are time
stamped with the PC date and time.  All other date and time entries in the
application are time stamped with Coordinated Universal Time (UTC) derived
from the Timer.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Procedure Default Parameter Page

Set Date and Time Set to date and time for
manufacturing location

190

Change Date and Time Format Time:  12-hour clock
Date:  Month-Day-Year

193

Enable Screen Saver Disabled 196

Change Keyboard Layout and
Country Code Page

United States 199

Change IP Address 1.1.1.1 207

Change Subnet Mask 255.0.0.0 207

Change MAC Address Set on adapter card 214

Change Default Printer Generic/Text Only on LPT1
Generic/Text to File

217
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Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.
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3. Click the Set Date and Time button.  The System Clock - Settings notebook
appears with the Date/Time page open.

4. To adjust the Console time, click the up or down arrows by the Hours,
Minutes, and Seconds fields as required. Click the AM or PM radio button as
required.
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5. To adjust the Console date, click the up or down arrows by the Month, Day,
and Year fields as required.

6. Close the System Clock - Settings notebook by double-clicking the icon in the
upper left corner of the notebook.

7. Close the OS/2 Window drawer by clicking the drawer arrow.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Date and Time Format
This procedure changes the time format between a 12-hour and 24-hour clock, and
the date format between a month-day-year, day-month-year, or year-month-day
format.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Double-click the System Setup icon. The System Setup - Icon View appears.

4. Double-click the Country icon. The Country - Settings notebook appears with
the Country page open.

5. Perform one or both of the following to adjust the format:
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– Click the Date tab to display the Date page.  Click the desired radio
button to select between Month-Day-Year, Day-Month- Year, or Year-
Month-Day display formats.

– Click the Time tab to display the Time page.  Click the desired radio
button to select between 12 hours or 24 hours display formats.  If the 12
hours format is used, select between AM or PM display by scrolling
through the list box to the right of the radio button.
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6. Double-click the upper left corner of the Country - Settings notebook box to
close the notebook.

7. Double-click the upper left corner of the System Setup - Icon View to close
the view.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Enable Screen Saver
Perform this procedure to enable the Win-OS/2 screen saver or modify screen
saver operation.  Do not enable the screen saver or automatic lockup (password
protection) function available through the OS/2 desktop Properties option.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.
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4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.

5. Double-click the Desktop icon.  The Desktop dialog box appears.
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6. Modify the screen saver function as required.  Enable the screen saver by
scrolling to a desired screen (other than None) in the Name field in the
Screen Saver section.  Set the time delay for the screen saver to enable by
scrolling to the desired time in the Delay field. The password function for the
Console is not required.  To enable the password function, select a screen
saver and the Setup button.  Click the Password check box, enter a
password, and click OK.

7. When finished, click the OK button on the Desktop dialog box.

8. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

9. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

10. Close the OS/2 Window drawer by clicking the drawer arrow.

11. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

12. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Keyboard Layout and Country Code Page (International Users Only)
Perform this procedure to change the keyboard layout and country information.
This allows keyboards to be customized for international users (outside of the
United States). You must also change options for Win-OS/2 windows and the OS/2
operating system.
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1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Double-click the System Setup icon.  The System Setup - Icon View
appears.
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4. Double-click the Selective Install icon.  A message box appears indicating
the installation program is initializing.  After a few seconds, the System
Configuration dialog box appears.

5. At the Locale area of the System Configuration dialog box, click the Country
icon.  The Country Information dialog box appears.
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6. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.

7. At the Locale area of the System Configuration dialog box, click the Keyboard
icon.  The Keyboard dialog box appears.

8. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.
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9. Click the OK button.  The OS/2 Setup and Installation dialog box appears.

10. Click the Install button to continue. The Source Directory dialog box appears.

11. Click the Install button.  A message box appears explaining that the OS/2
setup is completing the configuration change.  After a few seconds, a
message box appears telling you to shut down and restart the system.

12. Click the OK button.  The System Setup - Icon View appears again.

13. Double-click the upper left corner of the System Setup - Icon View and OS/2
System - Icon View to close the views and return to the OS/2 desktop.
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14. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

15. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Win-OS/2 Keyboard Settings
Perform this procedure to change the keyboard layout for Win-OS/2 windows
and the OS/2 operating system.  This allows keyboards to be customized for
international users (outside of the United States).

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.
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– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.
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4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.

5. Double-click the International icon.  The International dialog box appears.

6. Click the arrow button for the Country field and select the desired country
from the drop-down list.
206        Console Installation and User’s Guide



7. Click the arrow button for the Language field and select the desired language
from the drop-down list.

8. Click the arrow button for the Default Keyboard field and select the desired
keyboard layout from the drop-down list.

9. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

10. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

11. Close the OS/2 Window drawer by clicking the drawer arrow.

12. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

13. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Token Ring Adapter IP Address and Subnet Mask
The default IP address for the Console Token Ring adapter card is 1.1.1.1, and the
default subnet mask is 255.0.0.0. If you wish to change either or both these values,
obtain a unique Console IP address or subnet mask from the LAN administrator.

The IP address must be in the form nnn.nnn.nnn.nnn, where nnn is a decimal byte
in the range 0 through 255.  The IP address may not be all zeros or all 255s.
Change default IP address and subnet mask values if:

• The Console is not on an isolated Token Ring LAN.

• There is more than one Console on the Token Ring LAN.
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• The subnet mask does not conform to the network to which the Console is
connected.

• The IP address conflicts with the address of another device on the ring or
does not conform to the LAN addressing scheme.

• The IP address does not conform to the LAN addressing scheme.

Perform the following procedure to display and change the Director or Sysplex
Timer Console’s IP address and subnet mask.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.

3. Click the TCP/IP Cnfg. button.  The TCP/IP Configuration notebook appears
with the Network page open.
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4. To change the IP address, click in the IP Address field.  Type the new IP
address as necessary. Move within the field by using the left and right arrow
keys (← and →).  Use the Backspace  key to delete characters.

5. To change the subnet mask, click in the Subnet Mask field.  Type the new
subnet mask as necessary.  Move within the field by using the left and right
arrow keys (← and →).  Use the Backspace  key to delete characters.

6. Close the TCP/IP Configuration notebook by double-clicking the upper left
corner of the notebook.  The Closing TCP/IP Configuration dialog box
appears.

7. Click the Save button.  The OS/2 desktop appears.

8. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

9. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

10. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Token Ring Adapter MAC Address
Change the Console Token Ring adapter’s Media Access Control (MAC) address if
the address does not conform to the locally-administered LAN addressing scheme.
Perform the following procedure to display and change the Director or Sysplex
Timer Console’s MAC address.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.
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3. To display the MAC address, continue to "Display MAC Address" below.  To
change the MAC address, refer to “Change MAC Address” on page 214.

Display MAC Address
To display the MAC address:

1. Click the Lanaid button on the TCP/IP Cnfg. drawer.  The IBM LANAID
message box appears briefly while the system configuration is queried.
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The IBM LANAID message box closes, and the LANAID v2.21 for IBM
Auto/Turbo ISA Adapters window appears.

2. Record the MAC address.  The address is listed at the top of the window
under MAC Address.

3. Click the Exit button.  The LANAID dialog box appears.

4. Click the OK button.  The OS/2 desktop appears.

5. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.
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Change MAC Address
To change the MAC address:

1. Click the LAPS button on the TCP/IP Cnfg. drawer.  The IBM LAN Adapter
and Protocol Support window appears.

2. Click the Configure button.  The Configuration dialog box appears.

3. Ensure the Configure LAN transports radio button is selected, then click the
Continue button.  The Configure Workstation dialog box appears.
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4. Use the scrolling arrows to scroll through the Current Configuration list box
and click (select) the IBM Token-Ring Network Adapters entry.

5. Click the Edit button.  The Parameters for IBM Token-Ring Network Adapter
dialog box appears.
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6. Click the Network adapter address field.  Enter the new hexadecimal MAC
address (12-digit) as required.

7. Click the OK button.  The Configure Workstation dialog box reappears.

8. Click the OK button. The IBM LAN Adapter and Protocol Support dialog box
reappears.

9. Click the Exit button.  The CONFIG.SYS Updates dialog box appears.  The
letter C should appear in the Drives to update field.  If it does not, use the
scrolling arrows to select C.

10. Click the Continue button.  A CONFIG.SYS Updated dialog box
appears explaining the CONFIG.SYS file was successfully updated.

11. Click the OK button.  The Exiting LAPs dialog box appears.

12. Click the Exit button to return to the OS/2 desktop.

13. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

14. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

15. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Set or Change Default Printer
Perform the following procedure to set or change the default printer for the Director
or Sysplex Timer Console.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.
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3. Click the Program Manager button. The Program Manager window appears.

4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.
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5. Double-click the Printers icon.  The Printers dialog box appears.

6. Click (select) a driver displayed in the Installed Printers field and click the Set
as Default Printer button.

7. To add a driver not listed in the Installed Printers field, perform the following:

a. Click the Add button. The Printers dialog box reappears with a list of
available printers.
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b. Scroll through the list of printers and select the desired printer.

c. Click the Install button to display the Install Driver dialog box.

d. Type C:\prtdrvs  and click the OK button.  The driver loads and
appears under the list of installed printers in the Printers dialog box.

8. Close all open windows by double-clicking the upper left corner of each
window.  When the Exit Win-OS/2 dialog box appears, click the OK button
to exit Win-OS/2, close the dialog box, and return to the OS/2 desktop.

9. Close the OS/2 Window drawer by clicking the drawer arrow.

10. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 4 on
page 190), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

11. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Chapter 7. Model PC-365 Console Procedures

This chapter describes Operating System/2 (OS/2) Warp 4.0 procedures for
an IBM Model PC-365 computer used as an Enterprise Systems Connection
(ESCON) Director Console or Sysplex Timer Console.  The procedures are
Director and Timer-specific and include:

• Performing general administrative tasks.

• Performing backup and restore functions.

• Customizing the Console operating environment.

General Administrative Tasks
This section describes general administrative tasks for the ESCON Director
Console or Sysplex Timer Console.  The section provides instructions to:

• Perform the data collection procedure for the Director or Sysplex Timer.

• Clear the address resolution protocol (ARP) table for the local area
network (LAN) on which a Director or Timer is installed.

• Migrate a Director database to another Console (excluding a Hardware
Management Console).

• Change the Token Ring adapter data rate for the Console PC.

• Create Console diagnostic diskettes.

Perform Data Collection Procedure
Perform the data collection procedure for the Director or Sysplex Timer after a
system problem occurs or when a field-replaceable unit (FRU) is removed and
replaced.

Director Data Collection
The data collection procedure transfers maintenance information to the Director
Console’s fixed disk, then to a 3.5-inch diskette.  The diskette is mailed to the
original equipment manufacturer (OEM) for problem analysis and resolution.

1. With the Director’s Active Matrix window open, select the Collect
Maintenance Information option from the Maintenance menu.  The Collect
Maintenance Information dialog box appears showing files being transferred
and the transfer status.  When all files are transferred to the fixed disk, the
following dialog box appears.
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2. Click the OK button to close the dialog box.  The Director’s Active Matrix
window reappears.

3. Record the Director name.  The name (up to eight characters in length)
appears on the title bar at the top of the active matrix window.

4. Simultaneously press the Ctrl  and Esc  keys to transfer to the Director
Console’s OS/2 desktop.  The Window List appears.

5. Double-click the Desktop-Icon View selection.  The Director Console’s OS/2
desktop appears.

6. Insert a data collection diskette into drive A:  of the Director Console in
accordance with one of the following steps:

– If you are removing and replacing a FRU in the 9032-003 or 9033-004
ESCON Director, use the data collection diskette shipped with the
replacement FRU.  The diskette is labeled Data Collection Diskette.

– If you are removing and replacing a FRU in the 9032-005 ESCON
Director or collecting data for another purpose (such as fault isolating
problems), use a data collection diskette shipped with the Director.  The
diskette is labeled Data Collection Utility Version XX.YY.ZZ, where
XX.YY.ZZ is the Licensed Internal Code (LIC) version number.

– If a labeled data collection diskette is not available, a blank, DOS-
formatted diskette may be used.

7. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.
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8. Double-click the ESCON Director Data Collection icon.  The first ESCON
Director Data Collection window appears

9. Type Y and press the Enter  key.  The second ESCON Director Data
Collection window appears.

10. Type the Director name (recorded in step 3 of this procedure) and press the
Enter  key.  Messages appear in the window showing files transferring from
the fixed disk to diskette.  The data collection process is complete when the
Enter prompt appears.
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11. Press the Enter  key.  The ESCON Director Data Collection window closes.

12. Double-click the upper left corner of the ESCON Director Tools - Icon View
to close the view and return to the OS/2 desktop.

13. Remove the data collection diskette from drive A:  of the Director Console.
Record the following information on the diskette label.

– Director serial number.

– Quality Service Activity Reporting (QSAR) number.

– Problem Management - Hardware (PMH) number.

– Current date.

14. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

15. At the OS/2 desktop, open the Director Console application by double-
clicking the Director Console icon.  The Console application opens to the
window closed in step 4 of this procedure.

Sysplex Timer Data Collection
The data collection procedure transfers maintenance information from the Timer to
a 3.5-inch diskette.  The diskette is mailed to the OEM for problem analysis and
resolution.

1. At the Sysplex Timer Network Console window, simultaneously press the Ctrl
and Esc  keys to transfer to the Timer Console’s OS/2 desktop.  The Window
List appears.

2. Double-click the Desktop-Icon View selection.  The Timer Console’s OS/2
desktop appears.

3. At the OS/2 desktop, double-click the Sysplex Timer Tools folder.  The
Sysplex Timer Tools - Icon View appears.
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4. Double-click the Sysplex Timer Data Collection icon.  The Sysplex Timer
Data Collection window appears.

5. Insert a data collection diskette into drive A:  of the Timer Console.  The
diskette is labeled Data Collection Diskette.  If a labeled data collection
diskette is not available, a blank, DOS-formatted diskette may be used.

6. Press the Enter  key.  Messages appear in the window showing files
transferring from fixed disk to diskette.  The data collection process is
complete when the Enter prompt appears.

7. Press the Enter  key.  The Sysplex Timer Data Collection window closes.

8. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

9. Remove the data collection diskette from drive A:  of the Timer Console.
Record the following information on the diskette label.

– Timer serial number.

– QSAR number.

– PMH number.

– Current date.

10. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.
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11. At the OS/2 desktop, open the Sysplex Timer Console application by double-
clicking the Sysplex Timer Console icon.  The Console application opens to
the window closed in step 1 of this procedure.

Clear the Address Resolution Protocol Table
This procedure clears the ARP table for a LAN with a Director or Timer installed.
The procedure clears old Internet Protocol (IP) or Media Access Control (MAC)
addresses so the ARP table can rebuild with new addresses.  The procedure
prevents new Console, Director, or Timer addresses from conflicting with old,
unused addresses.  Clear the ARP table if:

• The IP or MAC address of a Director, Director Console, Timer, or Timer
Console was changed after operating previously on the LAN.

• The Director, Director Console, Timer, or Timer Console are installed on a
public (nondedicated) LAN.

To clear the ARP table:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the TCP/IP Cnfg. drawer to open the drawer.

3. Click the ARP button to clear the table. The ARP window appears briefly and
closes, indicating all the IP and MAC addresses cleared by the procedure.

4. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

5. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.
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Migrate Director Definitions
If the Director Console application is uninstalled at a Console (Director, Sysplex
Timer, Hardware Management, or other nondedicated Console) and installed on a
new Console, Director definitions must be recorded on a 3.5-inch diskette and
migrated to the new Console.  Definitions include IP addresses, Director names,
model numbers, and matrix configuration files.

If the Console application is discontinued and installed on a another Director
Console, a Director definitions diskette must be created. Refer to "Create Director
Definitions Diskette" below for instructions.  If the Console application is installed
on a new Director Console, Director definitions must be migrated. For instructions,
refer to "Migrate Definitions to a Director Console" on page 230.

Create Director Definitions Diskette
Perform this procedure to create a Director definitions diskette.

1. Ensure the Director Console application is closed, not just reduced to an
icon.  If the Console application is open (Startup or Matrix window appears),
continue to step a.  If the OS/2 desktop appears, go to step b.

Note: OS/2 screens may look slightly different depending on the level of
operating system installed on the Director Console.

a. At the Startup or Matrix window, select the Close Window option from
the File menu.  The Director Console application closes and the OS/2
desktop appears.  Go to step 2.

b. At the OS/2 desktop, simultaneously press the Ctrl  and Esc  keys.  The
Window List  appears.

• If the Director Console - Director Console selection does not appear,
the Console application is closed. Double-click the Desktop - Icon
View selection to return to the OS/2 desktop, and go to step 2.

• If the Director Console - Director Console selection appears , the
Console application is open and minimized. Double-click the
selection to maximize the application.  At the Startup or Matrix
window, select the Close Window option from the File menu.  The
Console application closes and the OS/2 desktop appears.
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2. Insert the Console application diskette (labeled Console Version XX.YY.ZZ)
into drive A:  of the Director Console.

3. Double-click the OS/2 System icon.  The OS/2 System - Icon View appears.

4. Double-click the Drives icon.  The Drives - Icon View appears.

5. Double-click the Drive A icon.  The Drive A - Icon View appears.

6. Double-click the DCGETDEF.CMD icon.  The DCGETDEF.CMD window
appears.

7. Remove the Console application diskette from drive A:  of the Director
Console and insert a blank, DOS-formatted diskette (provided with the
Director).

8. Press the Enter  key.  Director definitions are copied to the diskette, and the
copy progress is displayed in the DCGETDEF.CMD window.  When the
process is complete, the DCGETDEF.CMD window closes.

9. Double-click the upper left corner of the Drive A - Icon View, Drives - Icon
View, and OS/2 System - Icon View to close the views and return to the OS/2
desktop.
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10. Remove the Director definitions diskette from drive A:  of the Director
Console.

11. Label and store the Director definitions diskette as appropriate. The diskette
can now be used to transport definitions to a new Console.

Migrate Definitions to a Director Console
Perform this procedure to migrate Director definitions to a Director Console.

Note: This procedure does not work if the Director Console application is open or
if the Director Console library already contains definitions.

1. If the Director Console application is open, select the Exit option from the File
menu.  The following dialog box appears.

2. Click the OK button to close the dialog box.  The OS/2 desktop appears.

3. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.

4. Double-click the Put Director Definitions Director Console Migration icon.
The Put Director Definitions Director Console Migration window appears.
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Note: If a warning appears indicating migration was terminated because
Director definitions exist in the Console library, press the Enter key to
close the Put Director Definitions Director Console Migration window
and exit the utility.

If a warning appears indicating migration was terminated because
the Console library was not initialized, press the Enter  key to close
the Put Director Definitions Director Console Migration window and
exit the migration utility.  Open and close the Director Console
application, then perform this procedure again.

5. Insert the Director definitions diskette (created at the Console from which the
definitions are migrated) into drive A:  of the Console.

6. Press the Enter key. Director definitions are copied to the Console fixed disk
for initializing the Director Console library. When the process is complete, the
Put Director Definitions Director Console Migration window closes.

7. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

8. Remove the Director definitions diskette from drive A:  of the Console.  Store
the Director definitions diskette as appropriate.

9. At the OS/2 desktop, start the Director Console application by double-clicking
the Director Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

Change Token Ring Adapter Card Data Rate
Perform this procedure to change the data rate of the Token Ring adapter card for
the Director or Sysplex Timer Console. The procedure changes the default rate of
16 megabits per second (Mbps) to 4 Mbps.
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Note: The data rate is set at the factory.  Do not change the data rate unless
required because of LAN or other system requirements.

To change the Token Ring adapter card data rate:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, simultaneously press the Ctrl  and Esc  keys.  The
Window List appears.
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3. Select the ACTZGTWR - ACTZGTWR entry and click the right mouse button.
The Show pop-up menu appears.

Note: If the ACTZGTWR - ACTZGTWR entry does not appear in the
Window List, press the Esc  key and go to step 5.

4. Select the Close option.  The Show pop-up menu and the Window List
close.

5. Click the arrow on the TCP/IP Cnfg. drawer to open the drawer.

6. Click the LANAID button.  The IBM LANAID message box appears briefly
while the system configuration is queried.
Chapter 7.  Model PC-365 Console Procedures       233



The IBM LANAID message box closes, and the LANAID v2.21 for IBM
Auto/Turbo ISA Adapters window appears.

7. Click the Adapter Configuration button.  The View Adapter Configuration
dialog box appears with the Configurable page open.
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8. Click the Change button at the bottom of the dialog box.  The Change
Configuration Parameters dialog box appears with the Adapter Modes page
open.

9. Click the Other Parameters tab at the top of the dialog box.  The Other
Parameters page appears.

10. To change the data rate from 16 Mbps (default), click the 4 Mbps radio button
in the Data Rate box.

11. Click the OK button.  The Configuration Warning message box appears.
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12. Click the Yes button.  The Configuration Warning message box closes and
the View Adapter Configuration dialog box reappears.

13. Click the Store button at the bottom of the dialog box to save the parameters.
The Storing Configuration message box appears for approximately 30
seconds.

When the configuration change is stored, the Storing Configuration message
box closes and the Configuration settings applied message box appears.
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14. Click the OK button. The Configuration settings applied message box closes.

15. Click the Done button.  The View Adapter Configuration dialog box
closes and the LANAID v2.21 for IBM Auto/Turbo ISA Adapters dialog box
reappears.

16. Click the Exit button.  The LANAID dialog box appears.

17. Click the OK button.  The OS/2 desktop appears.

18. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

19. Shut down and restart the operating system and Console to initiate changes.
For instructions, refer to “Shut Down and Restart the OS/2 Operating System
and Console” on page 26.

Create Console Diagnostic Diskettes
Perform this procedure to create diagnostic diskettes for the Console PC.  Keep
the diskettes with the Console, and use them under direction from the next level of
support to fault isolate problems with the PC.  To create the diagnostic diskettes:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Insert a blank, formatted diskette (labeled For Use By Service Personnel
Only  and shipped with the Console) into the diskette drive.

3. Click the arrow on the Drive A drawer to open the drawer.
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4. Click the Build Diag. Disk button.  The Build Diag. Disk window appears.

5. Press the Y key to continue. A message appears at the bottom of the window
showing the percentage of files written to the diskette.

6. When the percentage reaches 100, remove the diskette, insert a second
diskette as prompted, and press the Enter  key.  Label the first diskette
Reference Diskette.

7. The Build Diag. Disk window appears again.  Press the Y key to continue.
A message appears at the bottom of the window showing the percentage of
files written to the diskette.

8. When the percentage reaches 100 again, the second diagnostic diskette is
created and the OS/2 desktop reappears.  Remove the diskette from the
drive.  Label the second diskette SCSI Diagnostic.

9. Close the Drive A drawer by clicking the drawer arrow.

10. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

11. Keep the diskettes with the Console and use them under direction from the
next level of support to fault isolate PC problems.
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Backup and Restore Functions
The Model PC-365 Console contains a rewriteable optical cartridge (ROC) drive to
perform backup and restore functions.  Backups of the Director or Sysplex Timer
system libraries are routinely performed. Library data is restored using a ROC with
the most recent backup version of the Director or Timer system library.  The entire
Console fixed disk is restored using:

• A 3.5-inch Director or Sysplex Timer Console application diskette.

• A 3.5-inch Console restore diskette.

• A Console restore CD-ROM.

• A ROC that contains the most recent backup version of the Director or Timer
system library.

This section describes:

• Backing up the Director or Sysplex Timer system library to ROC.

• Restoring the Director or Sysplex Timer system library from ROC.

• Restoring the Console fixed disk from CD-ROM and ROC.

Back Up the System Library to ROC
Routine backups of the Director or Sysplex Timer system library to a ROC ensure
critical data can be restored if required.  The data is also required when migrating
the Director Console application to a backup or replacement Console.

Critical data for the Director Console includes Console settings, LIC files, logs, IP
addresses, Director configuration files, and Director matrices.  Critical data for the
Sysplex Timer Console includes Console settings, IP addresses, configuration
files, logs, and identification information for the Timer network.

This section describes procedures to enable automatic back up of the system
library to ROC at the default time, change backup settings. or back up the system
library on demand.

Enable Automatic Backup at Default Time
If enabled, the operating system automatically backs up the system library to a
ROC at a specified or default time.  Perform this procedure to enable automatic
backup of the system library at the default backup time (daily at 12:00 midnight).
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This procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  If either or both
applications are running on a Hardware Management Console, refer to Chapter 3
for system library backup procedures.   To enable the automatic backup feature
using the default setting of 12:00 midnight:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the Backup drawer to open the drawer.
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3. Click the Set Default button on the Backup drawer.  The Set Default dialog
box appears.

4. Type Y and press the Enter  Key.  The Director or Sysplex Timer Console
system library automatically backs up every day at midnight.

5. Click the arrow on the Backup drawer to close the drawer.

6. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.
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– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

7. Ensure a blank optical cartridge is installed in the Console ROC drive when
the automatic backup feature is enabled.  The backup ROC is provided with
the Console.

Change Backup Settings
Perform this procedure to change backup settings from the default values.  To
change the backup settings:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the Backup drawer to open the drawer.
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3. Click the Modify Schedule button on the Backup drawer.  The Timer Control
Center dialog box appears.  The command line (script) shown at the top of
the screen automatically runs a program using the default backup setting.

Note: The term Timer in the Timer Control Center dialog box does not refer
to the Sysplex Timer.
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4. Click the script name to select it.  The settings associated with the script dis-
play at the lower part of the screen. To change the settings, perform one of
the following:

– Select an item in the Mode column.  All required parameters are
completed for the selection.

– Change parameters by scrolling up or down a column (Hour, Minute, etc.)
or by typing the desired value at the top of the column.  An asterisk (*)
indicates backup periodically by that parameter.

5. When the parameters are set correctly, click the Save button to save changes
to the script.

6. Click the OK button to enable the changes and return to the OS/2 desktop.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

Backup on Demand
Perform this procedure to back up the Director or Sysplex Timer system library
on demand.  This procedure applies to a dedicated Console PC running the
Director Console application or Sysplex Timer Console application (or both).  If
either or both applications are running on a Hardware Management Console, refer
to Chapter 3 for system library backup procedures.  To back up the system library
to ROC on demand:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the Backup drawer to open the drawer.
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3. Click the Backup button on the Backup drawer.  The Backup dialog box
appears.

4. Insert a blank cartridge (or a cartridge with data that can be overwritten)
in the ROC drive of the Console PC, then press the Enter key.  Process
messages display until the backup is complete.

5. Remove the cartridge from the ROC drive, label the cartridge, and store it in
a safe, secure location.

Note: Ensure a new blank cartridge is inserted in the ROC drive if the
automatic backup feature is enabled.

6. Click the arrow on the Backup drawer to close the drawer.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

Restore the System Library from ROC
Perform this procedure to restore the Director or Sysplex Timer system library from
a backup ROC to the Console fixed disk.  To restore the system library:
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1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. Click the arrow on the Backup drawer to open the drawer.
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3. Click the Restore button on the Backup drawer.  The Restore dialog box
appears.

4. Insert a backup cartridge in the ROC drive of the Console PC, then press
the Enter key.  The OS/2 desktop reappears when the restore operation is
finished.

Note: Ensure the correct cartridge is inserted in the ROC drive.

5. Remove the backup cartridge from the ROC drive and store it in a safe,
secure location.
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Note: Ensure a new blank cartridge is inserted in the ROC drive if the
automatic backup feature is enabled.

6. Click the arrow on the Backup drawer to close the drawer.

7. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational. It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational. The Console application should remain active
and operational for the following reasons:

a. Certain Timer events and associated reason codes are transmitted
only to the Event log maintained at the Timer Console.  The events
are not transmitted through attached processors to the System
Control Program (SCP) Console.  If the Console application is
closed and a Timer network failure occurs, reason codes and other
information required for fault isolation may not be recorded.

b. Closing the Console application causes an ETR Service is
Requested message to be reported to the SCP Console with reason
code 40 (communication lost with active Console) or reason code 41
(communication lost with standby Console).  This may result in an
unnecessary service call.

c. Starting the Console application causes an ETR Service is
Requested  message to be reported to the SCP Console, with
reason code 8 (communication established with active Console) or
reason code 9 (communication established with standby Console).
This may result in an unnecessary service call.

Restore the Console Fixed Disk from CD-ROM and ROC
Perform this procedure to format and restore the Console fixed disk from CD-ROM
and a backup ROC.  Use the instructions after installing a new unformatted fixed
disk.  This procedure applies to a dedicated Console PC running the Director
Console application or Sysplex Timer Console application (or both).  Default
parameters when the fixed disk is restored are listed in Table 5.
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Table 5. Default Parameters for Console Support Software (ROC Restore)

To reformat and restore the Console fixed disk from CD-ROM and a backup ROC:

1. Obtain the following (XX.YY.ZZ indicates the software version, release, and
patch numbers):

– The 3.5-inch Console application diskette labeled Console Version
XX.YY.ZZ (shipped with the Director or Sysplex Timer).

– The 3.5-inch Console restore diskette labeled Base Console Restore
Version XX.YY.ZZ (shipped with the Director or Sysplex Timer).

– The Console restore CD-ROM labeled Base Console Restore Version
XX.YY.ZZ (shipped with the Director or Sysplex Timer).

– The rewriteable optical cartridge (ROC) that contains the most recent
backup version of the system library.

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Feature Default Parameters

Set Time and Date Time and date for manufacturing location

Change Time and Date Format Time:  12-hour clock
Date:  Month-Day-Year

Console Screen Lock Disabled

Keyboard Layout United States

IP Address 1.1.1.1

MAC Address Set on adapter card

Subnet Mask 255.0.0.0

Automatic Backup Disabled

Default Printer Generic/Text Only on LPT1
Generic/Text to File
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Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

3. At the OS/2 desktop, click the Shutdown button at the bottom of the launch
pad. A dialog box appears, asking if you want to close the application without
saving data.

4. Click the OK button.  A Shutdown Has Completed message box appears,
explaining it is now safe to turn off the computer or restart.

5. Power off the Console PC.

6. Insert the Base Console Restore Version XX.YY.ZZ diskette in the diskette
drive (ensure the diskette is write enabled).  Power on the Console PC.

7. The IBM OS/2 logo screen appears, followed by a series of installation and
load messages.
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Ignore all messages until the following message appears:

8. Press the F1 key to continue the process.  The fixed disk is formatted and
partitioned in preparation for insertion of the Console restore CD-ROM. This
process takes approximately 10 minutes.

When the system is ready the following message appears:

9. At the preceding prompt, insert the CD-ROM labeled Base Console Restore
Version XX.YY.ZZ in the CD-ROM drive and press the Enter  key.  The
process of installing the files from the CD-ROM to the Console fixed disk
takes approximately 10 minutes.

When the installation is complete the following message appears:

10. Remove the Console restore diskette and CD-ROM from their respective
drives.  Simultaneously press the Ctrl , Alt , and Del keys to reboot the
Console PC.

11. If required, change the default IP address.  For instructions, refer to “Token
Ring Adapter IP Address and Subnet Mask” on page 272 and return here.

12. Install the Director or Sysplex Timer Console application using the application
diskette labeled Console Version XX.YY.ZZ. For instructions, refer to Chapter
6 of the appropriate maintenance information manual listed below:

– Maintenance Information for the 9032 Model 3 Enterprise Systems
Connection Director (SY27-3601).

– Maintenance Information for the 9033 Model 4 Enterprise Systems
Connection Director (SY27-2638).

Base Console Hard Disk Restore

The procedure will load your Console hard disk
from the Base Console Restore CD-ROM

WARNING: Continuing this process will result in
the destruction of information currently on your
hard disk.

Press F1 to continue with the RESTORE process.
Press ESC to EXIT the program.

Install the Base Console Restore CD-ROM

To continue press any key.

Base Console restore is complete.
Remove the diskette and the CD-ROM and reboot
the PC.
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– Maintenance Information for the 9032 Model 5 Director (SY28-1158).

– Maintenance Information for the 9037 Model 2 Sysplex Timer
(SY27-2641).

13. Restore the system library using the backup ROC.  For instructions, refer to
“Restore the System Library from ROC” on page 247.

Customize the Console Operating Environment
This section describes procedures to change ESCON Director or Sysplex Timer
Console operating parameters from default values listed in Table 6.   If you restore
the Model PC-365 Console’s fixed disk, all the parameters (including the IP
address of the Console) are reset to default values.

Note: Do not enable the screen saver or automatic lockup function (password
protection) through the OS/2 desktop Settings option.  Enable the screen
saver using instructions in this section.

Table 6. Procedures and Default Parameters for Console Operating Environment

Set Date and Time
This procedure sets the date and time for the Console PC’s operating environment.
Although the date and time are set, the parameters may require change for an
installation location. Use this procedure to display or change the Console date and
time or synchronize the Console date and time with a Sysplex Timer network.

Procedure Default Parameter Page

Set Date and Time Set to date and time for
manufacturing location

254

Change Date and Time Format Time:  12-hour clock
Date:  Month-Day-Year

257

Enable Screen Saver Disabled 261

Change Keyboard Layout and
Country Code Page

United States 264

Change IP Address 1.1.1.1 272

Change Subnet Mask 255.0.0.0 272

Change MAC Address Set on adapter card 276

Change Default Printer Generic/Text Only on LPT1
Generic/Text to File

281
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In the Director Console application, Console Audit Log and Console Error Log
events are time stamped with the PC date and time. All other date and time entries
in the application are time stamped with parameters derived from the Director.

In the Sysplex Timer Console application, Console Audit Log events are time
stamped with the PC date and time.  All other date and time entries in the
application are time stamped with Coordinated Universal Time (UTC) derived
from the Timer.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Set Date and Time button.  The System Clock - Properties dialog
box appears with the Date/Time page open.
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4. To adjust the Console time, click the up or down arrows by the Hours,
Minutes, and Seconds fields as required. Click the AM or PM radio button as
required.

5. To adjust the Console date, click the up or down arrows by the Month, Day,
and Year fields as required.

6. Close the System Clock - Properties dialog box by double-clicking the icon in
the upper left corner of the dialog box.

7. Close the OS/2 Window drawer by clicking the drawer arrow.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Date and Time Format
This procedure changes the time format between a 12-hour and 24-hour clock, and
the date format between a month-day-year, day-month-year, year-month-day, or
year-day-month format.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Click the System Setup option.  The System Setup - Icon View appears.
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4. Double-click the Country icon.  The Country - Properties dialog box appears
with the Country page open.

5. Perform one or both of the following to adjust the format:

– Click the Date tab to display the Date page.  Click the desired radio
button to select between Month-Day-Year, Day-Month-Year, Year-Month-
Day, or Year-Day-Month display formats.

– Click the Time tab to display the Time page.  Click the desired radio
button to select between 12 hours or 24 hours display formats.  If the 12
hours format is used, select between AM or PM display by scrolling
through the list box to the right of the radio button.
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6. Double-click the upper left corner of the Country - Properties dialog box to
close the dialog box.

7. Double-click the upper left corner of the System Setup - Icon View to close
the view.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.
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– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Enable Screen Saver
Perform this procedure to enable the Win-OS/2 screen saver or modify screen
saver operation.  Do not enable the screen saver or automatic lockup (password
protection) function available through the OS/2 desktop Properties option.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.
Chapter 7.  Model PC-365 Console Procedures       261



3. Click the Program Manager button. The Program Manager window appears.

4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.
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5. Double-click the Desktop icon.  The Desktop dialog box appears.

6. Modify the screen saver function as required.  Enable the screen saver by
scrolling to a desired screen (other than None) in the Name field in the
Screen Saver section.  Set the time delay for the screen saver to enable by
scrolling to the desired time in the Delay field. The password function for the
Console is not required.  To enable the password function, select a screen
saver and the Setup button.  Click the Password check box, enter a
password, and click OK.

7. When finished, click the OK button on the Desktop dialog box.

8. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

9. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

10. Close the OS/2 Window drawer by clicking the drawer arrow.

11. Perform one of the following:
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– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

12. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Keyboard Layout and Country Code Page (International Users Only)
Perform this procedure to change the keyboard layout and country information.
This allows keyboards to be customized for international users (outside of the
United States). You must also change options for Win-OS/2 windows and the OS/2
operating system.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Double-click the System Setup icon. The System Setup - Icon View appears.

4. Double-click the Install/Remove icon.  The Install/Remove - Icon View
appears.
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5. Double-click the Selective Install icon.  A message box appears indicating
the installation program is initializing.  After a few seconds, the System
Configuration dialog box appears.

6. At the Locale area of the System Configuration dialog box, click the Country
icon.  The Country Information dialog box appears.

7. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.

8. At the Locale area of the System Configuration dialog box, click the Keyboard
icon.  The Keyboard dialog box appears.
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9. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.

10. Click the Next button. The System Configuration (cont’d) dialog box appears.
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11. Click the Next button.  The OS/2 Setup and Installation dialog box appears.

12. Click the Next button to continue.  The Source Directory dialog box appears.

13. Click the Install button.  A message box appears explaining that the OS/2
setup is completing the configuration change.  After a few seconds, a
message box appears telling you to shut down and restart the system.

14. Click the OK button.  The Install/Remove - Icon View appears again.

15. Double-click the upper left corner of the Install/Remove - Icon View, System
Setup - Icon View, and OS/2 System - Icon View to close the views and return
to the OS/2 desktop.
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16. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

17. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Win-OS/2 Keyboard Settings
Perform this procedure to change the keyboard layout for Win-OS/2 windows
and the OS/2 operating system.  This allows keyboards to be customized for
international users (outside of the United States).

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.
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– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.
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4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.

5. Double-click the International icon.  The International dialog box appears.

6. Click the arrow button for the Country field and select the desired country
from the drop-down list.
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7. Click the arrow button for the Language field and select the desired language
from the drop-down list.

8. Click the arrow button for the Default Keyboard field and select the desired
keyboard layout from the drop-down list.

9. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

10. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

11. Close the OS/2 Window drawer by clicking the drawer arrow.

12. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

13. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Token Ring Adapter IP Address and Subnet Mask
The default IP address for the Console Token Ring adapter card is 1.1.1.1, and the
default subnet mask is 255.0.0.0. If you wish to change either or both these values,
obtain a unique Console IP address or subnet mask from the LAN administrator.

The IP address must be in the form nnn.nnn.nnn.nnn, where nnn is a decimal byte
in the range 0 through 255.  The IP address may not be all zeros or all 255s.
Change default IP address and subnet mask values if:

• The Console is not on an isolated Token Ring LAN.

• There is more than one Console on the Token Ring LAN.
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• The subnet mask does not conform to the network to which the Console is
connected.

• The IP address conflicts with the address of another device on the ring or
does not conform to the LAN addressing scheme.

• The IP address does not conform to the LAN addressing scheme.

Perform the following procedure to display and change the Director or Sysplex
Timer Console’s IP address and subnet mask.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.

3. Click the TCP/IP Cnfg. button.  The TCP/IP Configuration notebook appears
with the Network page open.
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4. To change the IP address, click in the IP Address field.  Type the new IP
address as necessary. Move within the field by using the left and right arrow
keys (← and →).  Use the Backspace  key to delete characters.

5. To change the subnet mask, click in the Subnet Mask field.  Type the new
subnet mask as necessary.  Move within the field by using the left and right
arrow keys (← and →).  Use the Backspace  key to delete characters.

6. Close the TCP/IP Configuration notebook by double-clicking the upper left
corner of the notebook.  The Closing TCP/IP Configuration dialog box
appears.

7. Click the Save button.  The OS/2 desktop appears.

8. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

9. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

10. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Token Ring Adapter MAC Address
Change the Console Token Ring adapter’s Media Access Control (MAC) address if
the address does not conform to the locally-administered LAN addressing scheme.
Perform the following procedure to display and change the Director or Sysplex
Timer Console’s MAC address.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.
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3. Click the MPTS button.  An IBM logo dialog box appears briefly, then the
Multi-Protocol Transport Services dialog box appears.

4. Click the Configure button.  The Configure dialog box appears.
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5. Ensure the LAN adapters and protocols radio button is selected and click the
Configure button.  The Adapter and Protocol Configuration dialog box
appears.

6. Use the scrolling arrows to scroll through the Current Configuration list box.
Click (select) the IBM T-R Shared RAM Family . . selection.

7. Click the Edit button. The Parameters for IBM T-R Shared RAM Family dialog
box appears containing parameters for the Token Ring adapter.
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The current MAC address appears in the Network adapter address field if a
user has previously configured the MAC address.  Otherwise the field is
blank.

8. To change the MAC address, click in the Network adapter address field.
Type the new MAC address as necessary.  Move within the field by using
the left and right arrow keys (← and →).  Use the Backspace  key to delete
characters.

9. Click the OK button.  The Adapter and Protocol Configuration dialog box
reappears.

10. Click the OK button.  The Configure dialog box reappears.

11. Click the Close button to save the changes. The Multi-Protocol Transport
Services dialog box reappears.

12. Click the Exit button. The Update CONFIG.SYS dialog box appears. Ensure
a C appears in the Drives to update field.
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13. Click the Exit button. A CONFIG.SYS Updated dialog box appears explaining
the CONFIG.SYS file was successfully updated.

14. Click the OK button.  The Exiting MPTS dialog box appears.

15. Click the Exit button to return to the OS/2 desktop.

16. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

17. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.
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18. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Set or Change Default Printer
Perform the following procedure to set or change the default printer for the Director
or Sysplex Timer Console.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.

4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.
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5. Double-click the Printers icon.  The Printers dialog box appears.

6. Click (select) a driver displayed in the Installed Printers field and click the Set
as Default Printer button.

7. To add a driver not listed in the Installed Printers field, perform the following:

a. Click the Add button. The Printers dialog box reappears with a list of
available printers.
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b. Scroll through the list of printers and select the desired printer.

c. Click the Install button to display the Install Driver dialog box.

d. Type C:\prtdrvs  and click the OK button.  The driver loads and
appears under the list of installed printers in the Printers dialog box.

8. Close all open windows by double-clicking the upper left corner of each
window.  When the Exit Win-OS/2 dialog box appears, click the OK button
to exit Win-OS/2, close the dialog box, and return to the OS/2 desktop.

9. Close the OS/2 Window drawer by clicking the drawer arrow.

10. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 6 on
page 254), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

11. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Chapter 8. Model PC 300PL Console Procedures

This chapter describes Operating System/2 (OS/2) Warp 4.0 procedures for an
IBM Model PC 300PL computer used as an Enterprise Systems Connection
(ESCON) Director Console or Sysplex Timer Console.  The procedures are
Director and Timer-specific and include:

• Performing general administrative tasks.

• Performing backup and restore functions.

• Customizing the Console operating environment.

General Administrative Tasks
This section describes general administrative tasks for the ESCON Director
Console or Sysplex Timer Console.  The section provides instructions to:

• Perform the data collection procedure for the Director or Sysplex Timer.

• Clear the address resolution protocol (ARP) table for the local area
network (LAN) on which a Director or Timer is installed.

• Migrate a Director database to another Console (excluding a Hardware
Management Console).

• Change the Token Ring adapter data rate for the Console PC.

• Create Console diagnostic diskettes.

Perform Data Collection Procedure
Perform the data collection procedure for the Director or Sysplex Timer after a
system problem occurs or when a field-replaceable unit (FRU) is removed and
replaced.

Director Data Collection
The data collection procedure transfers maintenance information to the Director
Console’s fixed disk, then to a 3.5-inch diskette.  The diskette is mailed to the
original equipment manufacturer (OEM) for problem analysis and resolution.

1. With the Director’s Active Matrix window open, select the Collect
Maintenance Information option from the Maintenance menu.  The Collect
Maintenance Information dialog box appears showing files being transferred
and the transfer status.  When all files are transferred to the fixed disk, the
following dialog box appears.
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2. Click the OK button to close the dialog box.  The Director’s Active Matrix
window reappears.

3. Record the Director name.  The name (up to eight characters in length)
appears on the title bar at the top of the active matrix window.

4. Simultaneously press the Ctrl  and Esc  keys to transfer to the Director
Console’s OS/2 desktop.  The Window List appears.

5. Double-click the Desktop-Icon View selection.  The Director Console’s OS/2
desktop appears.

6. Insert a data collection diskette into drive A:  of the Director Console in
accordance with one of the following steps:

– If you are removing and replacing a FRU in the 9032-003 or 9033-004
ESCON Director, use the data collection diskette shipped with the
replacement FRU.  The diskette is labeled Data Collection Diskette.

– If you are removing and replacing a FRU in the 9032-005 ESCON
Director or collecting data for another purpose (such as fault isolating
problems), use a data collection diskette shipped with the Director.  The
diskette is labeled Data Collection Utility Version XX.YY.ZZ, where
XX.YY.ZZ is the Licensed Internal Code (LIC) version number.

– If a labeled data collection diskette is not available, a blank, DOS-
formatted diskette may be used.

7. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.
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8. Double-click the ESCON Director Data Collection icon.  The first ESCON
Director Data Collection window appears

9. Type Y and press the Enter  key.  The second ESCON Director Data
Collection window appears.

10. Type the Director name (recorded in step 3 of this procedure) and press the
Enter  key.  Messages appear in the window showing files transferring from
the fixed disk to diskette.  The data collection process is complete when the
Enter prompt appears.
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11. Press the Enter  key.  The ESCON Director Data Collection window closes.

12. Double-click the upper left corner of the ESCON Director Tools - Icon View
to close the view and return to the OS/2 desktop.

13. Remove the data collection diskette from drive A:  of the Director Console.
Record the following information on the diskette label.

– Director serial number.

– Quality Service Activity Reporting (QSAR) number.

– Problem Management - Hardware (PMH) number.

– Current date.

14. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.

15. At the OS/2 desktop, open the Director Console application by double-
clicking the Director Console icon.  The Console application opens to the
window closed in step 4 of this procedure.

Sysplex Timer Data Collection
The data collection procedure transfers maintenance information from the Timer to
a 3.5-inch diskette.  The diskette is mailed to the OEM for problem analysis and
resolution.

1. At the Sysplex Timer Network Console window, simultaneously press the Ctrl
and Esc  keys to transfer to the Timer Console’s OS/2 desktop.  The Window
List appears.

2. Double-click the Desktop-Icon View selection.  The Timer Console’s OS/2
desktop appears.

3. At the OS/2 desktop, double-click the Sysplex Timer Tools folder.  The
Sysplex Timer Tools - Icon View appears.
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4. Double-click the Sysplex Timer Data Collection icon.  The Sysplex Timer
Data Collection window appears.

5. Insert a data collection diskette into drive A:  of the Timer Console.  The
diskette is labeled Data Collection Diskette.  If a labeled data collection
diskette is not available, a blank, DOS-formatted diskette may be used.

6. Press the Enter  key.  Messages appear in the window showing files
transferring from fixed disk to diskette.  The data collection process is
complete when the Enter prompt appears.

7. Press the Enter  key.  The Sysplex Timer Data Collection window closes.

8. Double-click the upper left corner of the Sysplex Timer Tools - Icon View to
close the view and return to the OS/2 desktop.

9. Remove the data collection diskette from drive A:  of the Timer Console.
Record the following information on the diskette label.

– Timer serial number.

– QSAR number.

– PMH number.

– Current date.

10. Insert the data collection diskette in the pre-addressed envelope provided
and mail the envelope to the OEM.
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11. At the OS/2 desktop, open the Sysplex Timer Console application by double-
clicking the Sysplex Timer Console icon.  The Console application opens to
the window closed in step 1 of this procedure.

Clear the Address Resolution Protocol Table
This procedure clears the ARP table for a LAN with a Director or Timer installed.
The procedure clears old Internet Protocol (IP) or Media Access Control (MAC)
addresses so the ARP table can rebuild with new addresses.  The procedure
prevents new Console, Director, or Timer addresses from conflicting with old,
unused addresses.  Clear the ARP table if:

• The IP or MAC address of a Director, Director Console, Timer, or Timer
Console was changed after operating previously on the LAN.

• The Director, Director Console, Timer, or Timer Console are installed on a
public (nondedicated) LAN.

To clear the ARP table:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the TCP/IP Cnfg. drawer to open the drawer.

3. Click the ARP button to clear the table. The ARP window appears briefly and
closes, indicating all the IP and MAC addresses cleared by the procedure.

4. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

5. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.
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Migrate Director Definitions
If the Director Console application is uninstalled at a Console (Director, Sysplex
Timer, Hardware Management, or other nondedicated Console) and installed on a
new Console, Director definitions must be recorded on a 3.5-inch diskette and
migrated to the new Console.  Definitions include IP addresses, Director names,
model numbers, and matrix configuration files.

If the Console application is discontinued and installed on a another Director
Console, a Director definitions diskette must be created. Refer to "Create Director
Definitions Diskette" below for instructions.  If the Console application is installed
on a new Director Console, Director definitions must be migrated. For instructions,
refer to "Migrate Definitions to a Director Console" on page 294.

Create Director Definitions Diskette
Perform this procedure to create a Director definitions diskette.

1. Ensure the Director Console application is closed, not just reduced to an
icon.  If the Console application is open (Startup or Matrix window appears),
continue to step a.  If the OS/2 desktop appears, go to step b.

Note: OS/2 screens may look slightly different depending on the level of
operating system installed on the Director Console.

a. At the Startup or Matrix window, select the Close Window option from
the File menu.  The Director Console application closes and the OS/2
desktop appears.  Go to step 2.

b. At the OS/2 desktop, simultaneously press the Ctrl  and Esc  keys.  The
Window List  appears.

• If the Director Console - Director Console selection does not appear,
the Console application is closed. Double-click the Desktop - Icon
View selection to return to the OS/2 desktop, and go to step 2.

• If the Director Console - Director Console selection appears , the
Console application is open and minimized. Double-click the
selection to maximize the application.  At the Startup or Matrix
window, select the Close Window option from the File menu.  The
Console application closes and the OS/2 desktop appears.
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2. Insert the Console application diskette (labeled Console Version XX.YY.ZZ)
into drive A:  of the Director Console.

3. Double-click the OS/2 System icon.  The OS/2 System - Icon View appears.

4. Double-click the Drives icon.  The Drives - Icon View appears.

5. Double-click the Drive A icon.  The Drive A - Icon View appears.

6. Double-click the DCGETDEF.CMD icon.  The DCGETDEF.CMD window
appears.

7. Remove the Console application diskette from drive A:  of the Director
Console and insert a blank, DOS-formatted diskette (provided with the
Director).

8. Press the Enter  key.  Director definitions are copied to the diskette, and the
copy progress is displayed in the DCGETDEF.CMD window.  When the
process is complete, the DCGETDEF.CMD window closes.

9. Double-click the upper left corner of the Drive A - Icon View, Drives - Icon
View, and OS/2 System - Icon View to close the views and return to the OS/2
desktop.
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10. Remove the Director definitions diskette from drive A:  of the Director
Console.

11. Label and store the Director definitions diskette as appropriate. The diskette
can now be used to transport definitions to a new Console.

Migrate Definitions to a Director Console
Perform this procedure to migrate Director definitions to a Director Console.

Note: This procedure does not work if the Director Console application is open or
if the Director Console library already contains definitions.

1. If the Director Console application is open, select the Exit option from the File
menu.  The following dialog box appears.

2. Click the OK button to close the dialog box.  The OS/2 desktop appears.

3. At the OS/2 desktop, double-click the ESCON Director Tools folder.  The
ESCON Director Tools - Icon View appears.

4. Double-click the Put Director Definitions Director Console Migration icon.
The Put Director Definitions Director Console Migration window appears.
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Note: If a warning appears indicating migration was terminated because
Director definitions exist in the Console library, press the Enter key to
close the Put Director Definitions Director Console Migration window
and exit the utility.

If a warning appears indicating migration was terminated because
the Console library was not initialized, press the Enter  key to close
the Put Director Definitions Director Console Migration window and
exit the migration utility.  Open and close the Director Console
application, then perform this procedure again.

5. Insert the Director definitions diskette (created at the Console from which the
definitions are migrated) into drive A:  of the Console.

6. Press the Enter key. Director definitions are copied to the Console fixed disk
for initializing the Director Console library. When the process is complete, the
Put Director Definitions Director Console Migration window closes.

7. Double-click the upper left corner of the ESCON Director Tools - Icon View to
close the view and return to the OS/2 desktop.

8. Remove the Director definitions diskette from drive A:  of the Console.  Store
the Director definitions diskette as appropriate.

9. At the OS/2 desktop, start the Director Console application by double-clicking
the Director Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

Change Token Ring Adapter Card Data Rate
Perform this procedure to change the data rate of the Token Ring adapter card for
the Director or Sysplex Timer Console. The procedure changes the default rate of
16 megabits per second (Mbps) to 4 Mbps.  Perform the procedure using the LAN
Adapter Installation and Diagnostics (LANAID) application from a native DOS (not
DOS or OS/2) window.
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Note: The data rate is set at the factory.  Do not change the data rate unless
required because of LAN or other system requirements.

To change the Token Ring adapter card data rate:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. Insert the LANAID Boot Diskette into drive A:  of the Console PC.
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3. At the OS/2 desktop, click the Shutdown button at the bottom of the launch
pad. A dialog box appears, asking if you want to close the application without
saving data.

4. Click the OK button.  A Shutdown Has Completed message box appears,
explaining it is now safe to turn off the computer or restart.

5. Simultaneously press the Ctrl , Alt , and Del keys to restart the Console PC
from the LANAID Boot Diskette.  The PC performs power-on self-tests
(POSTs). Upon completion, the PC DOS 7.0 Startup Menu appears with the
first menu option highlighted.

6. Press the Enter  key with the first option highlighted.  The following warning
and note appear.

7. Ignore the warning and note and press the Enter  key.  A LANAIDC >
prompt appears.

8. At the LANAIDC >  prompt, type /view  to view the Token Ring LAN
settings, and press the Enter  key.  After a few seconds, the IBM Turbo
16/4 Token-Ring ISA Adapter menu appears.

PC DOS 7.0 Startup Menu
=======================

1. IBM Auto/Turbo ISA Configuration using LANAIDC
2. IBM Auto/Turbo ISA Extended Diagnostics

Enter a choice: 1

------------------------------------------------------------
WARNING:To best avoid conflicts you should boot your system

as you normally do before running LANAIDC.

Running LANAIDC after booting from Disk1 will work,
but conflict checking will not be as effective.

------------------------------------------------------------
------------------------------------------------------------
NOTE: To run the graphical version of the LANAID

configuration program for the IBM Auto/Turbo ISA
adapter, you need to boot your system normally and
then install LANAID from the diskette by typing
A:\install at your normal system prompt.

------------------------------------------------------------
Hit any key to continue with LANAIDC from diskette or remove
diskette and reboot system normally ...
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9. At the LANAIDC >  prompt, type /rs=4  to change the Token Ring data rate
from 16 Mbps to 4 Mbps, and press the Enter  key.  After a few seconds, the
menu reappears with the change implemented. Do not change any of the
other Token Ring LAN settings.

10. Remove the LANAID Boot Diskette from drive A:  of the Console PC and
store in a safe location.

11. Simultaneously press the Ctrl , Alt , and Del keys to restart the Console PC
from the fixed disk (OS/2). The PC performs POSTs and loads the operating
system.  Upon completion, the OS/2 desktop appears.

12. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

      IBM Turbo 16/4 Token-Ring ISA Adapter

PnP Support: BIOS
Adapter Number: 1
Adapter MAC Address: 00 06 29 6B 1A 3D
MicroCode Level: 000400 P3F3A4
Serial Number: IBM1080 - 296B1A3D
Adapter Mode: ENHANCED
Configuration: LEGACY
Adapter State: Active
I/O Address: 320 - 323
Interrupt: 10
ROM Address: C8000 - C9FFF
Remote IPL: Disabled
Token-Ring Data Rate: 16
Auto-Sense Data Rate: Disabled
Adapter Bus Width: 16

LANAIDC >
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Create Console Diagnostic Diskettes
Perform this procedure to create diagnostic diskettes for the Console PC.  Keep
the diskettes with the Console, and use them under direction from the next level of
support to fault isolate problems with the PC.  To create the diagnostic diskettes:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Insert a blank, formatted diskette (labeled For Use By Service Personnel
Only  and shipped with the Console) into the diskette drive.

3. Click the arrow on the Drive A drawer to open the drawer.
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4. Click the Build Diag. Disk button.  The Build Diag. Disk window appears.

5. Press the Y key to continue. A message appears at the bottom of the window
showing the percentage of files written to the diskette.

6. When the percentage reaches 100, remove the diskette, insert a second
diskette as prompted, and press the Enter  key.  Label the first diskette
Reference Diskette.
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7. The Build Diag. Disk window appears again.  Press the Y key to continue.
A message appears at the bottom of the window showing the percentage of
files written to the diskette.

8. When the percentage reaches 100 again, the second diagnostic diskette is
created and the OS/2 desktop reappears.  Remove the diskette from the
drive.  Label the second diskette SCSI Diagnostic.

9. Close the Drive A drawer by clicking the drawer arrow.

10. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

11. Keep the diskettes with the Console and use them under direction from the
next level of support to fault isolate PC problems.

Backup and Restore Functions
The Model PC 300PL Console contains a rewriteable optical cartridge (ROC) drive
to perform backup and restore functions. Backups of the Director or Sysplex Timer
system libraries are routinely performed. Library data is restored using a ROC with
the most recent backup version of the Director or Timer system library.  The entire
Console fixed disk is restored using:

• A 3.5-inch Director or Sysplex Timer Console application diskette.

• A 3.5-inch Console restore diskette.

• A Console restore CD-ROM.

• A ROC that contains the most recent backup version of the Director or Timer
system library.

This section describes:

• Backing up the Director or Sysplex Timer system library to ROC.

• Restoring the Director or Sysplex Timer system library from ROC.

• Restoring the Console fixed disk from CD-ROM and ROC.
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Back Up the System Library to ROC
Routine backups of the Director or Sysplex Timer system library to a ROC ensure
critical data can be restored if required.  The data is also required when migrating
the Director Console application to a backup or replacement Console.

Critical data for the Director Console includes Console settings, LIC files, logs, IP
addresses, Director configuration files, and Director matrices.  Critical data for the
Sysplex Timer Console includes Console settings, IP addresses, configuration
files, logs, and identification information for the Timer network.

This section describes procedures to enable automatic back up of the system
library to ROC at the default time, change backup settings. or back up the system
library on demand.

Enable Automatic Backup at Default Time
If enabled, the operating system automatically backs up the system library to a
ROC at a specified or default time.  Perform this procedure to enable automatic
backup of the system library at the default backup time (daily at 12:00 midnight).

This procedure applies to a dedicated Console PC running the Director Console
application or Sysplex Timer Console application (or both).  If either or both
applications are running on a Hardware Management Console, refer to Chapter 3
for system library backup procedures.   To enable the automatic backup feature
using the default setting of 12:00 midnight:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.
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– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the Backup drawer to open the drawer.

3. Click the Set Default button on the Backup drawer.  The Set Default dialog
box appears.
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4. Type Y and press the Enter  Key.  The Director or Sysplex Timer Console
system library automatically backs up every day at midnight.

5. Click the arrow on the Backup drawer to close the drawer.

6. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

7. Ensure a blank optical cartridge is installed in the Console ROC drive when
the automatic backup feature is enabled.  The backup ROC is provided with
the Console.

Change Backup Settings
Perform this procedure to change backup settings from the default values.  To
change the backup settings:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the Backup drawer to open the drawer.

3. Click the Modify Schedule button on the Backup drawer.  The Timer Control
Center dialog box appears.  The command line (script) shown at the top of
the screen automatically runs a program using the default backup setting.
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Note: The term Timer in the Timer Control Center dialog box does not refer
to the Sysplex Timer.

4. Click the script name to select it.  The settings associated with the script dis-
play at the lower part of the screen. To change the settings, perform one of
the following:

– Select an item in the Mode column.  All required parameters are
completed for the selection.

– Change parameters by scrolling up or down a column (Hour, Minute, etc.)
or by typing the desired value at the top of the column.  An asterisk (*)
indicates backup periodically by that parameter.

5. When the parameters are set correctly, click the Save button to save changes
to the script.

6. Click the OK button to enable the changes and return to the OS/2 desktop.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.
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Backup on Demand
Perform this procedure to back up the Director or Sysplex Timer system library
on demand.  This procedure applies to a dedicated Console PC running the
Director Console application or Sysplex Timer Console application (or both).  If
either or both applications are running on a Hardware Management Console, refer
to Chapter 3 for system library backup procedures.  To back up the system library
to ROC on demand:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Click the arrow on the Backup drawer to open the drawer.
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3. Click the Backup button on the Backup drawer.  The Backup dialog box
appears.

4. Insert a blank cartridge (or a cartridge with data that can be overwritten)
in the ROC drive of the Console PC, then press the Enter key.  Process
messages display until the backup is complete.

5. Remove the cartridge from the ROC drive, label the cartridge, and store it in
a safe, secure location.
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Note: Ensure a new blank cartridge is inserted in the ROC drive if the
automatic backup feature is enabled.

6. Click the arrow on the Backup drawer to close the drawer.

7. At the OS/2 desktop, perform one of the following steps to open the Director
Console or Sysplex Timer Console application.

– To open the Director Console application, double-click the Director
Console icon.  The Console application opens to the window closed in
step 1 of this procedure.

– To open the Sysplex Timer Console application, double-click the Sysplex
Timer Console icon.  The Console application opens to the window
closed in step 1 of this procedure.

Restore the System Library from ROC
Perform this procedure to restore the Director or Sysplex Timer system library from
a backup ROC to the Console fixed disk.  To restore the system library:

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.
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Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. Click the arrow on the Backup drawer to open the drawer.

3. Click the Restore button on the Backup drawer.  The Restore dialog box
appears.
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4. Insert a backup cartridge in the ROC drive of the Console PC, then press
the Enter key.  The OS/2 desktop reappears when the restore operation is
finished.

Note: Ensure the correct cartridge is inserted in the ROC drive.

5. Remove the backup cartridge from the ROC drive and store it in a safe,
secure location.

Note: Ensure a new blank cartridge is inserted in the ROC drive if the
automatic backup feature is enabled.

6. Click the arrow on the Backup drawer to close the drawer.

7. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational. It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational. The Console application should remain active
and operational for the following reasons:

a. Certain Timer events and associated reason codes are transmitted
only to the Event log maintained at the Timer Console.  The events
are not transmitted through attached processors to the System
Control Program (SCP) Console.  If the Console application is
closed and a Timer network failure occurs, reason codes and other
information required for fault isolation may not be recorded.
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b. Closing the Console application causes an ETR Service is
Requested message to be reported to the SCP Console with reason
code 40 (communication lost with active Console) or reason code 41
(communication lost with standby Console).  This may result in an
unnecessary service call.

c. Starting the Console application causes an ETR Service is
Requested  message to be reported to the SCP Console, with
reason code 8 (communication established with active Console) or
reason code 9 (communication established with standby Console).
This may result in an unnecessary service call.

Restore the Console Fixed Disk from CD-ROM and ROC
Perform this procedure to format and restore the Console fixed disk from CD-ROM
and a backup ROC.  Use the instructions after installing a new unformatted fixed
disk.  This procedure applies to a dedicated Console PC running the Director
Console application or Sysplex Timer Console application (or both).  Default
parameters when the fixed disk is restored are listed in Table 7.

Table 7. Default Parameters for Console Support Software (ROC Restore)

To reformat and restore the Console fixed disk from CD-ROM and a backup ROC:

1. Obtain the following (XX.YY.ZZ indicates the software version, release, and
patch numbers):

– The 3.5-inch Console application diskette labeled Console Version
XX.YY.ZZ (shipped with the Director or Sysplex Timer).

Feature Default Parameters

Set Time and Date Time and date for manufacturing location

Change Time and Date Format Time:  12-hour clock
Date:  Month-Day-Year

Console Screen Lock Disabled

Keyboard Layout United States

IP Address 1.1.1.1

MAC Address Set on adapter card

Subnet Mask 255.0.0.0

Automatic Backup Disabled

Default Printer Generic/Text Only on LPT1
Generic/Text to File
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– The 3.5-inch Console restore diskette labeled Base Console Restore
Version XX.YY.ZZ (shipped with the Director or Sysplex Timer).

– The Console restore CD-ROM labeled Base Console Restore Version
XX.YY.ZZ (shipped with the Director or Sysplex Timer).

– The rewriteable optical cartridge (ROC) that contains the most recent
backup version of the system library.

2. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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3. At the OS/2 desktop, click the Shutdown button at the bottom of the launch
pad. A dialog box appears, asking if you want to close the application without
saving data.

4. Click the OK button.  A Shutdown Has Completed message box appears,
explaining it is now safe to turn off the computer or restart.

5. Power off the Console PC.

6. Insert the Base Console Restore Version XX.YY.ZZ diskette in the diskette
drive (ensure the diskette is write enabled).  Power on the Console PC.

7. The IBM OS/2 logo screen appears, followed by a series of installation and
load messages.

Ignore all messages until the following message appears:

8. Press the F1 key to continue the process.  The fixed disk is formatted and
partitioned in preparation for insertion of the Console restore CD-ROM. This
process takes approximately 10 minutes.

When the system is ready the following message appears:

9. At the preceding prompt, insert the CD-ROM labeled Base Console Restore
Version XX.YY.ZZ in the CD-ROM drive and press the Enter  key.  The
process of installing the files from the CD-ROM to the Console fixed disk
takes approximately 10 minutes.

Base Console Hard Disk Restore

The procedure will load your Console hard disk
from the Base Console Restore CD-ROM

WARNING: Continuing this process will result in
the destruction of information currently on your
hard disk.

Press F1 to continue with the RESTORE process.
Press ESC to EXIT the program.

Install the Base Console Restore CD-ROM

To continue press any key.
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When the installation is complete the following message appears:

10. Remove the Console restore diskette and CD-ROM from their respective
drives.  Simultaneously press the Ctrl , Alt , and Del keys to reboot the
Console PC.

11. If required, change the default IP address.  For instructions, refer to “Token
Ring Adapter IP Address and Subnet Mask” on page 334 and return here.

12. Install the Director or Sysplex Timer Console application using the application
diskette labeled Console Version XX.YY.ZZ. For instructions, refer to Chapter
6 of the appropriate maintenance information manual listed below:

– Maintenance Information for the 9032 Model 3 Enterprise Systems
Connection Director (SY27-3601).

– Maintenance Information for the 9033 Model 4 Enterprise Systems
Connection Director (SY27-2638).

– Maintenance Information for the 9032 Model 5 Director (SY28-1158).

– Maintenance Information for the 9037 Model 2 Sysplex Timer
(SY27-2641).

13. Restore the system library using the backup ROC.  For instructions, refer to
“Restore the System Library from ROC” on page 309.

Customize the Console Operating Environment
This section describes procedures to change ESCON Director or Sysplex Timer
Console operating parameters from default values listed in Table 8.   If you restore
the Model PC 300PL Console’s fixed disk, all the parameters (including the IP
address of the Console) are reset to default values.

Note: Do not enable the screen saver or automatic lockup function (password
protection) through the OS/2 desktop Settings option.  Enable the screen
saver using instructions in this section.

Base Console restore is complete.
Remove the diskette and the CD-ROM and reboot
the PC.
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Table 8. Procedures and Default Parameters for Console Operating Environment

Set Date and Time
This procedure sets the date and time for the Console PC’s operating environment.
Although the date and time are set, the parameters may require change for an
installation location. Use this procedure to display or change the Console date and
time or synchronize the Console date and time with a Sysplex Timer network.

In the Director Console application, Console Audit Log and Console Error Log
events are time stamped with the PC date and time. All other date and time entries
in the application are time stamped with parameters derived from the Director.

In the Sysplex Timer Console application, Console Audit Log events are time
stamped with the PC date and time.  All other date and time entries in the
application are time stamped with Coordinated Universal Time (UTC) derived
from the Timer.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

Procedure Default Parameter Page

Set Date and Time Set to date and time for
manufacturing location

316

Change Date and Time Format Time:  12-hour clock
Date:  Month-Day-Year

319

Enable Screen Saver Disabled 323

Change Keyboard Layout and
Country Code Page

United States 326

Change IP Address 1.1.1.1 334

Change Subnet Mask 255.0.0.0 334

Change MAC Address Set on adapter card 338

Change Default Printer Generic/Text Only on LPT1
Generic/Text to File

343
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– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.
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3. Click the Set Date and Time button.  The System Clock - Properties dialog
box appears with the Date/Time page open.
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4. To adjust the Console time, click the up or down arrows by the Hours,
Minutes, and Seconds fields as required. Click the AM or PM radio button as
required.

5. To adjust the Console date, click the up or down arrows by the Month, Day,
and Year fields as required.

6. Close the System Clock - Properties dialog box by double-clicking the icon in
the upper left corner of the dialog box.

7. Close the OS/2 Window drawer by clicking the drawer arrow.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Date and Time Format
This procedure changes the time format between a 12-hour and 24-hour clock, and
the date format between a month-day-year, day-month-year, year-month-day, or
year-day-month format.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Click the System Setup option.  The System Setup - Icon View appears.
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4. Double-click the Country icon.  The Country - Properties dialog box appears
with the Country page open.

5. Perform one or both of the following to adjust the format:

– Click the Date tab to display the Date page.  Click the desired radio
button to select between Month-Day-Year, Day-Month-Year, Year-Month-
Day, or Year-Day-Month display formats.

– Click the Time tab to display the Time page.  Click the desired radio
button to select between 12 hours or 24 hours display formats.  If the 12
hours format is used, select between AM or PM display by scrolling
through the list box to the right of the radio button.
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6. Double-click the upper left corner of the Country - Properties dialog box to
close the dialog box.

7. Double-click the upper left corner of the System Setup - Icon View to close
the view.

8. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

9. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.
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– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Enable Screen Saver
Perform this procedure to enable the Win-OS/2 screen saver or modify screen
saver operation.  Do not enable the screen saver or automatic lockup (password
protection) function available through the OS/2 desktop Properties option.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.
Chapter 8. Model PC 300PL Console Procedures 323



3. Click the Program Manager button. The Program Manager window appears.

4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.
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5. Double-click the Desktop icon.  The Desktop dialog box appears.

6. Modify the screen saver function as required.  Enable the screen saver by
scrolling to a desired screen (other than None) in the Name field in the
Screen Saver section.  Set the time delay for the screen saver to enable by
scrolling to the desired time in the Delay field. The password function for the
Console is not required.  To enable the password function, select a screen
saver and the Setup button.  Click the Password check box, enter a
password, and click OK.

7. When finished, click the OK button on the Desktop dialog box.

8. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

9. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

10. Close the OS/2 Window drawer by clicking the drawer arrow.

11. Perform one of the following:
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– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

12. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Keyboard Layout and Country Code Page (International Users Only)
Perform this procedure to change the keyboard layout and country information.
This allows keyboards to be customized for international users (outside of the
United States). You must also change options for Win-OS/2 windows and the OS/2
operating system.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. Double-click the OS/2 System icon at the top of the OS/2 desktop. The OS/2
System - Icon View appears.

3. Double-click the System Setup icon. The System Setup - Icon View appears.

4. Double-click the Install/Remove icon.  The Install/Remove - Icon View
appears.
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5. Double-click the Selective Install icon.  A message box appears indicating
the installation program is initializing.  After a few seconds, the System
Configuration dialog box appears.

6. At the Locale area of the System Configuration dialog box, click the Country
icon.  The Country Information dialog box appears.

7. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.

8. At the Locale area of the System Configuration dialog box, click the Keyboard
icon.  The Keyboard dialog box appears.
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9. Click (select) the desired country name and click the OK button. The System
Configuration dialog box appears again.

10. Click the Next button. The System Configuration (cont’d) dialog box appears.
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11. Click the Next button.  The OS/2 Setup and Installation dialog box appears.

12. Click the Next button to continue.  The Source Directory dialog box appears.

13. Click the Install button.  A message box appears explaining that the OS/2
setup is completing the configuration change.  After a few seconds, a
message box appears telling you to shut down and restart the system.

14. Click the OK button.  The Install/Remove - Icon View appears again.

15. Double-click the upper left corner of the Install/Remove - Icon View, System
Setup - Icon View, and OS/2 System - Icon View to close the views and return
to the OS/2 desktop.
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16. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

17. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Change Win-OS/2 Keyboard Settings
Perform this procedure to change the keyboard layout for Win-OS/2 windows
and the OS/2 operating system.  This allows keyboards to be customized for
international users (outside of the United States).

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.
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– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.
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4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.

5. Double-click the International icon.  The International dialog box appears.

6. Click the arrow button for the Country field and select the desired country
from the drop-down list.
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7. Click the arrow button for the Language field and select the desired language
from the drop-down list.

8. Click the arrow button for the Default Keyboard field and select the desired
keyboard layout from the drop-down list.

9. Double-click the top left corner of the Control Panel and Program Manager
windows to close the windows.

10. When the Exit Win-OS/2 dialog box appears, click the OK button to exit
Win-OS/2, close the dialog box, and return to the OS/2 desktop.

11. Close the OS/2 Window drawer by clicking the drawer arrow.

12. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

13. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Token Ring Adapter IP Address and Subnet Mask
The default IP address for the Console Token Ring adapter card is 1.1.1.1, and the
default subnet mask is 255.0.0.0. If you wish to change either or both these values,
obtain a unique Console IP address or subnet mask from the LAN administrator.

The IP address must be in the form nnn.nnn.nnn.nnn, where nnn is a decimal byte
in the range 0 through 255.  The IP address may not be all zeros or all 255s.
Change default IP address and subnet mask values if:

• The Console is not on an isolated Token Ring LAN.

• There is more than one Console on the Token Ring LAN.
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• The subnet mask does not conform to the network to which the Console is
connected.

• The IP address conflicts with the address of another device on the ring or
does not conform to the LAN addressing scheme.

• The IP address does not conform to the LAN addressing scheme.

Perform the following procedure to display and change the Director or Sysplex
Timer Console’s IP address and subnet mask.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.
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2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.

3. Click the TCP/IP Cnfg. button.  The TCP/IP Configuration notebook appears
with the Network page open.
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4. To change the IP address, click in the IP Address field.  Type the new IP
address as necessary. Move within the field by using the left and right arrow
keys (← and →).  Use the Backspace  key to delete characters.

5. To change the subnet mask, click in the Subnet Mask field.  Type the new
subnet mask as necessary.  Move within the field by using the left and right
arrow keys (← and →).  Use the Backspace  key to delete characters.

6. Close the TCP/IP Configuration notebook by double-clicking the upper left
corner of the notebook.  The Closing TCP/IP Configuration dialog box
appears.

7. Click the Save button.  The OS/2 desktop appears.

8. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

9. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

10. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Token Ring Adapter MAC Address
Change the Console Token Ring adapter’s Media Access Control (MAC) address if
the address does not conform to the locally-administered LAN addressing scheme.
Perform the following procedure to display and change the Director or Sysplex
Timer Console’s MAC address.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to close the application.

– If the Director Console application is open, select the Exit option from the
File menu.  The following dialog box appears.

Click the OK button to close the dialog box. The OS/2 desktop appears.
The Director continues to operate normally after exiting the Console
application.

– If the Sysplex Timer Console application is open, select the Exit option
from the File menu.  The following dialog box appears.

Click the Exit button to close the dialog box. The OS/2 desktop appears.
The Timer network continues to operate normally after exiting the
Console application.

2. At the OS/2 desktop, click the TCP/IP Cnfg. drawer arrow on the launch pad
to open the drawer.
338        Console Installation and User’s Guide



3. Click the MPTS button.  An IBM logo dialog box appears briefly, then the
Multi-Protocol Transport Services dialog box appears.

4. Click the Configure button.  The Configure dialog box appears.
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5. Ensure the LAN adapters and protocols radio button is selected and click the
Configure button.  The Adapter and Protocol Configuration dialog box
appears.

6. Use the scrolling arrows to scroll through the Current Configuration list box.
Click (select) the IBM T-R Shared RAM Family. . selection.

7. Click the Edit button. The Parameters for IBM T-R Shared RAM Family dialog
box appears containing parameters for the Token Ring adapter.
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The current MAC address appears in the Network adapter address field if a
user has previously configured the MAC address.  Otherwise the field is
blank.

8. To change the MAC address, click in the Network adapter address field.
Type the new MAC address as necessary.  Move within the field by using
the left and right arrow keys (← and →).  Use the Backspace  key to delete
characters.

9. Click the OK button.  The Adapter and Protocol Configuration dialog box
reappears.

10. Click the OK button.  The Configure dialog box reappears.

11. Click the Close button to save the changes. The Multi-Protocol Transport
Services dialog box reappears.

12. Click the Exit button. The Update CONFIG.SYS dialog box appears. Ensure
a C appears in the Drives to update field.
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13. Click the Exit button. A CONFIG.SYS Updated dialog box appears explaining
the CONFIG.SYS file was successfully updated.

14. Click the OK button.  The Exiting MPTS dialog box appears.

15. Click the Exit button to return to the OS/2 desktop.

16. Close the TCP/IP Cnfg. drawer by clicking the drawer arrow.

17. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.
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18. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.

Set or Change Default Printer
Perform the following procedure to set or change the default printer for the Director
or Sysplex Timer Console.

1. If the Director or Sysplex Timer Console application is open, perform one of
the following steps to transfer to the OS/2 desktop.

– If the Director Console application is open, press the Ctrl  and Esc  keys
from the Startup window or any active matrix window.  The Window List
appears.

Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

– If the Sysplex Timer Console application is open, press the Ctrl and Esc
keys from the Startup or Sysplex Timer Network Console window.  The
Window List appears.
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Double-click the Desktop-Icon View selection.  The OS/2 desktop
appears.

2. At the OS/2 desktop, click the OS/2 Window drawer arrow on the launch pad
to open the drawer.

3. Click the Program Manager button. The Program Manager window appears.

4. At the Win-OS/2 Main window, double-click the Control Panel icon.  The
Control Panel window appears.
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5. Double-click the Printers icon.  The Printers dialog box appears.

6. Click (select) a driver displayed in the Installed Printers field and click the Set
as Default Printer button.

7. To add a driver not listed in the Installed Printers field, perform the following:

a. Click the Add button. The Printers dialog box reappears with a list of
available printers.
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b. Scroll through the list of printers and select the desired printer.

c. Click the Install button to display the Install Driver dialog box.

d. Type C:\prtdrvs  and click the OK button.  The driver loads and
appears under the list of installed printers in the Printers dialog box.

8. Close all open windows by double-clicking the upper left corner of each
window.  When the Exit Win-OS/2 dialog box appears, click the OK button
to exit Win-OS/2, close the dialog box, and return to the OS/2 desktop.

9. Close the OS/2 Window drawer by clicking the drawer arrow.

10. Perform one of the following:

– If this is the final procedure performed to customize the operating
environment, shut down and restart the Console.  For instructions, refer
to “Shut Down and Restart the OS/2 Operating System and Console” on
page 26.

– If you are performing other customization tasks (refer to Table 8 on
page 316), perform the tasks and shut down and restart the Console.
For instructions, refer to “Shut Down and Restart the OS/2 Operating
System and Console” on page 26.

11. At the OS/2 desktop, perform one of the following steps to start the Director
Console or Sysplex Timer Console application.

– To start the Director Console application, double-click the Director
Console icon.  The Startup window appears when the Console
application is operational.  It may take up to 30 seconds for the Console
application to open.

– To start the Sysplex Timer Console application, double-click the Timer
Console icon.  The Startup window appears when the Console
application is operational.
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Glossary

This glossary includes terms and definitions
from:

• The IBM Dictionary of Computing
(ZC20-1699).

• The American National Standard
Dictionary for Information Systems
(ANSI X3.172-1990), copyright 1990 by
the American National Standards Insti-
tute (ANSI).  Copies can be purchased
from the American National Standards
Institute,1430 Broadway, New York, New
York 10018. Definitions from this text are
identified by the symbol (A).

• ANSI/EIA Standard - 440A: Fiber Optic
Terminology, copyright 1989 by the
Electronic Industries Association (EIA).
Copies can be purchased from the
Electronic Industries Association, 2001
Pennsylvania Avenue N.W., Washington,
D.C. 20006. Definitions from this text are
identified by the symbol (E).

• The Information Technology Vocabulary,
developed by Subcommittee 1 (SC1),
Joint Technical Committee 1 (JTC1), of
the International Organization for Stan-
dardization (ISO) and the International
Electrotechnical Commission (IEC).
Definitions of published parts of this
vocabulary are identified by the symbol
(I).  Definitions taken from draft interna-
tional standards, committee drafts, and
working papers developed by ISO/IEC
SC1/JTC1 are identified by the symbol
(T), indicating that final agreement has
not been reached among the participat-
ing national bodies of SC1.

The following cross references are used in
this glossary:

Contrast with  - Refers to a term with an
opposite or substantively different
meaning.

See - Refers the reader to multiple-word
terms in which this term appears.

See also  - Refers the reader to terms with
a related, but not synonymous, meaning.

Synonym for  - Indicates the term has the
same meaning as a preferred term
defined in the glossary.
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A

ac. See alternating current.  Contrast with
dc.

accelerator. A short-cut keystroke method to
perform a menu operation.  Menu options
may have accelerator keys listed to the right
of the menu option.  Use the accelerator to
perform the menu option’s function when no
menu is selected for the window.

active configuration.   In an ESCON or
FICON environment, the Director configura-
tion that is determined by the status of the
connectivity attributes.  Contrast with saved
configuration.

adapter.   (1) Hardware that provides
transitional functions between multiple
devices.  (2) In a fiber-optic environment, the
link hardware used to join different optical
fiber connector types.  Contrast with coupler.

address.  (1) To refer to a device or an item
of data by its address (I, A).  (2) The location
in a computer where data is stored.  (3) In
data communication, the unique code
assigned to each device or workstation
connected to a network.  (4) The identifier of
a location, source, or destination.

address name.  See port name.

address resolution protocol (ARP). The
protocol by which a host computer maintains
a cache of address translations, allowing the
physical address of the computer to be
derived from the Internet address.

administrative password authorization.
The level-one password authorization that
allows access to a Director to perform
administrative, maintenance, and operator
functions.  Contrast with maintenance
password authorization and operator
password authorization.

allowed connection.   In a Director, the
attribute that when set, establishes dynamic
connectivity capability.  Contrast with
prohibited connection.

alternating current (ac).  Electric current
that reverses direction at regular sinusoidal
intervals.  Contrast with direct current.

American National Standard Code for
Information Interchange (ASCII).   A stan-
dard character set consisting of 7-bit coded
characters (8-bit including parity check) used
for information exchange between systems
and equipment.

American National Standards Institute
(ANSI). A national organization consisting of
producers, consumers, and general interest
groups that establishes procedures by which
accredited organizations create and maintain
industry standards in the United States (A).

ANSI. See American National Standards
Institute.

AOC/MVS. See Automated Operations
Control for MVS.

application.   (1) The use to which a data
processing system is put, for example, a
payroll application, an airline reservation
application, or a network application.  (2) A
collection of software components used to
perform specific types of work on a computer.

application-specific integrated circuit
(ASIC).  A circuit designed for a specific
application or purpose, such as implementing
the lower-layer Fibre Channel protocol
(FC-0).  ASICs differ from general-purpose
devices such as memory chips or micropro-
cessors.

AR. IBM parts list acronym for As Required.
AR indicates the parts quantity is not the
same for all machines.

ARP. See address resolution protocol.
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ASCII. See American National Standard
Code for Information Interchange.

ASIC. See application-specific integrated
circuit.

attribute. The connection status of the
address on a configuration matrix; allowed,
blocked, dedicated, or prohibited.

Automated Operations Control for MVS
(AOC/MVS).  An IBM-licensed program that
automates routine processor management
tasks, including, shutdown, recovery, startup,
and initialization procedures, and automates
operator responses to messages. AOC/MVS
functions are now integrated into SA OS/390.

B

backup diskette.   A diskette that contains
duplicate information from an original
diskette.  The backup diskette is used in
case information on the original diskette is
unintentionally changed or destroyed.

bit. Acronym for binary digit, the smallest unit
of data in computing, with a value of zero or
one.  Abbreviated as lowercase b.

blocked.   In a Director, the attribute that
when set, removes the communication
capability of a specific port.  Contrast with
unblocked.

bridge.   (1) An attaching device that con-
nects two LAN segments to allow the transfer
of information from one LAN segment to the
other.  A bridge can connect the LAN
segments directly by network adapters and
software in a single device, or can connect
network adapters in two devices through
software and use of a telecommunication link
between the two adapters. (2) A functional
unit that connects two LANs that use the

same logical link control protocol, but may
use different media access control protocols
(T). Contrast with router.

British Thermal Unit (BTU). The quantity of
heat required to raise the temperature of one
pound of water by one degree Fahrenheit.

BTU.  See British Thermal Unit.

button.   On a graphical user interface, a vir-
tual display element (a rectangle containing
text) that is selected with an input device and
programmed to operate as a function key (T).

byte.   An 8-bit quantity that computers treat
as a single unit, often called an octet or word.
Abbreviated as uppercase B.  See also octet.

C

cascade. Windows on a console cascade to
show all open windows in a way that allows
any window to be viewed by clicking its title
(window is brought to the front).  Cascaded
windows are overlapped.  To cascade
windows, use the Window pull-down menu
and select Cascade.  Contrast with Tile.

CBY.  Acronym for channel operations run-
ning in byte mode (ESCON channel attached
to ESCON converter), and specifies the I/O
operation mode for the channel path under
the IOCP CHPID statement Type parameter.
Contrast with CVC.

CD-ROM.  See compact disk read-only
memory.

cell.   On the Director matrix window, a cell is
the intersection point between a horizontal
port address and a vertical port address.  A
selected cell is indicated by the cell cursor.
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cell cursor. A white square on the Director’s
matrix window indicating the selected
intersection cell.  Attribute modifications that
require two port addresses, such as prohibit
or dedicate, are performed on the cell.

chained. In an ESCON environment, means
that two Directors are physically attached.

channel. A system element that controls one
channel path, and whose mode of operation
depends on the type of hardware attached.
Each channel controls an I/O interface
between the channel control element and the
attached control units.

channel-attached.   (1) Pertaining to direct
attachment of devices by data I/O channels to
a computer. (2) Pertaining to devices
attached to a control unit by cables, not tele-
communication lines.

channel path (CHP).   A single interface
between a central processor and one or more
control units, along which signals and data is
sent to perform I/O requests.

channel path identifier (CHPID).   In a
channel subsystem, a value assigned to each
channel path of the system that uniquely
identifies the path.

channel subsystem (CSS).   A collection of
subchannels that direct the flow of informa-
tion between I/O devices and main storage,
relieve the processor of communication tasks,
and perform path management functions.

CHP.  See channel path.

CHPID.  See channel path identifier.

Class 3 Fibre Channel service. Class 3
service duplicates the functions of a packet-
switched network and allows multiple nodes
to share links by multiplexing transmitted
data.  Class 3 service does not acknowledge
data frame delivery.  Class 3 service is
supported by the 9032-005 Director.

CNC. Acronym for ESCON channel-attached
to ESCON-capable device, and specifies the
I/O operation mode for the channel path
under the IOCP CHPID statement Type
parameter.

column.   Vertical arrangement of data.
Contrast with row.

command.   (1) A character string from an
external source to a system that represents a
request for system action. (2) A request from
a terminal to perform an operation or execute
a program.  (3) A value sent through an I/O
interface from a channel to a control unit that
specifies the operation to be performed.

compact disk read-only memory (CD-
ROM).  High capacity read-only memory in
the form of an optically read disk.

component. (1) Hardware or software that is
part of a functional unit.  (2) A functional part
of an operating system; for example, the
scheduler or supervisor.

concurrent maintenance.   The ability to
perform maintenance tasks, such as the
removal and replacement of FRUs, while the
Director is operating.  In addition, fiber-optic
cables can be connected or disconnected
from ports while the Director is operating.
See also hot pluggable and nondisruptive
installation.

configuration matrix. A configuration matrix
defines a Director’s address configuration.
The three matrix types are new matrix, saved
matrix, and active matrix.  Synonym for matrix.

connectivity attribute.  The characteristic
that determines port status for the Director.
See allowed connection, dedicated connec-
tion, prohibited connection, blocked, and
unblocked.
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connectivity capability.   (1) The capability
that allows attachment of a device to a sys-
tem without requiring physical reconfiguration
of either the device or the interconnections.
(2) The Director capability that allows logical
manipulation of link connections to provide
physical device attachment.  See also
configuration matrix, connectivity control,
and dynamic connection.

connectivity control.   In a Director, the
method used to change port connectivity
attributes and determine the communication
capability of the link attached to the port.

connector.   See optical fiber connector.

Console.   The Director device used to per-
form administrative, maintenance, and opera-
tions tasks.  Synonym for display device or
terminal.

Console Audit log.   A log that tracks and
records Director Console operator activities,
including changing passwords, adding or
deleting LIC versions, adding or deleting
Director definitions, and entering or exiting
the application.  Each log entry contains a
description of the action, an action identifier,
and the date and time the action occurred.

Console Error log. A log of abnormal errors
that were encountered by the Director Con-
sole software during operations, but did not
cause Console failure.  For example, errors
caused by insufficient PC memory are
logged.

Console library.   An information database
for the Director, maintained by the Console
application.  The library is stored on the PC
platform running the Console application, and
contains logs, LIC versions, and saved
configurations.

Control Processor (CTP) card.   In the
Director, the circuit card that provides the
processor and associated logic.  The card
initializes hardware after power on.  While in
operation, the card supports the switch CUP,
maintenance port, and operator panel, and
supports port exception handling and error
recovery.  It also contains the fiber channel
controller for I/O requirements.

control program.   A computer program that
schedules and supervises execution of
programs in a computer system (I).

control unit.   Hardware that controls the
reading, writing, or display of data at one or
more I/O units.

Control Unit Port (CUP).   An internal
Director port (on the CTP card and labelled
FE) that communicates with channels to
report error conditions and link initialization.

converter.   In an ESCON environment, a
device that allows attachment of parallel
channel (bus and tag) I/O control units to
ESCON channels.

coupler. In a fiber-optic environment, the link
hardware used to join optical fiber connectors
of the same type.  Contrast with adapter.

CSS.  See channel subsystem.

CTC.  Acronym for an ESCON channel
attached to another ESCON channel (chan-
nel-to-channel), and specifies the I/O mode of
operation for the channel path under the
IOCP CHPID statement Type parameter.

CTP.  See Control Processor card.

CUP.  See Control Unit Port.

CVC.  Acronym for channel operations run-
ning in block mode (ESCON channel
attached to ESCON converter), and specifies
the I/O operation mode for the channel path
under the IOCP CHPID statement Type
parameter. Contrast with CBY.
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D

DASD.  See direct access storage device.

dB. See decibel.

dBm. Decibels referenced to one milliwatt.
Zero dBm equals one milliwatt, with a
logarithmic relationship as the value
increases.

dc. See direct current.  Contrast with ac.

DCAF. Acronym for IBM-licensed Distributed
Console Access Facility software. Through
DCAF, the Director Console is accessed and
controlled by a remote PC.

decibel (dB).   A standard unit used to
express gain or loss of optical power,
expressed as the ratio of input power to out-
put power on a logarithmic basis.

dedicated connection.  A connection
between two Director ports not affected by
information in the transmission frames.  The
connection restricts those ports from
communicating with any other port, and can
be established only as a result of actions
performed by a host control program or at the
Director Console. Contrast with dynamic
connection.

default.   Pertaining to an attribute, value, or
option assumed by a system when none is
specified (I).

destination.   A point or location, such as a
processor, Director, or Console, to which data
is transmitted.

device.   Mechanical, electrical, or electronic
hardware with a specific purpose.

device number.  In a channel subsystem,
four hexadecimal digits that uniquely identify
an I/O device.

device port (DVP) card.   The Director’s
hardware interface for ESCON fiber-optic
media. Each port card contains either LED or
XDF laser port interfaces. See also port card.

dialog box.   A pop-up window on a console
with information messages or fields to be
modified or completed with desired options.

diagnostics. (1) The process of investigating
the cause or nature of a problem in a product
or system.  (2) Modules or tests used by
computer users and service personnel to
diagnose hardware problems.

direct access storage device (DASD).   A
storage device that provides direct access to
data, and in which access time is indepen-
dent of data location.

direct current (dc).  Electric current that
continuously flows in one direction.  Contrast
with alternating current.

Director.   A device that provides dynamic
switching of fiber-optic connections between
ESCON channel paths and control units, and
FICON channel paths and ESCON control
units.  The Director also extends the
operational distance between processors
(ESCON or FICON) and ESCON control
units.

Director Audit log.   A log containing
summaries of actions taken by the Console
operator or the host-based software, record-
ing an audit trail of changes affecting the
Director.  For example, prohibiting or dedicat-
ing an address intersection is recorded (with
the date and time).

Director Event log.   A log of abnormal
hardware or software incidents that are
reported by the Director during operations.
For example, a CTP card failure is logged as
a hardware incident.  A corrupt configuration
file is logged as a software incident.
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Director LIN log.   A log of abnormal link
incidents reported by the Director during
operations. For example, a loss of synchroni-
zation condition or a bit error rate threshold
exceeded condition is reported as a link
incident.

disconnected.   In a Director, the attribute
that when set, disables a dedicated connec-
tion.  Contrast with connected.

diskette.   A thin magnetic disk enclosed in a
plastic jacket, which is removable from a
computer and is used to store and transport
data.

diskette drive. The hardware mechanism by
which a computer reads data from and writes
data to removable diskettes.

display device.   A computer peripheral that
presents information on a screen.  A syn-
onym for Console or terminal.

distribution panel.   In an ESCON environ-
ment, a panel that provides a central location
to attach trunk and jumper cables, and is
mounted in a rack, wiring closet, or on a wall.

DRAM. See dynamic random access
memory. See also RAM and contrast with
SRAM.

duplex. In data communication, pertaining to
transmission in which data is sent and
received at the same time.  Contrast with
half-duplex and simplex.

duplex connector.   An optical fiber
component that terminates jumper cable
fibers in one housing and provides physical
keying for attachment to a duplex receptacle.
See also Fibre Channel Standard connector,
multimode connector, and subscriber
connector.

duplex receptacle.   A fixed or stationary
optical fiber component that provides a keyed
attachment method for a duplex connector.

DVP card.   See device port card.

dynamic connection.   In a Director, a
connection between two ports established by
the Director that appears as one continuous
link when active. The duration of the connec-
tion depends on the protocol defined for the
frames transmitted and on the state of the
ports.  Contrast with dedicated connection.

dynamic connectivity.  The Director
capability that allows connections to be
enabled or disabled at any time.

dynamic random access memory (DRAM).
Random access memory that resides in a cell
comprised of a capacitor and transistor.
DRAM data deteriorates (i.e. is dynamic)
unless the capacitor is periodically recharged
by the controlling microprocessor.  DRAM is
slow, but relatively inexpensive.  See random
access memory and contrast with static
random access memory.

E

EAF. See enhanced availability feature.

EBCDIC.  See extended binary-coded deci-
mal interchange code.

EC. See engineering change.

EIA.  See Electronic Industries Association.
See also TIA.

electromagnetic interference (EMI). Refers
to undesirable electromagnetic emissions
generated by solar activity, lightning, and
electronic devices.  The emissions interfere
with or degrade the performance of another
electronic device.
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Electronic Industries Association (EIA).
The governing body that publishes
recommended standards for physical devices
and associated interfaces.  For example,
RS-232 is the EIA standard that defines
computer serial port connectivity.  See also
TIA.

electrostatic discharge (ESD).   The unde-
sirable discharge of static electricity that can
damage or degrade electronic circuitry.

ELP.  See establish logical path.

EMI.  See electromagnetic interference.

engineering change (EC).   A change to the
design, construction, or operation of a
hardware or software system that improves
the operation, reliability, or serviceability of
the system.  The EC process involves sub-
mission of a formal proposal that is reviewed
and authorized.  Implementation of an autho-
rized EC is carefully tracked and controlled.

Enhanced Availability Feature (EAF).
Enhanced availability features are backup
FRUs that are ordered and installed in the
Director to provide redundancy and reduce
disruption in case of failure.

Enterprise Systems Architecture (ESA). A
computer architecture introduced by IBM in
1988 as ESA/370.  The architecture added
access registers to improve virtual memory
management and increase storage from 2
gigabytes to 16 terabytes.  The architecture
was enhanced with the introduction of
ESA/390 in 1990.

Enterprise Systems Connection (ESCON).
An IBM architecture, technology, and set of
products and services introduced in 1990 that
provides a dynamically connected
environment using fiber-optic cables as the
data transmission medium.

erase. To remove electrically or magnetically
stored data, leaving the space where the data
was stored unoccupied.

EREP. Acronym for IBM’s Environmental
Record Editing and Printing software.
Through EREP, data contained in a system
recorder file is made available for mainte-
nance analysis.

error message.   An indication an error is
detected. See also information message and
warning message.

ESA.  See Enterprise Systems Architecture.

ESCON.  See Enterprise Systems
Connection.

ESCON channel.   A data communications
channel that uses ESCON technology with
fiber-optic cables as the transmission
medium, rather than copper bus and tag
cables. Contrast with FICON channel and
parallel channel.

ESCON Converter.   See converter.

ESCON Manager. An IBM-licensed program
that provides host control and intersystem
communication with the Director connectivity
operations.  ESCON Manager was discontin-
ued in 1998 and its functions are now
integrated into SA OS/390.

ESD.  See electrostatic discharge.

establish logical path (ELP) .  An ESCON
protocol command issued from host to
establish a connection between host and port
or between two ports on a Director.  The
command frame contains a destination and
source address.

event code.   A multi-digit code that displays
at the operator panel or Director Event log.
The code is used by maintenance personnel
to determine corrective actions to be taken.
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extended binary-coded decimal inter-
change code (EBCDIC).  A coded character
set comprised of 256 8-bit characters.

Extended Distance Feature (XDF).   A
means to extend the propagation distance of
a fiber-optic signal. Essentially a singlemode
laser ESCON port.

F

fabric.   A network of one or more switch
elements that can transmit, route, and receive
data using the Fibre Channel protocol.  A
fabric can support multiple, concurrent Fibre
Channel connections.

fabric port (F_port).  A port on a switch to
which N_ports are directly connected.
Contrast with node port.  See also thin fabric
port.

FC-0. The Fibre Channel layer that describes
the physical link between two ports, including
the transmission media, transmitter and
receiver circuitry, and interfaces.

FC-1. The Fibre Channel layer that describes
the IBM-patented 8B/10B transmission code
that provides DC balance in the transmitted
bit stream, separates control bytes from data
bytes (for simplification), and detects transmit
and receive errors.

FC-2.  The Fibre Channel layer that specifies
the signaling protocol, rules, and mecha-
nisms required to transfer data blocks.  The
FC-2 layer is very complex, and provides dif-
ferent classes of service, packetization,
sequencing, error detection, segmentation,
and reassembly of transmitted data.

FC-3.  The Fibre Channel layer that provides
a set of services common across multiple
N_ports of a Fibre Channel node.  The
services are not commonly used and are
essentially reserved for Fibre Channel
architecture expansion.

FC-4.  The Fibre Channel layer that provides
mapping of Fibre Channel capabilities to
upper level protocols, including IP and SCSI.

FC-PH.  See Fibre Channel Physical and
Signaling Interface.

FCS.  See Fibre Channel Standard.

FCS Connector.   See Fibre Channel Stan-
dard connector.

FCV. (1) Acronym for Fibre Channel Con-
verter port card, the Director’s hardware inter-
face for FICON fiber-optic media.  See also
port card.  (2) Acronym for FICON channel-
attached converted to ESCON-capable
device, and specifies the I/O operation mode
for the channel path (using an FCV port card)
under the IOCP CHPID statement Type
parameter.

feature.   A part of an IBM-licensed product
that may be ordered separately or as an
option by the customer.

fiber.   See optical fiber.

fiber-optic cable.   See optical cable.

fiber optics . The branch of optical technol-
ogy concerned with the transmission of radi-
ant power through fibers of transparent
materials such as glass, fused silica, or
plastic (E). Telecommunication applications of
fiber optics use optical fibers.  A single fiber
or a nonspatially aligned fiber bundle is used
for each information channel. Such fibers are
often called optical fibers to differentiate them
from fibers that are used in noncommunica-
tion applications.
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Fiber Transport Services (FTS). An IBM
service that provides installation of fiber-optic
cable trunk lines and strategically-located
distribution panels in a data center. Optically-
connected equipment can then be installed
with either short jumper cables, harnesses, or
factory-terminated trunk cables.

Fibre Channel Converter (FCV) port card.
The Director’s hardware interface for FICON
fiber-optic media.  See also port card.

Fibre Channel Standard (FCS). ANSI
standard that provides a common, efficient
data transport system that supports multiple
protocols.  The architecture integrates both
channel and network technologies, and
provides active, intelligent interconnection
among devices.  All data transmission is
isolated from the control protocol, allowing
use of point-to-point, arbitrated loop, or
switched fabric topologies to meet the needs
of an application.

Fibre Channel Standard (FCS) connector.
A connector that terminates fiber-optic jumper
cables in a pair of connected housings (one
transmit and one receive), and provides
physical keying for attachment to an SC
receptacle.  An FCS connector is synony-
mous with an SC connector.  An FCS
connector can attach to an FCV port card or
XDF Laser port card.  See also multimode
connector and subscriber connector.

Fibre Channel Physical and Signaling
Interface (FC-PH). The ANSI document that
specifies the FC-0 (physical signaling), FC-1
(data encoding), and FC-2 (frame construct)
layers of the Fibre Channel protocol.

Fibre Connection (FICON).   An IBM set of
products and services introduced in 1999 that
is based on the Fibre Channel Standard.
FICON technology uses fiber-optic cables
as the data transmission medium, and signifi-
cantly improves I/O performance (including

one Gbps bidirectional data transfer). FICON
is designed to coexist with ESCON channels,
and FICON-to-ESCON control unit
connections are supported.

FICON.  See Fibre Connection.

FICON channel.   A data communications
channel that uses FICON technology (rather
than ESCON technology) with fiber-optic
cables as the transmission medium. Contrast
with ESCON channel and parallel channel.

Field Replaceable Unit (FRU). An assembly
that is removed and replaced in its entirety
when any one of its components fails. A logic
card is an example of a FRU.

FLASH memory.  Reusable nonvolatile
memory that is organized as segments for
writing, and bytes or words for reading.
FLASH memory is faster than read-only
memory, but slower than random access
memory.

FLOGI.  Acronym for the fabric login
command.  The command establishes the
initial operating parameters and topology for
a fabric.  The command is accepted by an
F_port or thin F_port.

F_port.  See fabric port.  See also thin
F_port.

FRU.  See Field Replaceable Unit.

FTS.  See Fiber Transport Services.

G

GB.  See gigabyte.

Gbps.   Acronym for gigabits per second.

GHz.  See gigahertz.
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gigabyte (GB).   A unit of measure for data
storage, equal to 1,073,741, 824 bytes.
Generally approximated as one billion bytes.

gigahertz (GHz).   One billion cycles per
second (hertz).

GND.  Acronym for ground (e.g. that portion
of a conducting circuit connected to the
earth).

graphic display. The Director’s configuration
matrix may be displayed in a graphic mode on
the Console. This mode shows all connection
types as unique graphic symbols in the matrix
region of the window.  When graphic display
mode is disabled, only prohibited connections
are displayed.

graphical user interface (GUI).  A GUI is a
visually oriented interface where the user
interacts with representations of real-world
objects displayed on the computer screen.
Interactions with such objects produce
actions that are intuitive to the user.

GUI.  See graphical user interface.

H

half-duplex. In data communication, pertain-
ing to transmission in only one direction at a
time.  Contrast with duplex, synonym for
simplex.

hardware.   Physical equipment (Director or
Console) as opposed to computer programs,
procedures, rules, and associated
documentation.  Contrast with software.

Hardware Audit log.   A log that records all
configuration changes for Director FRUs.
Each entry contains a FRU name, position,
status, part number, serial number, and date
and time a change was detected.

Hardware Configuration Definition (HCD).
A program that defines all available I/O
devices and channel paths to a processor
system and the MVS operating system.  This
program replaced the Input Output Configura-
tion and MVS Configuration Programs start-
ing with MVS/ESA Version 4.0.

hardware information block (HIB). A Direc-
tor status register that defines if a port is
installed, has a dynamic connection, has a
link failure, is blocked, or is offline.  The MXC
reads the register in response for connection
requests to the port.

HCD.  See Hardware Configuration Defini-
tion.

Hertz (Hz).   A unit of frequency equal to one
cycle per second.

hexadecimal.  A numbering system with
base of sixteen; valid numbers use the num-
bers 0 through 9 and characters A through F,
where A represents 10 and F represents 15.

HIB.  See hardware information block.

host-based software.  Pertains to ESCON
Manager, the software used in configuring
and managing multiple Directors on the net-
work.

host processor.  (1) A processor that con-
trols all or part of a user application network
(T). (2) In a network, the processing unit in
which resides the access method for the
network.

hot pluggable.   Pertains to a FRU that is
removed and replaced from a device while
the device is powered on and operational.
See also concurrent maintenance and
nondisruptive installation.

Hz.  See Hertz.
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I

ID.  See identifier.

identifier (ID).   (1) One or more characters
used to identify or name a data element and
possibly to indicate certain properties of that
data element (T).  (2) A sequence of bits or
characters that identifies a program, device,
or system to another program, device, or
system. (3) A user-defined symbolic name of
24 characters or less that identifies a Director.
See also password identifier and port name.

IEEE.  See Institute of Electrical and
Electronics Engineers.

IML.  See Initial Machine Load.

information message.   A message inform-
ing a user that a function is performing nor-
mally or has completed normally.  User
acknowledgment may not be required,
depending on the message.  See also error
message and warning message.

Initial Machine Load (IML).   Process of
loading the operating system and applica-
tions software from secondary storage to a
central processor after machine power-on.
Sometimes referred to as booting the
machine.

Initial Program Load (IPL).   (1) Initialization
procedure causing an operating system to
commence operation. (2) Process by which a
configuration image is loaded into storage at
the beginning of a work day or after a system
malfunction.  (3) Process of loading system
programs and preparing a system to run jobs.

Initial Program Load (IPL) file.   Information
stored in Director’s nonvolatile memory that
contains default connection configurations.
The Director loads the file for operation when
powered on.  The file can be modified or
another file can be specified as the IPL file.

input/output (I/O). (1) Pertaining to a device
whose parts can perform an input process
and an output process at the same time (I).
(2) Pertaining to a functional unit or channel
involved in an input process, output process,
or both, concurrently or not, and to the data
involved in such a process.  (3) Pertaining to
input, output, or both.

input/output configuration.   A collection of
channel paths, control units, and I/O devices
that attaches to a processor.

input/output configuration data set
(IOCDS).  A data set that contains an I/O
configuration definition built by the IOCP.

Input/Output Configuration Program
(IOCP).  A program that defines all available
I/O devices and channel paths to a processor
system.  Replaced by the Hardware Configu-
ration Definition Program starting with MVS/
ESA Version 4.0.

input/output controller (IOC).  A functional
unit in a data processing system that controls
one or more devices or units of peripheral
equipment.

Institute of Electrical and Electronics
Engineers (IEEE).   A technical professional
society that promotes the development and
application of electrotechnology and allied
sciences.

interface.  (1) A shared boundary between
two functional units, defined by functional,
signal, or other characteristics.  The concept
includes the specification of the connection of
two devices having different functions (T). (2)
Hardware, software, or both, that link sys-
tems, programs, or devices.

Internet Protocol (IP). Network layer for the
TCP/IP protocol used on Ethernet networks.
IP provides packet routing, fragmentation,
and reassembly through the data link layer.

I/O.  See input/output.
358        Console Installation and User’s Guide



IOC.  See input/output controller.

IOCDS.  See input/output configuration data
set.

IOCP.  See Input/Output Configuration
Program.

IP.  See Internet Protocol.

IP address.   A unique string of numbers that
identifies a device on the Internet.  The
address consists of four groups of numbers
delimited by periods (dotted quad).  All
resources on the Internet must have an IP
address.

IPL.  See Initial Program Load.

ISA.  See Industry Standard Architecture.

ITE.  Acronym for Information Technology
Equipment.

J

jack. A hardware-connecting device to which
the wire or wires of a circuit are attached, and
that is arranged for the insertion of a plug.

jumper cable. In a fiber-optic environment, a
cable having two conductors that provide a
physical connection between two devices, or
between a device and a distribution panel.
Contrast with trunk cable.

K

kB.   See kilobyte.

kilobyte (kB).   A unit of measure for data
storage, equal to 1,024 bytes.  Generally
approximated as one thousand bytes.

L

LAN.   See Local Area Network.

LAN Adapter Installation and Diagnostics
(LANAID).   An IBM-licensed installation tool
providing a graphical and command-line inter-
face for manual installation and configuration
of a Token Ring LAN or LAN devices.

LAN Adapter and Protocol Support
(LAPS).   IBM - licensed software that man-
ages and controls network adapter cards in a
device, including the device drivers for those
cards as well as the protocols that are used
to communicate with other devices on the
network.

LANAID.   See LAN Adapter Installation and
Diagnostics.

LAPS.   See LAN Adapter and Protocol
Support.

laser.   Acronym for Light Amplification by
Stimulated Emission of Radiation.  A device
that produces optical radiation using a popu-
lation inversion to provide amplification and
an optical resonant cavity to provide positive
feedback.  Laser radiation is highly coherent
temporally, or spatially, or both (E).

LCD.  See liquid crystal display.

LED.  See light-emitting diode.

LIC.  See Licensed Internal Code.

Licensed Internal Code (LIC).   Software
provided for use on IBM machines and
licensed to customers under the terms of
lBM’s customer agreement.

light-emitting diode (LED).   A semiconduc-
tor chip that emits visible or infrared light
when activated.  Often used as an indicator
light on computer hardware.

LIN.  See link incident.
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link.   In a fiber-optic environment, the physi-
cal connection and transmission medium
between an optical transmitter and receiver.
A link consists of two conductors, one for
sending and the other for receiving, thereby
providing a duplex communication path.

link address. In an ESCON environment, an
address assigned at initialization that identi-
fies a channel or control unit and allows it to
send and receive transmission frames and
perform I/O operations.  See also port
address.

link incident. A failure associated with a link,
rather than a hardware or software failure
associated with the Director.  Examples of
link incidents include an invalid sequence,
sequence timeout, bit error rate threshold
exceeded, loss of signal or synchronization,
or a not-operational sequence recognized.

LMA Code.   See Loader/Monitor Area Code.

Loader/Monitor Area (LMA) Code .  Code
that resides in the loader/monitor area of the
CTP card, and provides input/output func-
tions (through a maintenance port, operator
panel, or Console), terminal window
command functions, power-on diagnostics,
FRU power-on hours, data read/write control,
and LMA/LIC download functions.

local .  Synonym for channel-attached.

Local Area Network (LAN).   A computer
network in a localized geographical area (e.g.
a building or campus), and whose communi-
cations technology provides a high-bandwidth
medium to which many nodes are connected.

log.   (1) To record or print all messages on a
system printer. (2) A record or compilation of
system events that have occurred.

logical partition (LPAR).   A processor
hardware subset defined to support the
operation of a system control program, and
can be used without affecting any of the appli-
cations in another partition.

logical switch number (LSN).   A two-digit
number used by the IOCP to identify a
Director.

LPAR.   See logical partition.

LSN.  See logical switch number.

M

MAC.  See Media Access Control.

MAC Address.   The hardware address of a
device connected to a shared network.

Maintenance Agreement Qualification
(MAQ).  After a period of equipment service
by another vendor, the MAQ is the verification
procedure that ensures the equipment is
eligible for maintenance by IBM customer
engineers.

Maintenance Analysis Procedure (MAP).
A written or online set of procedures that
guide maintenance personnel through step-
by-step instructions for hardware fault isola-
tion, repair, and verification.

maintenance password authorization. The
level-two password authorization that allows
access to a Director to perform maintenance
and operator functions. Contrast with
administrative password authorization and
operator password authorization.

management information system (MIS).
(1) management performed using automatic
data processing (I, A).  (2) An information
system that aids in performing management
functions (A).
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MAP. See Maintenance Analysis Procedure

MAQ.  See Maintenance Agreement
Qualification.

matrix. A matrix defines a Director’s address
configuration.  The three matrix types are
new matrix, saved matrix, and active matrix.
Synonym for configuration matrix.

Matrix Controller-2 (MXC2) card. A Director
circuit card that replaces a standard MXC
card and upgrades the Director to support
FICON operation.

Matrix Controller/Matrix Switch (MXC/
MXS) card. A set of Director circuit cards that
makes decisions on dynamic connection
requests between channels, control units
attached to the Director, and provides for
connection paths between ports.

MAU.  See Multistation Access Unit.

MB.  See megabyte.

Mbps.   Acronym for megabits per second.

MBps.   Acronym for megabytes per second.

MCL.  See microcode level.

Media Access Control (MAC). In LANs, the
sublayer of the data link control layer that
supports media dependent functions and
uses the functions of the physical layer to pro-
vide services to the logical link control sub-
layer.  The MAC sublayer includes a method
of determining when a device has access to
the transmission media.

megabyte (MB).   A unit of measure for data
storage, equal to 1,048,576 bytes. Generally
approximated as one million bytes.

menu.   A list of items displayed on the
Console from which a user can make a
selection.  See also pull-down menu.

menu bar.   The menu bar is located across
the top of a Console window.  Pull-down
menus are displayed by clicking on the menu
bar option with the mouse, or by pressing Alt
with the underlined letter of the name for the
menu bar option.

MES.  See miscellaneous equipment
specification.

microcode level (MCL).   The release level
(1.0, 1.2, 2.0, etc.) of a set of developed and
tested microcode instructions that is made
public.

micrometer.   One millionth of a meter.

MIF.  See Multiple Image Facility.

MIS.  See management information system.

miscellaneous equipment specification
(MES).  A set of stand-alone instructions
provided by IBM that supports the installation
of a hardware or software replacement or
upgrade.

modem.   Acronym for modulator/demodula-
tor. A device that converts digital computer
data to an analog signal that is transmitted
over a telecommunication line and converts a
received analog signal to digital data for the
computer.

mouse.   In computer graphics, a hand-held
locating, pointing, and selection device.  A
mouse usually contains a control ball, and is
operated by moving it on a flat surface.

MTP.  See multifiber terminated push-on.

multifiber terminated push-on (MTP).   A
12-fiber quick-disconnect push-on connector
that provides fast and effective reconnection
of processors and devices without disturbing
channel hardware configurations.

multimode optical fiber.   A graded-index or
step-index optical fiber that allows more than
one mode (light path) to propagate. Contrast
with singlemode optical fiber.
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Multiple Image Facility (MIF).   An IBM-
licensed program that allows multiple logical
partitions to concurrently share native
ESCON or FICON channels.  This reduces
the number of channel paths required to
support a configuration.

Multiple Virtual Storage (MVS).   The
generic name for an IBM-licensed operating
system used on System/370 and later main-
frame processors.  See also virtual storage
and OS/390.

Multistation Access Unit (MAU).   A cabling
attachment device that can connect up to
eight nodes to an IBM Token Ring network.

MVS.  See Multiple Virtual Storage.

MVS Configuration Program (MVSCP).  A
program that defines all available I/O devices
and channel paths to the MVS operating
system.  Replaced by Hardware Configura-
tion Definition Program starting with MVS/
ESA Version 4.0.

MVSCP.  See MVS Configuration Program.

MVS/ESA.  Acronym for Multiple Virtual
Storage/Enterprise Systems Architecture.
See also MVS and ESA.

MXC2 card.  See Matrix Controller-2 card.

MXC/MXS card.  See Matrix Controller/
Matrix Switch card.

N

network.   An arrangement of hardware,
software, nodes, and connecting branches
that comprises a data communication sys-
tem.  The ISO seven-layer specification
partitions a computer network into indepen-
dent modules from the lowest (physical) layer
to the highest (application) layer.

new matrix. A Director’s saved matrix that is
blank (contains default configuration
attributes) but does not have a saved name.
It is used for creating a new configuration,
and updating a saved matrix the first time
configuration changes are saved. Contrast
with saved matrix.

node.   (1) In a network, a point at which one
or more functional units connect channels or
data circuits (I).  In network topology, the
point at an end of a branch (T).

node port (N_port).  A port on a computer,
storage system, or other end device through
which the device performs Fibre Channel
communication.  Contrast with fabric port.
See also thin fabric port.

nondisruptive installation.   The installation
of units or FRUs while normal equipment
operation continues without interruption.
Contrast with nondisruptive removal.  See
also concurrent maintenance and hot
pluggable.

nondisruptive removal.   The removal of
units or FRUs without interrupting normal
equipment operation.  Contrast with nondis-
ruptive installation.  See also concurrent
maintenance and hot pluggable.

nonvolatile.   A term used to describe a data
storage device or memory chip that retains its
contents when power is removed or off.

NP. IBM parts list acronym for Not Procur-
able.  NP indicates the part is not procurable
and the next higher assembly should be
ordered.

N_port.  See node port.

NR. The IBM parts list acronym for Not
Recommended.  NR indicates the part is
procurable but is not recommended, and the
next higher assembly should be ordered.
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O

octet.   An 8-bit quantity, often called a byte
or word, and often used to explain specific
segments of a LAN address. A LAN address
is a 32-bit number in decimal format, normally
represented as four 8-bit octets with each
byte or octet separated by a decimal point.
See also byte.

ohm.   A unit of electrical resistance equal to
that of a conductor in which a current of one
ampere is produced by a potential of one volt
across the conductor terminals.

Open Systems Interconnection (OSI).   A
model that represents a network as a hierar-
chical structure of functional layers.  Each
layer provides a set of functions that can be
accessed and used by the layer above.  Lay-
ers are independent, in that implementation
of a layer can be changed without affecting
other layers.

operating system (OS).   Software that
controls execution of applications and pro-
vides services such as resource allocation,
scheduling, I/O control, and data manage-
ment.  Most operating systems are predomi-
nantly software, but partial hardware
implementations are possible (T).

operator password authorization.   The
level-three password authorization that allows
access to a Director to perform operator
functions only.  Contrast with administrative
password authorization and maintenance
password authorization.

optical cable.   A single fiber, multiple fibers,
or a fiber bundle in a structure constructed to
meet certain optical, mechanical, or environ-
mental specifications (E).  See also jumper
cable, optical cable assembly, and trunk
cable.

optical cable assembly.   A connector-
terminated optical cable.  The cable is
generally terminated by the manufacturer and
is ready for installation (E).  See also jumper
cable and optical cable.

optical drive backup . A data backup system
that uses rewriteable optical cartridges
(ROCs) as the storage medium.

optical fiber connector. A hardware compo-
nent that transfers optical power between two
optical fibers or bundles, and is designed to
be repeatedly connected and disconnected.

optical waveguide.   (1) A structure capable
of guiding optical power (E).  (2) In optical
communications, a fiber designed to transmit
optical signals.  See also optical fiber.

OS.  See operating system.

OS/2.  Acronym for Operating System 2, the
operating system developed by IBM for
personal computers.  The OS/2 licensed
program can perform multiple tasks at the
same time.

OS/390. Acronym for Operating System 390,
an integrated, open-enterprise server operat-
ing system developed by IBM that incorpo-
rates a leading-edge and open
communications server, distributed data and
file services, Parallel Sysplex support, object-
oriented programming, distributed computing
environment, and open application interfaces.

OSI.  See Open Systems Interconnection.

P

parallel channel.   A data communications
channel that uses copper bus and tag cables
as a transmission medium, rather than fiber-
optic cables.  Contrast with ESCON channel
and FICON channel.
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parameter.   (1) Variable that is given a con-
stant value for a specified application and that
may denote the application (I, A).  (2) Item in
a menu for which the user specifies a value,
or for which the system provides a value
when the menu is interpreted.  (3) Data
passed between programs or procedures.

password.   A unique string of characters
known to a computer system, and to a user
who must specify the password to gain full
or limited access to the system and the
information stored within.

password identifier.   In a Director, a user-
defined symbolic name of 24 characters or
less that identifies the password user.

path.   (1) In a network, any route between
two nodes (T).  (2) In systems network
architecture, the series of path control net-
work components (path control and data link
control) traversed by the information
exchanged between two network-address-
able units.

PC.  See personal computer.

PDCM.  See port dynamic connect mask.

personal computer (PC).   A portable
computer that consists of a system unit, dis-
play, keyboard, mouse, one or more diskette
drives, and internal fixed-disk storage.  PCs
are designed to give independent computing
power to a single user.

point-to-point. A Fibre Channel topology
that provides a single, direct connection
between two communication ports.  The
Director supports only point-to-point topology.

POR.  See Power-on Reset.

port.   (1) An access point for data entry or
exit. (2) A receptacle on a device to which a
cable for another device is attached.

port address. In a Director, the address
used to specify port connectivity parameters
and to assign link addresses for attached
channels and control units.

port authorization. Feature of the password
definition function that allows an administrator
to extend operator-level passwords to specific
port addresses for each Director definition
managed by a Console.  Port authorization
affects only operator-level actions for active
and saved matrices.

port card.  In a fiber-optic environment, a
FRU that provides an optomechanical attach-
ment method for fiber cables, and performs
specific device-dependent logic functions.
See also Device port card and FCV port card.

port dynamic connect mask (PDCM) .
Register that controls blocking between two
ports and defines the blocked status between
the ports. This provides information about
blocked status of two ports with a static
connection so requests can be denied for
dynamic connections.

port name.  In a Director, a user-defined
symbolic name of 24 characters or less that
identifies a port.

POST.  See Power-on Self-Test.

Power-on Reset (POR).   Method by which a
device is set to a prescribed or clear state.
The device is powered off, then powered on
and re-IPLed.

Power-on Self-Test (POST).   A series of
diagnostic tests that are automatically
executed by a device when the power is
switched on.

processor.   A computer’s functional unit
that interprets and executes instructions.  A
processor consists of an instruction control
unit and an arithmetic and logic unit. (I, A).
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prohibited connection.   In a Director, the
attribute that when set, removes dynamic
connectivity capability. Contrast with allowed
connection.

protective plug.   In a fiber-optic environ-
ment, a type of duplex connector (or cover)
that provides physical protection.  Contrast
with wrap plug.

protocol.  (1) Set of semantic and syntactic
rules that determines the behavior of
functional units in achieving communication
(I).  (2) In systems network architecture, the
meanings of and sequencing rules for
requests and responses for managing the
network, transferring data, and synchronizing
network component states.  (3) A specifica-
tion for the format and relative timing of data
exchanged between communicating devices.

pull-down menu.   A menu that is displayed
below, or pulled down from a menu bar at the
top of a window.

Q

quadrant.   One of four areas in a Director
where device port cards are installed.  The
quadrants are designated A through D.

query.   (1) The process by which a master
device asks a slave device for identification
and status (T).  (2) For interactive systems,
an operation at a Console that elicits a
response from the system.  (3) A request for
information from a file based on specific
conditions.

queue. (1) A list constructed and maintained
so the next data element to be retrieved is the
one stored first. This method is characterized
as first in-first out (T). (2) A line or list of items
that is waiting to be processed.

R

R. The IBM parts list acronym for Restricted.
R indicates the part is procurable but has a
restricted availability.

RAM. See random access memory. See
also DRAM and SRAM, and contrast with
ROM.

random access memory (RAM). A group of
computer memory locations that is numeri-
cally identified to allow high-speed access by
the controlling microprocessor.  A memory
location is randomly accessed by referring to
its numerical identifier. See dynamic random
access memory and static random access
memory, and contrast with read-only memory.

read-only memory (ROM). An information
storage chip with permanent memory. Stored
information cannot be changed or deleted
except under special circumstances.
Contrast with random access memory.

rewriteable optical cartridge (ROC). A
plastic cartridge with a recording medium that
uses magneto-optical read/write technology,
and is removable from a computer and used
to store and transport data.

RI. See ring-in. Contrast with RO.

ring-in (RI). In an IBM Token Ring network,
the receive or input receptacle on a multista-
tion access unit. Contrast with ring-out.

ring-out (RO). In an IBM Token Ring net-
work, the transmit or output receptacle on a
multistation access unit. Contrast with
ring-in.

ring topology. A logically circular, unidirec-
tional transmission path without defined ends,
in which control is distributed or centralized.
See also Token Ring.

RO. See ring-out. Contrast with RI.
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ROC. See rewriteable optical cartridge.

ROM. See read-only memory. Contrast with
RAM.

router.   An attaching device that connects
two LAN segments, which use similar or dif-
ferent architectures, at the reference model
network layer. Contrast with bridge.

row.   Horizontal arrangement of data.
Contrast with column.

RS-232. The EIA-recommended specifica-
tion for asynchronous serial interfaces
between computers and communications
equipment. It specifies both the number of
pins and type of connection, but does not
specify the electrical signals.

S

SA. See Service Agreement.

SA OS/390.  See System Automation for
OS/390.

saved configuration.   In an ESCON or
FICON environment, a stored set of connec-
tivity attributes whose values determine a
configuration used to replace all or part of a
Director’s active configuration matrix.
Contrast with active configuration.

saved matrix.  A matrix modified for a
particular purpose, then saved to the Director
Console fixed disk.  Multiple saved matrices
are maintained in the Console library for each
Director.  Contrast with new matrix.

SC Connector.   See subscriber connector.

SCP. See System Control Program.

SCSI. See small computer system interface.

Service Agreement (SA).   A tailored hard-
ware, software, or combined support contract
between IBM and the customer.

simplex. In data communication, pertaining
to transmission in only one direction at a time.
Contrast with duplex, synonym for half-
duplex.

singlemode optical fiber.   An optical fiber
that allows one wavelength-dependent mode
(light path) to propagate.  Contrast with
multimode optical fiber.

small computer system interface (SCSI).
An input and output bus that provides a
standard interface between the OS/2 operat-
ing system and peripheral devices.

software.   Computer programs, procedures,
rules, and associated documentation pertain-
ing to the operations of a system.  See also
application, and contrast with hardware.

spare ports card.   A card feature for the
Director that contains either four LED ports
(#5245), or two LED and two XDF ports
(#5255).

SRAM. See static random access memory.
See also RAM and contrast with DRAM.

static random access memory (SRAM).
SRAM is microprocessor-cache random
access memory. SRAM is built internal to the
microprocessor or on external chips.  SRAM
is fast, but relatively expensive.  See random
access memory and contrast with dynamic
random access memory.

stop bit.   In start-stop transmission, a signal
at the end of a character that prepares the
receiving device for reception of a subse-
quent character (I).

subnet mask. For internet subnetworking, a
32-bit mask used to identify the subnetwork
address bits in the host portion of the IP
address.
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subscriber connector (SC). A connector
that terminates fiber-optic jumper cables in
two housings (one transmit and one receive),
and provides physical keying to an SC recep-
tacle. An SC connector is synonymous with
an FCS connector. An SC connector can
attach to an FCV port card or XDF laser port
card.  See also Fibre Channel Standard
connector and multimode connector.

subsystem.   A secondary or subordinate
system, or programming support, usually
capable of operating independently of or
asynchronously with a controlling system (T).

SWCH.  The acronym used in ESCON
Manager to represent a Director and identify
the Director in the UNIT parameter.

switch.   A synonym used in ESCON Man-
ager for a Director.  Identifies the Director in
the CHPID statement.

Sysplex Timer.   An IBM table top unit that
provides the synchronization for time-of-day
clocks in multiple central processing
complexes.

System Automation for OS/390 (SA
OS/390).  IBM-licensed software that
provides System/390 Parallel Sysplex
management, automation capabilities, and
integrated systems and network manage-
ment.  SA OS/390 manages host, remote
processor, and I/O operations.  SA OS/390
integrates the functions of Automated
Operations Control for MVS, ESCON
Manager, and Target System Control Facility.

system configuration.   A process that
specifies the devices and programs that form
a particular data processing system.

System Control Program (SCP).   An IBM-
supplied program that is fundamental to the
operation and maintenance of a mainframe
system.  The software serves as an interface
with licensed and other programs.

T

Target System Control Facility (TSCF). An
IBM-licensed program that designates one
processor in a Parallel Sysplex as a focal-
point system that controls target systems.
The focal point system can load, configure,
start, control, and monitor applications on tar-
get systems. The focal point system can also
coordinate processes across systems. TSCF
functions are now integrated into SA OS/390.

TCP.  See transmission control protocol.

TCP/IP. See transmission control
protocol/internet protocol.

Telecommunications Industry Associa-
tion (TIA).  TIA is a member organization of
the Electronic Industries Association, and is
the trade group representing the communica-
tions and information technology industries.
See also EIA.

terminal.  In data communication, a device
equipped with a keyboard and display, capa-
ble of transmitting and receiving information.
Synonym for Console or display device.

thin fabric port (thin F_port).  The port
connection on the FCV port card that
behaves externally as an N_port, but has the
F_port ability to accept a fabric login (FLOGI)
command.  Contrast with node port.  See
also fabric port.

thin F_port.   See thin fabric port.

TIA.  See Telecommunications Industry
Association.  See also EIA.

tile.  Windows on a console are tiled to
simultaneously display all open windows
side-by-side in a reduced-size format.  No
overlapping of windows occurs.  To tile
windows, use the Window pull-down menu
and select Tile.  Contrast with Cascade.
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TKRG.  See Token Ring Controller Adapter
card.

toggle. A procedure to change the state of a
feature. If the feature is On, toggling will turn
it Off, and vice versa.

token.   A sequence of bits passed from one
device to another on a Token Ring network
that signifies permission to transmit over the
network.  The token consists of a starting
delimiter, access control field, and end
delimiter.  If a device has data to transmit, it
appends the data to the token.

Token Ring.   A LAN configuration where
devices attach to a network cable in a closed
path or ring.  A token (unique sequence of
bits) circulates on the ring to allow devices to
access the LAN for data transmission.  See
also ring topology.

Token Ring Controller Adapter (TKRG)
card.   The circuit card that provides a port to
connect a Director to a 4/16 Mbps Token Ring
LAN. The card is labelled TKRG.

topology.   The physical or logical arrange-
ment of nodes in a computer network.

TPF.  See Transaction Processing Facility.

Transaction Processing Facility (TPF).
IBM-licensed software that supports
interactive applications in which requests
submitted at terminals are processed upon
receipt.  TPF provides a message-based,
real-time, high-capacity transaction process-
ing environment.

transmission control protocol (TCP).   The
transport layer for the TCP/IP protocol widely
used on Ethernet networks and any network
that conforms to U.S. Department of Defense
standards for network protocol.  TCP pro-
vides reliable communication and control
through full-duplex connections.

transmission control protocol/internet
protocol (TCP/IP). A layered set of protocols
(network and transport) that allows sharing of
applications among devices on a high-speed
LAN communication environment.  See also
TCP and IP.

trunk cable. In an fiber-optic environment, a
cable consisting of multiple fiber pairs that
does not directly attach to an active device.
The cable usually exists between distribution
panels and can be located within, or external
to, a building.  Contrast with jumper cable.

TSCF.  See Target System Control Facility.

U

UL.  See Underwriters Laboratories.

ULP.  See upper level protocol.

unblocked.   In a Director, the attribute that
when set, establishes communication capa-
bility for a specific port.  Contrast with
blocked.

Underwriters Laboratories (UL).   A
laboratory organization accredited by the
Occupational Safety and Health Administra-
tion, and authorized to certify products for use
in the home and workplace.

uninterruptable power supply (UPS).   A
buffer between public utility power or an other
power source, and a system that requires
precise, uninterrupted power.

URL.  Acronym for Uniform Resource
Locator. A URL is the address of a document
or other resource on the internet.
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upper level protocol (ULP).   Protocols that
map to and run on top of Fibre Channel FC-4
layer.  Upper level protocols include IP and
SCSI.

UPS.  See uninterruptable power supply.

V

Vac.  Acronym for volts alternating current.
See alternating current.

Vdc.  Acronym for volts direct current.  See
direct current.

Virtual Machine (VM).   (1) A virtual data
processing system that appears to be at the
exclusive disposal of a single user, but whose
functions are accomplished by sharing the
resources of a real data processing system.
(2) A functional simulation of a computer
system and its associated devices, multiples
of which can be controlled concurrently by
one operating system.

Virtual Storage (VS).  (1) Storage space
that may be regarded as addressable main
storage by the user of a computer system in
which virtual addresses are mapped to real
addresses.  The size of virtual storage is
limited by the addressing scheme of the
computer system and by the amount of
auxiliary storage available, not by the number
of main storage locations.  (2) Addressable
space that is apparent to the user as
processor storage space, from which the
instructions and the data are mapped to the
processor storage locations.

Virtual Storage Extended (VSE).  An
IBM-licensed software operating system that
controls the execution of programs.

VM.  See Virtual Machine.

VM/ESA.  Acronym for Virtual Machine/
Enterprise Systems Architecture.  See also
VM and ESA.

volt. A measure of the difference in electrical
potential between two points in a conductor,
equal to one ohm resistance carrying a
constant current of one ampere, with a power
dissipation of one watt.

VS.  See Virtual Storage.

VSE.  See Virtual Storage Extended.

W

watt.   A unit of power in the International
System equal to one joule (Newton-meter)
per second.

warning message.   An indication that a
system error or other problem has been
detected.  See also error message and
information message.

window. A portion of the Director Console
screen in which one of several concurrent
applications or data sets can display informa-
tion.  The user sees what appears to be
several sheets of paper, much as the sheets
would appear on a desktop.  See also
cascade and tile.

Windows. A graphical user interface and
windowing system introduced by Microsoft
Corporation in 1985. Windows runs on top of
the MS-DOS operating system.

Win-OS/2. Win-OS/2 is the Windows compo-
nent of IBM’s OS/2 Version 2.0 operating
system.  It is based partially on Windows 3.0
and Windows 3.1. Win-OS/2 is the operating
system used by the Director Console
application.
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wrap plug.   (1) A connector attached to the
plug end of a cable that connects input and
output pins together for testing.  See wrap
test.  (2) In a fiber-optic environment,  a type
of duplex connector used to wrap the optical
output signal of a device directly to the optical
input.  Contrast with protective plug.

wrap test.   A test that checks attachment or
control unit circuitry, without checking the
mechanism itself, by returning the output of
the mechanism as input.  A wrap test can
transmit a specific character pattern through
a system, and compare the pattern received
with the pattern transmitted.

X

XDF.  See Extended Distance Feature.
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A
Adapter and Protocol Configuration
dialog box, 278, 340

administrative tasks
change date and time format

PC 300PL Console, 319
PC-330 Console, 193
PC-365 Console, 257
PS/2 Console, 121

change default printer
PC 300PL Console, 343
PC-330 Console, 217
PC-365 Console, 281
PS/2 Console, 145

change keyboard layout
PC 300PL Console, 326
PC-330 Console, 199
PC-365 Console, 264
PS/2 Console, 127

change Win-OS/2 keyboard settings
PC 300PL Console, 331
PC-330 Console, 204
PC-365 Console, 269
PS/2 Console, 132

enable or change screen saver
PC 300PL Console, 323
PC-330 Console, 196
PC-365 Console, 261
PS/2 Console, 124

set date and time
PC 300PL Console, 316
PC-330 Console, 190
PC-365 Console, 254
PS/2 Console, 118

ARP table
clear

PC 300PL Console, 290
PC-330 Console, 153
PC-365 Console, 226
PS/2 Console, 83

description, 83, 153, 226, 290

automatic backup
change settings, 243, 304
fixed disk

PC-330 Console, 178
PS/2 Console, 106

system library
PC 300PL Console, 302
PC-330 Console, 167
PC-365 Console, 240
PS/2 Console, 96

AutoTape dialog box, 97, 168, 179

AutoTape Event Schedule dialog
box, 98, 108, 169, 179

B
back up

backup on demand (fixed disk)
PC-330 Console, 180
PS/2 Console, 109

backup on demand (system library)
PC 300PL Console, 307
PC-330 Console, 170
PC-365 Console, 245
PS/2 Console, 99

change automatic backup
settings, 243, 304

critical Hardware Management
Console data, 39
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default time, 96, 106, 167, 178, 240, 302
Director system library

from Hardware Management
Console, 45

from PC 300PL Console, 302
from PC-330 Console, 167
from PC-365 Console, 240
from PS/2 Console, 96

enable automatic backup (fixed disk)
PC-330 Console, 178
PS/2 Console, 106

enable automatic backup (system library)
PC 300PL Console, 302
PC-330 Console, 167
PC-365 Console, 240
PS/2 Console, 96

fixed disk
from PC-330 Console, 178
from PS/2 Console, 106

QIC 80 format tape, 99, 109, 170, 180
Sysplex Timer system library

from Hardware Management Con-
sole, 49

from PC 300PL Console, 302
from PC-330 Console, 167
from PC-365 Console, 240
from PS/2 Console, 96

Backing Up Files dialog box, 102, 112, 173,
184

backup Console (Director), 8

Backup dialog box, 247, 308

Backup drawer (launch pad), 17

Backup Library Director Console Archive
window, 46

Backup Library Sysplex Timer Console
Archive window, 50

backup on demand
fixed disk

PC-330 Console, 180
PS/2 Console, 109

system library
PC 300PL Console, 307
PC-330 Console, 170
PC-365 Console, 245
PS/2 Console, 99

backup options
PC-330 Console, 167
PS/2 Console, 95

Build Diagnostic Diskette window, 94, 165,
239, 300

C
CD-ROM

fixed disk restore, 250, 312

Change Configuration Parameters dialog
box, 162, 235

clear ARP table
PC 300PL Console, 290
PC-330 Console, 153
PC-365 Console, 226
PS/2 Console, 83

close a window, 29

Closing TCP/IP Configuration, 275, 337

Configuration dialog box, 143, 214

Configure dialog box, 277, 339

Configure Workstation dialog box, 143, 214

Confirm on Data File delete dialog box, 53, 55

Console
backup Director Console, 8
Director Console, 1
Hardware Management Console, 33
LAN configurations, 59
remote access by TCP/IP, 61
replacement Director Console, 8
shared Console, 14
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standby Sysplex Timer Console, 13
Sysplex Timer Console, 8

Control Panel window, 126, 134, 146, 198,
206, 218, 262, 271, 282, 324, 333, 344

Country - Properties dialog box, 259, 321

Country Information dialog box, 129, 266, 328

create Console diagnostic diskette
PC 300PL Console, 299
PC-330 Console, 164
PC-365 Console, 237
PS/2 Console, 93

create definitions diskette
Hardware Management Console, 42
PC 300PL Console, 292
PC-330 Console, 156
PC-365 Console, 228
PS/2 Console, 86

customize Console environment
change default printer

PC 300PL Console, 343
PC-330 Console, 217
PC-365 Console, 281
PS/2 Console, 145

change IP address
PC 300PL Console, 334
PC-330 Console, 207
PC-365 Console, 272
PS/2 Console, 135

change keyboard layout
PC 300PL Console, 326
PC-330 Console, 199
PC-365 Console, 264
PS/2 Console, 127

change MAC address
PC 300PL Console, 338
PC-330 Console, 214
PC-365 Console, 276
PS/2 Console, 142

change subnet mask
PC 300PL Console, 334
PC-330 Console, 207
PC-365 Console, 272
PS/2 Console, 135

change time and date format
PC 300PL Console, 319
PC-330 Console, 193
PC-365 Console, 257
PS/2 Console, 121

change Win-OS/2 keyboard settings
PC 300PL Console, 331
PC-330 Console, 204
PC-365 Console, 269
PS/2 Console, 132

enable or change screen saver
PC 300PL Console, 323
PC-330 Console, 196
PC-365 Console, 261
PS/2 Console, 124

set time and date
PC 300PL Console, 316
PC-330 Console, 190
PC-365 Console, 254
PS/2 Console, 118

D
data collection procedure

Director
Hardware Management Console, 39
PC 300PL Console, 285
PC-330 Console, 149
PC-365 Console, 221
PS/2 Console, 79

Sysplex Timer
Hardware Management Console, 48
PC 300PL Console, 288
PC-330 Console, 152
PC-365 Console, 224
PS/2 Console, 82
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data rate (LAN), 162, 235

date and time
change format

PC 300PL Console, 319
PC-330 Console, 193
PC-365 Console, 257
PS/2 Console, 121

set
PC 300PL Console, 316
PC-330 Console, 190
PC-365 Console, 254
PS/2 Console, 118

DCAF - Directory window, 65

DCAF software
configure Console for remote access, 59
configuring for TCP/IP, 61
DCAF - Directory window, 65
Distributed Console Access Facility

window, 65

DCAF Target drawer (launch pad), 16

DCGETDEF.CMD window, 43, 87, 157,
229, 293

delete
Director Console application from

Hardware Management
Console, 52

Director Console icons from Hardware
Management Console, 53

Extra Applications folder, 54, 56
Timer Console application from Hardware

Management Console, 54
Timer Console icons from Hardware

Management Console, 56

Delete Object(s) dialog box, 52, 55

Desktop dialog box, 126, 198, 263, 325

desktop objects
description, 17
Director Console icon, 18
Director tools folder, 18
OS/2 Applications icon, 17

OS/2 System icon
Warp 4.0, 18
Warp Connect 3.0, 17

Sysplex Timer Console icon, 18
Sysplex Timer tools folder, 19

dialog boxes
Adapter and Protocol Configuration, 278,

340
AutoTape, 97, 168, 179
AutoTape Event Schedule, 98, 108, 169,

179
Backing Up Files, 102, 112, 173, 184
Backup, 247, 308
Change Configuration Parameters, 162,

235
Closing TCP/IP Configuration, 275, 337
Configuration, 143, 214
Configure, 277, 339
Configure Workstation, 143, 214
confirm on Data File delete, 53, 55
Country - Properties, 259, 321
Country Information, 129, 266, 328
Delete Object(s), 52, 55
Desktop, 126, 198, 263, 325
Director Console - Properties, 70, 72
Exiting MPTS, 280, 342
Install Driver, 148, 220, 284, 346
International, 134, 206, 271, 333
Keyboard, 130, 202, 266, 328
LANAID, 164, 213, 237
List of Printers, 147, 219, 283, 345
Load Job File, 101, 112, 173, 183
Multi-Protocol Transport Services, 277,

339
OS/2 Setup and Installation, 131, 203,

268, 330
Printers, 147, 219, 283, 345
Restore, 249, 310
Restore Parameters for Tape Library

Backup, 105, 176
Retension Confirmation, 101, 112, 173,

183
Set Default, 242, 303
Source Directory, 131, 203, 268, 330
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Sysplex Timer Console - Properties, 74,
76

System Clock - Properties, 256, 318
System Configuration, 129, 201, 266
Timer Control Center, 244, 305
Update CONFIG.SYS, 279, 341
View Adapter Configuration, 161, 234

Director Console
application icon, 18, 35
backup Console, 8
description, 1
PC 300PL

description, 6
specifications, 7

PC-330
description, 4
specifications, 4

PC-365
description, 5
specifications, 6

platforms, 1
PS/2

description, 2
specifications, 3

replacement Console, 8
shared Console, 14
tools folder, 18

Director Console - Properties dialog box
Program page, 70, 72
Session page, 70, 72

Director Console application
delete from Hardware Management

Console, 52
install on Hardware Management

Console, 34
shut down

from Director Console, 24
from Hardware Management

Console, 35

start
from Director Console, 24
from Hardware Management

Console, 35
transfer

from OS/2 desktop, 22
to OS/2 desktop, 21

uninstall from Hardware
Management Console, 51

Director definitions
create definitions diskette

Hardware Management Console, 42
PC 300PL Console, 292
PC-330 Console, 156
PC-365 Console, 228
PS/2 Console, 86

migrate
Hardware Management Console, 42
PC 300PL Console, 292
PC-330 Console, 155
PC-365 Console, 228
PS/2 Console, 85

diskettes
Console diagnostic, 93, 164, 237, 299
Data Collection, 40, 49
fixed disk restore, 114, 185

Distributed Console Access Facility
window, 65

Drive A - Icon View, 43, 86, 156, 229, 293

Drive A drawer (launch pad), 16

DualStor drawer (launch pad), 17

DualStor for OS/2 window, 101, 104, 111,
172, 175, 182

DualStor software
PC-330 Console, 167, 178
PS/2 Console, 96, 106
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E
electronic emission notices, xi

ESCON Director Data Collection window, 41,
81, 151

ESCON Director Tools - Icon View, 18, 46,
80, 150, 222, 286

Exiting MPTS dialog box, 280, 342

Extra Applications - Icon View, 35–36

Extra Applications folder
delete, 54, 56
open, 35–36

F
fixed disk

back up
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PC-365 Console, 272
PS/2 Console, 135

change MAC address
PC 300PL Console, 338
PC-330 Console, 214
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